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CHAPTER 
ONE

Introduction to Digital Screens

An eScreen is simply a digital sign, similar to a large 
computer monitor or TV, that displays useful information 
like company notices, production facts/figures, and other 
internal communications. These digital signs are installed 
in our lobbies, conference rooms, operator control rooms, 
break rooms, etc. for the purpose of informing and 
educating employees, guests and customers.

Instant and thorough communication is very important 
in a large company like Digix. Our eScreens can quickly 
disseminate information to employees and contractors 
who may not have access to e-mail, in a clear and visually-
appealing way.

Our screens are capable of displaying high quality images, 
animations, videos, and some even have audio capabilities. 
The following training introduces you to these features and 
upon its completion, you will have a better understanding 
of how to leverage for your communication needs.
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Our Communication Channels
The goal of internal communications is simple: to engage all employees 
in Digix’s mission, strategy and success — across  functions, levels 
and geographies. But the steps we take to successfully achieve this 
goal are a bit more complex.

Every day, we have important choices to make about what and how 
we communicate.

We live in a world of information overload where it’s easy to post, 
send and share volumes of data with the push of a button. Deciding 
what not to communicate is just as important as deciding what to 
communicate. Are we treating everything with equal importance 
and adding to the clutter of messaging, or are we using a strong 
filter based on relevance and value to hone in on the “critical few”? 

How we communicate — using the right channel with the right 
content at the right time — is the difference-maker. The eScreens 
are just one of several options available to us at Digix.

Figure 1-1. Typical flow of information

Figure 1-2. Communication channels and their reach

1.1	 eScreen Channel Strategy
The eScreens are among the most dynamic communication 
options available to you. Let’s learn why.

BUSINESS
UNIT CORPORATEFACILITY

EMPLOYEES AND CONTRACTORS

E-MAIL NEWSLETTER MEETINGSEMPLOYEE 
WEBSITE eSCREENS

BEST CHANNEL?

COMMUNICATION CHANNEL

E-MAIL NEWSLETTER MEETINGSEMPLOYEE 
WEBSITE eSCREENS

WHO CAN IT REACH? EVERYONEONLY THOSE WITH NETWORK ACCESS SOME
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Digital Channel Strategy� eScreen Channel Strategy

Digital Channel Strategy
In a rather short period of time, eScreens have filled a communication 
gap by helping us connect with employees and contractors who do 
not have access to Digix’s network while at work. And this success 
isn’t a secret. More and more people and functions are asking to post 
information on eScreens. Without proper oversight, eScreens could 
easily follow in e-mail’s footsteps — overcrowded and overwhelming.

As an eScreen administrator, your role is to help set priorities for 
your facility and make sure the critical few are getting the play time 
they deserve.

Before posting a message, be sure to ask yourself: 

•	 Does the information support the goals of internal 
communications, my business unit and/or my facility? 

•	 Is this the right channel for the message and the audience 
or would I be better off using email, bulletin boards and/or 
meetings? 

•	 Have we effectively communicated the message already 
through other channels, or would we be using a new 
technology for old news? 

•	 What would happen if we didn’t post the information on 
eScreens? Would it negatively impact safety, operations or 
employee engagement? Would anyone even miss it? 

If you have questions about our internal communications channel 
strategy, be sure to contact a member of the Public Affairs team in 
your business unit or Plymouth.

Digix's Public 
Affairs department

E-Mail: 
public.affairs@digixco.com
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1.2	 Parts of the eScreen System
The eScreens are all connected on our network and share content 
from a central server. You tell your eScreen what to play, and the 
server sends it the information.

The eScreen
What we all know as the eScreen is actually an LCD (liquid 
crystal display) flat screen television monitor powered by a 

computer called an SDA (Symon Digital Appliance), which displays 
content from the server. The content includes user-generated items 
such as slides and text tickers, as well as automatic feeds like news 
and weather.

SDA 
The SDA is the computer that powers the LCD screen. 
The SDA is usually mounted to the wall behind the screen, 

and sometimes can be built-in to the screen itself. Some sites have 
multiple eScreens connected to one SDA. 

Server
The eScreen Server is located in Wood Dale, IL. and is 
the main “brain” of the eScreen system. The server is 

responsible for telling each eScreen in North America what to play 
and when.

Design Studio
The program you will use to add and schedule content 
for your eScreens is called Design Studio. Design Studio 

sends your content and schedules to the server, where it is stored 
and later recalled for playback on your eScreens.

What part do you play?
Of all these parts, you are arguably the most important! You 
are the interface between your local organization and the 

communication power of the eScreens. You will also help content 
providers (managers, HR staff, event coordinators, etc.) share their 
messages with employees via the eScreens.

Figure 1-3. Parts of the system

YOU
Administrator

SERVER
Wood Dale, IL

DESIGN STUDIO
Software

SDA
(Symon Digital Appliance)

eSCREEN
Your Local Site
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The eScreen Layout� Parts of the eScreen System

The eScreen Layout
The eScreen is divided into several distinct areas, each displaying 
different types of content.

Main Area.  The main area is used to display important messages 
like announcements, safety information and advisories.

Upper right area.  This area is used to display continual or recurring 
information like reminders and training dates, as well as non-crucial 
information like event/employee photos.

Lower right area.  This area displays national news, local weather, 
quotes and facts. The lower right area receives its information 
automatically, and is not user-editable.

Text ticker area.  Several scrolling tickers (news, stocks, local site 
ticker, etc.) display in this area, and repeat automatically. Only the 
local site ticker is user-editable (see page 115 for more information).

Fixed areas.  The brand arc and Digix logo display in the header. 
The time and date display alternately at the top-right of the screen.

Figure 1-4. A Typical wall-mounted eScreen, not powered-on

The layout areas of 
the eScreen:

1.	 Main area

2.	 Upper right area

3.	 Lower right area

4.	Text ticker area

5.	 Header

6.	Time/date

Figure 1-5. The eScreen layout 
showing no content
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Permissible Content Examples 
The Digix eScreens should only display positive, professional, relevant 
and timely content. The following list includes some approved 
content types:

•	 Departmental news

•	 Production numbers

•	 Site-specific events

•	 Public Affairs events

•	 Maintenance dates

•	 Local news items

•	 General reminders

•	 Training dates

•	 Employee schedules

•	 Requests for volunteers*

•	 Safety reminders

•	 Employee accolades

•	 On-the-job recognition

•	 Community involvement 
photographs

•	 Facility photographs

•	 Quarterly Update dates 
and times

•	 Quarterly earnings reports

•	 Tips (energy, safety, etc.)

•	 Message from facility 
managers/SLT

•	 Employee birthdays†

•	 Congratulations†

•	 Good-luck messages†

Per-Facility Discretion
Personal congratulations.  You may want to acknowledge an 
employee’s efforts outside of Digix. The decision on whether this 
is appropriate for your facility’s eScreen is left up to facility-level 
management. However, if you are unsure, a good general rule is 
that personal announcements such as births and weddings should 
be saved for your newsletters and bulletin boards.

Employee recognition and birthdays.   As a vital part of 
engagement, we want to ensure that employees who go above and 
beyond Digix’s values-in-action are recognized. Displaying employee 
birthdays can also be an excellent means of encouraging further 

*subject to local approval  †per-facility discretion

1.3	 eScreen Content Guidelines
The content shown on the eScreens is the responsibility of the 
Public Affairs department, and must adhere to a set of guidelines.
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Disallowed Content� eScreen Content Guidelines

engagement. If your facility-level management chooses to display 
a list of employee birthdays on your eScreens, please be sure that 
you have a current, complete list from your Human Resources 
department.

Disallowed Content
All content displayed on the eScreens is subject to editing or removal 
if found to be inconsistent with the brand identity and/or these 
guidelines. Specifically, content will be removed if it:

•	 is primarily intended to highlight an employee’s home life

•	 is primarily intended as a joke or gag

•	 is defamatory or discriminatory, or promoting illegal activities

•	 is intended to solicit business for a company outside of Digix 

•	 does not display accurate facts and figures

•	 falls into one of the categories listed on the right

Photographs
Imagery is typically used to evoke emotions, provide information, 
and is an important part of communicating in general. Photographs 
selected for the eScreens should:

•	 reflect our global presence and diversity

•	 highlight human interaction with our products, crops, etc.

•	 use contours and colors, landscapes, food and people

•	 focus on collaboration with our customers and communities

•	 be factual and truthful

•	 show actual use of Digix products when possible

For more information on using photos and other imagery including 
stock photographs, see page144.

What are some 
examples of 
content that is not 
allowed? 
•	 Classified ads

•	 Death notices

•	 Personal audio or 
music

•	 Chain-letter e-mails

•	 Photos of blood or 
other bodily fluids

•	 Photos of weapons

•	 Offensive/
objectionable 
material or 
photographs

•	 Workplace-
inappropriate jokes 
or stories
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eScreen Content Guidelines� Community Property

Community Property
It would not be very productive to have users at different facilities 
creating duplicate content.

General-purpose content such as emergency preparedness tips, 
parking lot safety information, daylight savings time reminders, as 
well as a variety of other pre-made content has been made available 
in a folder called Community Property in the Design Studio software. 
(For more information on content folders in Design Studio, see page 
78). This content is available to all users; simply add them to your 
eScreen’s schedule to play. (For more information on scheduling 
content in Design Studio, see page 90).

Automatic Content
As an eScreen Administrator, you are to be responsible for updating 
the site-specific content. However, all corporate-wide, and business-
unit-wide content will automatically be displayed on all relevant 
eScreens without action from you. It will play alongside the local 
content that you add to your eScreens.

This type of content is indicated by one of the badges shown 
in (Figure 1-6). When you see, for example, the All Phosphates 
badge, you will know that the current content is being shown at all 
phosphate facilities. Similarly, the All Digix badge indicates that the 
content is being shown organization-wide.

Figure 1-6. Automatic content 
indicator badges



CHAPTER 
TWO

eScreen Templates

One of the most important parts of the eScreen system is 
the content that you will be displaying.

The way in which you will get most of your content posted 
on your facility's eScreens is using pre-made PowerPoint 
templates with text and graphics, that are specifically 
tailored for eScreens.

To effectively use the eScreen templates, we must take 
a closer look at the information itself: What information 
should be posted? What is the best way to display this 
particular information? Are there guidelines I should follow?
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2.1	 Why We Use eScreen Templates
There are several great reasons to use eScreen templates: 
They are brand-compliant, easy to use and efficient, and come in 
a variety of styles and topics.

BRAND COMPLIANCE
The main reason the templates exist is to ensure that the information 
we post to our eScreens is brand-compliant and reaches the 
workforce in a consistent, professional manner. 

Any communication (e-mail, memo, newsletter, and even an eScreen 
slide) that leaves our desks — whether it’s intended for the public or 
for the workforce — must conform to certain visual standards called 
Branding Guidelines. 

Branding Guidelines at a Glance
The Digix visual identity system is composed of a group of design 
elements that uniquely brand Digix communications. It is the way 
our employees interact with our guests, customers and each other. 

The color palette.  As part of Digix's visual identity system, the 
palette contains 15 approved colors (Figure 2-2).

The color palette offers a range of colors that complement the Digix 
logo and each other, using natural tones that represent agriculture: 
fields, crops, soil, water and industrial environments.

The Digix logo.  There are several versions of the Digix logo 
(Figure 2-1). You are most likely to come into contact with:

• the most well-known version, the full color logo, which is only
for use on white backgrounds or white paper.

• the one-color black logo, which is only for use on light
backgrounds or white paper.

• the one-color white (reversed) logo, which is only for use on
dark background colors.

The logo must always be positioned away from other elements on 
the page or screen (Figure 2-3).

digital signage

digital signage

digital signage

digital signage

digital signage

digital signage

digital signage

digital signage

digital signage

Figure 2-1. The Digix logos
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PANTONE 
111

PANTONE
4485

PANTONE
458

PANTONE 
COOL 

GRAY 11

PANTONE BLACK

PANTONE
4495

PANTONE
617

Figure 2-2. Digix color palette

Figure 2-3. Logo positioning

digital signage
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Brand Compliance� Why We Use eScreen Templates

There are several treatments you should never apply to the Digix 
logo (Figure 2-4), including

•	 placing a black logo onto a dark background (1)

•	 setting the logo in any color other than white or black (2)

•	 placing a full-color logo on any color other than white (3)

•	 attaching other company names or text to the logo (4)

•	 placing the logo in-line with text (5)

•	 making a pattern from the logo (6)

•	 breaking apart or using the logo elements (7)

•	 transforming the logo in any way, including applying a drop 
shadow or adding a border to the logo (8)

The brand arcs.  Central to the visual identity system are the graphic 
arcs representative of the hills and patterns of farm fields. The Digix 
brand arcs are a familiar mark of coherence and professionalism, 
which carry their own set of usage guidelines. To learn more about 
the branding arc guidelines, visit the Branding Guidelines section at 
the Digix employee website.

The  fonts.  There are two fonts approved for Digix communications: 
(1) Formata and (2) Arial.

Formata is a sans serif font that can be used for headlines, subheads, 
captions and text. It is not pre-installed on Digix computers because 
there are required licenses associated with its use. (For information 
on obtaining a Formata font license, see page 13). Formata is 
used on all professionally-designed pieces like brochures and sell 
sheets. Choose from the weights shown in (Figure 2-5). 

Arial is a sans serif font that is pre-installed on every Digix computer. 
You will see Arial used in most PowerPoint presentations and Word 
documents. Choose from the weights shown in (Figure 2-5).

digital signage

digital signage

digital signage

digital signage

digital signage
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ABC Company
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digital signage digital signage digital signage digital signage

digital signage digital signage digital signage digital signage
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digital signage

digital signage

digital signage

digital signage

Lorem ipsum.

ABC Company

digital signage

digital signage digital signage digital signage digital signage

digital signage digital signage digital signage digital signage

digital signage digital signage digital signage digital signage

digital signage digital signage digital signage digital signage

digital signage digital signage digital signage digital signage

digital signage
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digital signage

digital signage

Lorem ipsum.

ABC Company

digital signage
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Figure 2-4. Digix logo treatment 
restrictions

1

2
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5

Figure 2-5. Approved fonts for 
Digix communications

Our brand:

The Digix brand is more 
than just our logo. It is 
based on a brand strategy 
that defines our vision, 
position, promise, and 
foundation. How we 
represent Digix — through 
our actions, products, 
words and visuals — is the 
sum of our brand’s worth. 
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Why We Use eScreen Templates� Easy to Use and Efficient

Branding and eScreen Communications
Because these firm branding guidelines also apply to Digix’s 
eScreens, it makes sense to have a unified, approved means of 
creating eScreen content. Using pre-made templates to create slides 
brings unity to our digital communications and ensures our strong 
brand image can be seen by employees, guests and customers.

EASY TO USE AND EFFICIENT
Using eScreen templates is easy and much quicker than creating a 
slide from scratch each time you want to post a message. You do 
not have to worry about designing a slide; you are only concerned 
with the information you’re putting into it.

Every aspect of slide-making has already been considered. All 
eScreen templates include:

•	 Approved, relevant graphics

•	 Pre-positioned graphic and text elements

•	 Text boxes and photo place holders

•	 Font choice and text size

•	 Instructions on how to use each template

All you have to do is type (or paste) the information into the 
designated areas on the slide.

VARIETY OF STYLES AND TOPICS
The eScreen templates cover a variety of topics, and most templates 
include blank versions of all slides so that you can use them for 
other needs as well.

Slide colors and layouts have been chosen for each topic. This 
ensures slide topics are easily recognized by viewers. See "Topics 
and Style Examples" on page 17 for a list of template topics.



Chapter 2: eScreen Templates 13

2.2	Getting to Know Your eScreen 
Templates

Let’s take a look at the eScreen templates, what format and styles 
are available, and how to choose the right one for your needs.

WHAT YOU WILL NEED
Before we can take our first look at the eScreen templates, you will 
want to make sure you have the following:

• The Formata fonts installed on your computer

• The template files

• A working knowledge of PowerPoint

Getting the Formata Font Files
To obtain the Formata font files, send an e-mail to brands@digixco.com 
so that a license can be secured for you. 

Many of the eScreen templates utilize the Formata fonts. You will 
get the best visual result if you have these fonts installed. (See 
11 for more information on Formata).

Getting the Template Files
The eScreen templates are essentially just slides contained in several 
PowerPoint files. Some of the files contain multiple topics and slide 
types. You can download all of the files at once, or on an as-needed 
basis, but be sure to check back for new topics and updated files.

The template files are available on the employee website. From 
your Digix computer, visit the employee website and click through 
the steps defined in (Figure 2-6).

A Working Knowledge of PowerPoint
Although the templates are pre-formatted, you will also use traditional 
PowerPoint tools to get the results you want, e.g., resizing a text box, 
rotating a photo, and exporting slides. For PowerPoint training, visit 
http://microsoft-training.digixco.com/office.htm.

How do I install 
the Formata font?

Once you receive the 
font files from Mosaic's 
Public Affairs department, 
e-mail the Digix Global 
Service Desk at
Global.ServiceDesk@digixco.com 

to request that the 
font be installed.

Be sure to let them 
know that you already 
have the font files.

Someone from the Global 
Service Desk will contact 
you to install the fonts.

Figure 2-6. Employee website navigation for downloading eScreen templates

Digix Employee Website
https://employee.digixco.com

Brand Guideline Templates
(In the ‘Quick Links’ menu)

Downloads
(On the right)

eScreen Templates
(On the right)
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Getting to Know Your eScreen Templates� The Template Files

THE TEMPLATE FILES
When you have downloaded the PowerPoint files, store them in a 
place where you can easily access them in the future. You will notice 
that the files are named by topic as shown in (Figure 2-7).

Figure 2-7. Example of a typical template file list on your computer.

The template files are available on the employee website. (For more 
information, see "Getting the Template Files" on page 13).

Basic File Management
Store the files somewhere safe, like on your personal network drive. 
Name the folder something easy to remember, like Templates, as 
shown in (Figure 2-7). It is a good idea to keep a fresh, untouched 
copy of the template files on your personal network drive as well.

As you create slides, the template files will become saturated with 
your own content. Should you need a fresh copy of a template file, 
you can retrieve it quickly from your personal network drive.

Backup, backup, 
backup!

Keeping your work on 
your desktop computer 
may be convenient, but 
you should store them on 
your personal network 
drive, along with fresh, 
untouched copies of 
the template files. 

You may also choose to 
keep all of your working 
files on your personal 
network drive, and work 
directly from there. Either 
way, be sure to have a 
backup of all work.
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TEMPLATE SIZES
There are two distinct sizes of eScreen templates to choose from: 
large and small. The size you choose depends on where you intend 
to post the finished slide:

•	 Main area (1)

•	 Upper right area (2)

Large templates.  Large slides should be posted in the main area, 
the larger of the two areas highlighted in (Figure 2-8).

Small templates.  As shown in (Figure 2-9), template files with the 
prefix sm_ contain small slides that have been specifically formatted 
to retain readability when displayed in the smaller upper right area.

Content of any type or topic may go in either area highlighted 
in (Figure 2-8). For more on content types and examples, see 
"eScreen Content Guidelines" on page 6).

CHOOSING A TEMPLATE
Consider the message you want to post. To begin your slide, you 
must determine how the message should be composed, which 
layout area the completed slide should be posted to, as well as the 
size and topic of the template you should choose.

Consider the information that you will use to create your slide:

•	 What form of information is it (text, photos, etc.)?

•	 How long is the text?

•	 How time-sensitive is the information?

•	 Is there a template that covers this topic?

•	 What is its intended visibility (high, moderate, etc.)?

Figure 2-8. eScreen layout areas 
available for posting slides

Figure 2-9. Files for small 
templates bear the sm_ prefix
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Taking into account the suggestions outlined in (Figure 2-10.1), 
consider the following use-case scenarios:

•	 If your message is moderate in length and needs to be highly 
visible, then you should post it in the main area.

•	 If your message is very short, and does not need to be highly 
visible, then you should post it in the upper right area.

•	 If your message is rather long, but there was no suitable 
template for your needs, then you should post the information 
in the text ticker area. (For more information, see  page 115).

•	 If you have a set of photos that does not require high-visibility, 
then you should post them in the upper right area.

More About the Upper Right Area
Due to its small size, the upper right area should only be used for 
very short, concise messages and reminders. The upper right area 
is typically it is used to display continual or recurring information like 

Small template, 
big text:

When using a small 
template, you will notice 
that its text appears very 
large. Do not be tempted 
to resize the text. Always 
follow the suggested 
minimum point sizes.

The slides will be displayed 
much smaller in the upper 
right area of the eScreen 
layout, and the large text 
helps retain its readability.

Text with 
Photo(s)

Main area     Upper right area     Text ticker

*You should keep all messages as concise as possible. (See “Paring Down Long Text” on page 138).

Photo(s)

Long 
Text*

Moderate 
Text*

HighModerate

What is the intended 
visibility?

NoYes

Is there a template for 
this topic specifically?

ModerateVery

How time-sensitive is 
the  information?

Short 
Text

The 
information 
is primarily:

(large template) (small template) (see page 115)

Figure 2-10.1 Suggested eScreen layout areas for messages by typeFigure 2-10.2
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reminders and training dates, as well as non-crucial information like 
event/employee photos.

Topics and Style Examples
Below are several examples of the content-specific eScreen slides 
you will find in the template files. This is not a complete list, and 
each file may include several slide layouts, colors, and topics. (For 
more information on choosing slide layouts, see page 21).

RIFR Data

Site Leaders

Quarterly Updates

Relay for Life

United Way

Snow Advisory

SafeStart™

General Health Screen

Welcome Slides

Heat Advisory

Security/IT

Photo Collage

Figure 2-11. Sample slide styles and topics (continued on next page)
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Blank Slides and General Purpose Slides 
In the event that there is no suitable template for your needs, 
many blank and general-use templates have also been provided in 

Energy Tip

Traffic Advisory

Breast Cancer Awareness

Biometrics Screening

Job Openings

Hurricane Preparedness

MIP/EIP Scorecard

RoicWorks!

Osteoporosis Screening

Lifestyle Management

Hurricane Information

Management Meetings

Blood Donation

Holiday

Figure 2-11. Sample slide styles and topics (continued from previous page)
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numerous formats and color combinations so that you can start your 
message from scratch. For more information on light customizations, 
see "Recommended Slide Conventions" on page 142.

Below is a small sample of the styles available for your general 
communication needs, and the name of the file containing them:

Plain without Heading Box
gen_use_1.pptx

Plain with Heading Box
gen_use_3.pptx

Full photo without Heading Box
gen_use_1.pptx

Full Photo with Heading Box
gen_use_2.pptx

Figure 2-12. Sample general-purpose slides (continued on next page)
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Plain White
gen_use_4.pptx

Small Plain
sm_gen_use_1.pptx

Small Full Photo
sm_gen_use_2.pptx

Figure 2-12. Sample general-purpose slides (continued from previous page)

Requesting Additional Templates
You may come across a recurring topic or message that you are 
continually posting to your eScreens. If you feel that it would benefit 
your or other users’ workflow to have a new eScreen template made 
for a particular topic, contact the Public Affairs department.

Digix's Public 
Affairs department

E-Mail: 
public.affairs@digixco.com
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2.3	How to Use the Templates
Now that you know how to choose a template based on the topic 
and placement of the message you want to post, let’s open a 
template file and take a look around.

Template Instructions
The first thing you will notice when you open a template is the 
template instructions. A set of instructional slides — with helpful 
pictures  for each step — is included inside all template files. The 
instructional slides will include some or all of the following:

•	 How to create a new slide

•	 How to insert and format a photograph

•	 How to save/export the slides

These slides are like any other slide in PowerPoint, and can be 
rearranged or deleted. When exporting slides, be sure you are not 
exporting the instructional slides along with the ones you created. 
(For more information on exporting slides, see page 27).

CHOOSING A  
SLIDE LAYOUT
Step 1 on the first instructional 
slide says to click on the arrow 
below the New Slide button 
(Figure 2-14).

Every template file has many 
layout and color options, and 
may even contain more slide 
topics. These can only be 
accessed by clicking this button.

Slide options in the New Slide 
menu are grouped by color, type, 
or in some other logical way. In 
the Weather Advisory template 
(Figure 2-13), slide options are 
grouped by type of weather.

Figure 2-13. Slides are grouped 
logically in the New Slide menu.

Important:
Click the arrow below the 
New Slide button to see all 
layout and color options included 
in that template file.

Figure 2-14. Step 1 of the first 
instructional slide
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Slides are also sub-grouped by the type of message, the slide 
elements they contain, or in some other logical way. In the Weather 
Advisory example (Figure 2-13), the Cold Weather group contains 
slides for general cold weather, snowy weather, and icy weather. 
The Stormy Weather group contains slides for thunderstorms, 
hurricanes and tornados.

Slide Layout Objects
A slide layout object is an element contained within a slide, such as 
a text box or photo placeholder, that receives your input. Some slide 
layout objects include:

•	 Text boxes  can be used for title text, subtitle text, body text, 
event dates, captions, etc.

•	 Photo placeholders  can be used for photos of events, 
employees, or the person being quoted in a message.

•	 Graphic elements  are typically part of the background image 
and cannot be moved or replaced. They can separate or group 
items, and provide visual interest or clarification to the slide.

•	 Multi-element placeholders  allow you to insert any type of 
media into a slide: tables, charts, photos, graphics and items  
from other Microsoft® Office products.

A given slide may contain several layout objects. The way the objects 
are combined or arranged will determine which slide layout will 
work best for the message you are composing.

Use-Case Scenario:
A message that will only have a title and a few lines of text, will 
go into a slide layout that has text boxes for a title and body 
text. For this type of message, you would not want to choose 
a slide layout that also has a text box for a subtitle and a photo 
placeholder.

More about slide 
layout objects:

•	 Editable objects have 
a thin dotted line.

•	 To begin typing in a 
box, click inside of it.

•	 Do not place text or 
other objects over the 

“DO NOT COVER” area.

•	 Follow all instructions 
inside layout objects.

•	 Objects you did not 
type into or insert a 
something into will 
be invisible when the 
slide is exported.

Figure 2-15. About layout objects
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Special-Use Layouts
Let’s look at a more complex example of slide layout objects that 
are arranged to accomplish a special function. The slide is found 
in the template file: weather_with_displays.pptx in the Hot or 
Stormy Weather group with the name General Heat Text Only 
(Figure 2-16). This slide would be used to warn the workforce of a heat 
advisory issued by your local weather station or Safety department.

In (Figure 2-17) you can see that there are several layout objects 
on the slide. However, only four are user-editable:

•	 the body text box (item 3)

•	 the two text boxes for high and low values (item 4)

•	 the text box for day of the week (item 5)

The other objects, including the title, were pre-placed for the 
functionality of this particular slide and are not user-editable. 

The body text.  The main text box (item 3) is where a user will type 
or paste the message.

The weather display.  On the slide, to the left is a combination 
of objects including: graphic elements (item 6) and text boxes 
(items 4 and 5) where a user will type the required information. 
When complete, it becomes a visually-appealing and useful weather 
display that will enhance the message.

ADDING INFORMATION TO A SLIDE 
Example Exercise:
In this example, we will go through the steps to create 
a Severe Heat Advisory slide. We will type a message 
that we have composed into the main text box, fill-in 

the required weather display information, and export the slide from 
PowerPoint. First, lets take a look at how to add the information.

1.	 Title graphic element

2.	 Background image

3.	 Text box

4.	 Text boxes

5.	 Text box

6.	 Graphic element

12

3

5

6

4

Figure 2-16. Choosing the General 
Heat Text Only slide layout

Figure 2-17. Example of layout 
objects on a slide template
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Follow these steps to open the example slide:

1.	 Open the file.  In your templates folder, double-click the file 
weather_with_displays.pptx to open it in PowerPoint

2.	 Show the New Slide menu.  Click the arrow below the 
New Slide button to bring up the New Slide menu.

3.	Choose the slide.  Click the slide General Heat Text Only in the 
Hot or Stormy Weather group (Figure 2-17 on page 23).

The new, blank slide will now 
appear in the slide list on the 
left. If the new slide was inserted 
between the instruction slides, 
you may choose to move it to the 
bottom of the list by dragging it 
below the last slide (Figure 2-18).

HINT:  The messages for your 
facility's eScreens may be 
composed using any of several 
sources. (For more information 
on the type of content you 
should post, see “Where Do I Get 
Information?” on page 134).

Follow these steps to fill-in the text boxes on the example slide:

4.	 Fill in the body.  Click on the main text box and type in: 

Please be advised that the severe heat that is anticipated for 
Friday, August 13, may impact your working conditions. Stay 
cool and remember to drink plenty of fluids during the day!

Remember:
If you need medical assistance, dial 1455 from any facility 
phone.

Figure 2-18. Moving slides within 
the slide list on the left in PowerPoint

The bare minimum:

Most text boxes will state 
a minimum text size, but  
a 22-point minimum text 
size is recommended 
when it is not stated. 
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5.	 Fill in the day of the week.  Click on the text box for the day 
of the week at the top of the weather display and type the 
following text: Fri (Figure 2-19).

6.	Fill in the high value.  Click on the text box for the high 
temperature value and type in: HIGH 98.

7.	 Fill in the low value.  Click on the text box for the low 
temperature value and type in: LOW 85 (Figure 2-20).

HINT:  As you type, the text will resize to fit the shape of the 
text box without cutting off any part of the message.

Now you have what looks like a functioning weather display to post 
on your eScreens. Viewers will immediately understand that on the 
day specified (Friday), the temperature will be very high (up to 98 
degrees), which brings more importance to your suggestion to work 
safely and drink plenty of fluids.

Case-in-Point:
Of course, you should obtain accurate temperatures for the day(s) 
for which you are making slide(s). These can come from your 
local news outlet, a weather website such as www.weather.com, 
or the weather app on your smartphone.

PREVIEWING A SLIDE
Notice that the thin dotted lines are now missing around the layout 
objects where you have typed the information. This indicates the 
layout object is no longer invisible; its contents will export properly.

There is one layout object whose dotted line did not disappear: the 
“DO NOT COVER THIS AREA” text box at the top left. We would 
not want this text to display on our final slide, however, it is not 
necessary to delete the text or the text box. Because the text box 
has a thin dotted line around it, its contents will neither print nor 

Figure 2-19. 

Figure 2-20.
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export. You can be sure of this by previewing the slide using the 
Slide Show mode inside of PowerPoint.

Follow any one of these steps to 
preview the slide in Slide Show mode:

1.	 Click the Slide Show button  in 
the status bar at the bottom of the 
window (Figure 2-21), or

2.	Click the From Current Slide button.  This can be found 
under the Slide Show tab in the tool bar (Figure 2-22), or

3.	 Press the F5 key on your keyboard. %

In the preview, you will notice that the “DO NOT COVER THIS AREA” 
text does not display (Figure 2-23). You see a high-quality, accurate 
view that shows exactly what your final slide 
looks like. Be sure to give your message one 
more quick review for spelling and structure.

Follow any one of these steps to close  
the Slide Show mode and return to the 
regular editing mode:

1.	 Press the Esc key on your keyboard,  or

2.	Choose End Show.  Choose End Show 
from the menu that appears when you 
right-click anywhere on the slide show 
presentation as shown in (Figure 2-24).

Figure 2-21.

Figure 2-22.

Figure 2-23. Slide preview Figure 2-24.
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Okay we’re all done! You have decided your slide looks great, 
and is ready to be exported out of PowerPoint.

EXPORTING A SLIDE
Example Exercise:
To export a slide or slides out of PowerPoint simply 
means to save the slide or slides in any format other 
than the PowerPoint document format. Before we 

begin, make sure the slide you want to export is the current slide 
being shown on your screen.

Follow these steps to export a slide:

1.	 Open the File Menu.  to open the File menu., click on the 
File button at the top left corner of the window  as shown in 
(Figure 2-25).

2.	Click Save As.  In the File menu that appears, click the Save As 
button as shown in (Figure 2-26). The Save As dialog box will 
appear as shown in (Figure 2-27).

Figure 2-25.

Figure 2-26.

Figure 2-27. Parts of the Save As dialogue box

Folder List
Lets you navigate to other 

folders to save your slide in 
another location.

Save As Type
Shows the file type of the 

slide you are about to save.

File List
Shows a list of files in the 
current folder that matches 
the type chosen in the 
Save As Type box .

Current Location
Shows the name and 

location of the folder where 
you are about to save.

File Name
Choose a name for your file 
and type it here.

Save Button
Click this button when you 
are ready to save your slide.
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3.	 Choose a location for your file.  Using the folder list in the in 
the Save As dialog box, choose where you would like to save 
the exported slide. In this example, save it to your desktop.

4.	Give the file a name.  Choose a descriptive name for the slide 
you are exporting, and type it into the File name box. We will 
call this slide heat_advisory_0813 (Figure 2-28).

Changing the File Type
As of now, the Save as type box still says PowerPoint Presentation 
(*.pptx), but we do not want to use this file type. Using this file type 
would save the entire document as a PowerPoint presentation. You 
must choose a file type that the eScreens can display, like PNG. 

Follow these steps to change the document type to PNG:

5.	Open the file type menu.  In the Save As dialog box that we 
opened in the previous step, click on the Save as type  box 
(Figure 2-28), and a long list of file types will appear.

HINT:  This list is not in alphabetical order. To quickly cycle to 
the PNG item in the list, type jp on your keyboard. This 
cycles through: JPEG then PNG. Press enter to accept the choice.

6.	Select the PNG file format.   Choose PNG Portable Network 
Graphics Format (*.png) from the list (Figure 2-29).

Figure 2-28.

Basic file 
organization tip:

You can create a new 
folder from inside the Save 
As dialog box by following 
these steps:

1.	 Right-click on a blank 
area in the file list.

2.	 Choose New 

3.	 Choose Folder

4.	 Give your new folder a 
descriptive name.

5.	 Open the new folder 
by double-clicking, and 
save your slide in it.

Figure 2-29.

1

2
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JPEG vs. PNG File Types
The most common file type for photographs is JPEG. However, 
drawn images and illustrations with varying amounts of text and 
graphics — like the eScreen slides — are better suited for the PNG file 
type, which offers a higher quality for the eScreens.

Hint:  PNG files are no different to you or the eScreens. You will 
store, open, and view them the same as you do with JPEG files.

Saving the Slide
Now you will complete the export process by saving the slide. 
Review the settings in the Save As dialog box. In the previous steps, 
you set the following attributes:

•	 File name: heat_advisory_0813
•	 File type: PNG
•	 Location: Desktop

Follow these steps to save the slide with its current settings:

7.	 Click the Save button.   At the 
bottom of the dialog box, click 
the Save button (Figure 2-31).

8.	Choose Current Slide Only.  
A dialog box will appear (Figure 2-32). Because there is more 
than one slide in your PowerPoint document, the program 
needs to know whether it should save all the slides or the current 
slide only. The slide you created was currently active when you 
chose the Save As command, so clicking Current Slide Only 
will save only the current, active slide.

Figure 2-30. Comparing the JPEG and PNG file types

Figure 2-31.

The Saved Slide
After you save 
the file, you will 
see it on your 
desktop. You 
can organize it 

into another folder if you choose, 
or add it directly into Design 
Studio. See "Importing and 
Organizing Content" on page 
83 for more information.

Figure 2-32.

What does it all 
mean?

JPEG, the file type we 
know best for photographs, 
is an acronym for Joint 
Photographic Expert Group.

PNG is an acronym for 
Portable Network Graphics.
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WORKING WITH TEXT
To get the best visual result for the text on your eScreen slide, 
sometimes you will need to format or edit a message after you see 
it placed into the slide layout.

Example Exercise:
In this example, we will go through the steps to create 
an Employee of the Month slide. We will compose a 
message from information we received in an e-mail, 

place the text into a slide layout, and learn how to format the text 
using traditional tools found inside of PowerPoint.

When you receive an e-mail like the one shown in (Figure 2-33), 
your first step is to determine where to post the message, and 

which template you should choose.

We know from the chart in (Figure 2-10.1 on 
page 16) that because the slide will contain a 
photo and short text, we should post it in the main 
area. This means we’ll choose a large template.

We know from the section "Topics and Style 
Examples" on page 17, and by looking at the 
list of template files, that there is no template for 
congratulating employees of the month.

Hint:  For general messages like this one, a 
general-use slide layout with a text box and a 
photo placeholder will be the best approach.

For this example, we will start with a general-
purpose template, and select a slide layout that 
will accommodate our message.

Figure 2-33. Example request you may receive via e-mail 
for information to be posted on the eScreens
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Follow these steps to open the example slide:

1.	 Open the file.  In your templates folder, double-click the file 
gen_use_3.pptx to open it in PowerPoint

2.	 Show the New Slide menu.  Click the arrow below the 
New Slide button to bring up the New Slide menu.

3.	Choose the slide.  Click the slide named Text and Content 
30/70 in the Light Blue and Light Orange group (Figure 2-34).

Hint:  The layouts in this file are sub-grouped by the objects 
they contain, and the size ratio between content placeholders 
and the text boxes are displayed in the layout name. The photo 
we will be using in the next exercise, johnny_photo.jpg, is in 
the portrait orientation (vertical). A layout with a 30/70 ratio 
best matches the content placeholder to that orientation.

When the new slide appears, let’s examine its layout objects to 
ensure it will fit our needs: In (Figure 2-35) we see that there are 
several layout objects on the slide. The following are user-editable:

•	 the title text box (2)

•	 the subtitle text box (3)

•	 the text box for body text (4)

•	 placeholder for the photo (5)

•	 photo caption text box (6)

The e-mail we received contains enough information to fill-in these 
layout objects: The title text box (“Employee of the Month”), the 
body text box (a message we will compose from the e-mail), and 
the content placeholder (the photo attached to the e-mail). We will 
learn more about working with photos on page 36.

You can compose your own text to fill in the remaining text boxes 
(subtitle and caption) or you can leave them blank. We know from 

Figure 2-34.

1.	 Background image with 
graphic elements

2.	 Text box

3.	 Text box

4.	 Text box

5.	 Content placeholder

6.	 Text box

1 2
3

5

6

4

Figure 2-35. Example of layout 
objects on a slide template
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the section "Previewing a Slide" on page 25, that empty text 
boxes or placeholders will not show up on the exported slide.

Follow these steps to add text to the example slide:

4.	 Fill in the title.  Click on the title text box and type: Employee 
of the Month

5.	 Fill in the subtitle.  Click on the subtitle text and type the current 
month and year. For this example, type: November 2013.

6.	Fill in the body text.  Click on the main text box and type:

7.	 Fill in the photo caption.  Click on the caption text box and 
type: Johnny B. Safe, Mechanic - 04 Maintenance Team.

Hint:  The body message was composed using the information 
we received in the e-mail shown in (Figure 2-33). For more on 
how to extract information from e-mails, and which information 
you should include in a message, see page 137.

FORMATTING TEXT ON A SLIDE
When the text is entered, we see that it is not appealing 
(Figure 2-36): The employee’s name gets lost inside the 

rest of the text, and the line break in the caption is at an odd location.

To fix these problems and add a bit of visual interest, we will:

•	 center the body text

•	 make the employee name bold in the body text

•	 put the employee name on its own line in the body text

•	 put the employee name on its own line in the caption text

•	 italicize the employee’s job title in the caption text

Congratulations to Johnny B. Safe from the 04 
Maintenance Team for making employee of the month 
for November.

On Pasting Text
When pasting message text 
instead of typing it, you can use 
the keyboard shortcut Z + v.

Be careful that the pasted text 
takes the formatting of the text 
box into which you are pasting it. 

For more information, see 
"Copying Text from Another 
Source" and  "Pasting Text into a 
Slide" on page 62.

Figure 2-36. Our progress so far
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Selecting All Text in a Text Box
Follow any one of these steps to select the body text:

1.	 Use the Select menu.  Click once inside 
the body text to activate the text box, and 
choose Select All from the Select menu in 
the Editing area of the tool bar as shown 
in (Figure 2-37).

2.	Use the keyboard shortcut Ctrl + A .  Click 
once inside the body text to activate the text 
box, and press Z + a on the keyboard.

Keyboard Shortcut Tip:  Press and quickly 
release the A key while holding down the 
control key. Then release the control key. 

3.	 Triple-click the text.  With or without the 
text box active, clicking anywhere on the 
body text three times in rapid succession 
will select the entire body of text.

Centering Text in a Text Box
Follow any one of these steps to center the body text:

1.	 Use the Center button on the 
tool bar.  With the body text selected, click 
the Center button in the Paragraph section 
of the tool bar (Figure 2-39).

2.	Use the keyboard shortcut Ctrl + E.   With 
the body text selected press Z + e on your keyboard.

Inserting Forced Line Breaks in a Text Box
Now that the body text is centered in the text box, we want to put 
the employee’s name on its own line using forced line breaks, which 
are also known as carriage returns.

Tool Tips:
If you do not see the tool bar 
items listed in the steps, one of 
the following may be the cause:

•	 The Home tool bar is not 
being shown. Click on the 
Home tab to show the 
Home tool bar.

•	 The tool bar buttons are 
being combined into 
menus due to screen size. 
This is normal behavior, 
however your buttons and 
tools may not look the 
same as the screen shots 
shown. Simply click the 
menu to see the tools it 
contains (Figure 2-38).

Click to select text:

The following applies 
to selecting text in 
PowerPoint:

•	 Double-clicking will 
select a word.

•	 Triple-clicking will 
select a paragraph.

In this example, triple 
clicking selects all of the 
body text because the 
text is not divided into 
paragraphs (there are no 
carriage returns in the text).

Figure 2-37.

Figure 2-38.

Figure 2-39.
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Follow these steps to insert carriage returns in the body text:

1.	 Place your type cursor before the employee name.  Using 
your mouse, click once just before the ‘J’ in Johnny B. Safe. 
This will insert your type cursor there. It is okay if the employee 
name is already at the beginning of the line.

2.	 Press the enter key on your keyboard.   Because forced line 
breaks are invisible, it will not look like much as happened if 
the employee name was already at the beginning of the line.

3.	 Place your cursor after the employee name.  Using your 
mouse, click once just after the ‘e’ in Johnny B. Safe.

4.	Press the enter key on your keyboard.  Now the employee 
name should be on its own line as shown in (Figure 2-40).

Hint:  The spaces between the employee name and the words 
before and after it, are still in the text. Even though you cannot 
see them, they may affect the centering of the text slightly. 
Delete the extra spaces to ensure your text is truly centered.

Selecting Only Some Text in a Text Box 
Now the employee name is on its own line (Figure 2-40). However, 
it is in the same style as the rest of the text. We want to add some 
emphasis only to the employee name, so we must select only that.

Follow any one of these steps to select only some text:

1.	 Click and drag.  Place your mouse cursor at the beginning of 
the text you wish to select, and drag across the text.

Hint:  Dragging means to hold down your primary 
mouse button while moving your mouse across the text. 

2.	Use the Shift key.  Insert your type cursor at the beginning of 
the employee name. Hold down the | key and press the 
right-arrow key multiple times until the text is selected.

Figure 2-40.

More selection 
shortcuts:
•	 Shift + Home 

selects all text from 
the cursor to the 
beginning of the line.

•	 Shift + End selects all 
text from the cursor to 
the end of the line.

•	 Holding the Shift and 
Ctrl keys will select 
whole words when 
used with the left/
right arrow keys, and 
whole paragraphs 
when used with the 
up/down arrow keys.
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Making Text Bold in a Text Box
Follow any one of these steps to make the selected text bold:

1.	 Use the Bold button in the 
tool bar.  With the text selected, 
click the Bold button in the Font 
section of the Home tool bar 
(Figure 2-41).

2.	Use the keyboard shortcut Ctrl + B.  With the text selected, 
press Z + b on your keyboard. 

Now the employee name stands out more, and the message is 
easier to read at a glance (Figure 2-42).

Let’s shift our attention to the caption text box in the bottom 
left area of the slide. We know that we want the employee’s 

job title on the line below his name, so we will insert a forced line 
break between the comma and the job title. (See page 33 for 
more information on inserting forced line breaks).

Making Text Italic in a Text Box 
Now we will italicize the employee’s job title in the caption box. To 
do that, select only the employee’s job title. (See page 34 for 
more information on selecting only some text).

Follow any one of these steps to make the selected text italic:

1.	 Use the Italic button in the 
tool bar.  With the text selected, 
click the Italic button in the Font 
section of the Home tool bar 
(Figure 2-43).

2.	Use the keyboard shortcut Ctrl + I.  With the text selected 
press Z + i on your keyboard. 

You can see in (Figure 2-44) that the job description is now italicized.

Figure 2-42.

Figure 2-44.

Our Progress
If we preview our slide in the 
Slide Show mode (Figure 2-45), 
we will see that all of the text on 
the slide looks great. (For more 
information on previewing a 
slide, see page 25).

We will fill in the blank area with 
a photo of the employee in the 
next exercise.

Figure 2-45. 

Figure 2-41.

Figure 2-43.
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WORKING WITH PHOTOS
Photographs are an essential part of communication. A photo should 
always accompany your message if:

•	 a photo pertaining to your message is available

•	 there is adequate space on the slide to accommodate both 
your message and the photo 

Example Exercise:
We will add a photo to the Employee of the Month slide 
we began in the previous excercise. We will learn how 
to take a photo from an e-mail and place it into a slide.

Saving a Photo from an E-mail
When you receive an e-mail message with a photo attachment that 
you would like to add to a slide (Figure 2-46), the first step is to get 
the photo out of the message and put it on your desktop.

Follow any one of these steps to save an 
attachment from an e-mail message:

1.	 Use the Attachment Tools (Figure 2-47).  
Click once on the attachment to be saved (1). 
At the top of the e-mail message, click the 
yellow Attachment Tools tab (2), then click 
the Save As button (3). To save multiple 
attachments, click the Save All Attachments 
button instead. When the Save As dialog box 
appears, choose Desktop in the folder list 
and click Save. You do not need to give the 
photo a name.

2.	 Drag the photo onto your desktop.  Make 
sure you can see both the e-mail message 
window and a blank area of your desktop. 
Drag the attachment onto your desktop 
(Figure 2-48).

Figure 2-47. 

Figure 2-46. An e-mail message with photo attachment

1

2

3
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Hint:  If the photo was sent 
inside the e-mail text instead 
of as an attachment, right-
click on the photo, and choose 
Save as Picture (Figure 2-49).

You may want to organize the 
photo into a folder for future 
use. Or you can delete it after it 
is placed in the slide, if you know 
you will not use it again.

ADDING A PHOTO TO A SLIDE
Now that we have saved the photo onto our desktop, we want to 
insert it into the Employee of the Month slide that we began in the 
previous exercise on page 30.

In the center of the content placeholder there are six icons as shown 
in (Figure 2-50): 

•	 Insert Table (1)

•	 Insert Chart (2)

•	 Insert SmartArt Graphic (3)

•	 Insert Picture from File (4)

•	 Clip Art (5)

•	 Insert Media Clip (6)

You will occasionally encounter 
a slide that was specifically 
designed for photo content, and 
the content placeholder will only 
have one icon: Insert Picture 
from File (4). 

Figure 2-49. The menu that 
appears when you right-click a photo 

inside e-mail message text

Placeholder icons:

The icons in the content 
placeholders are semi-
transparent until you hover 
your mouse pointer over 
them. A helpful reminder 
will appear as you move 
the mouse over each one.Figure 2-50. Content placeholder

2

5

3

6

1

4

Figure 2-48. Dragging a photo out of an e-mail message
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Follow these steps to fill the content 
placeholder with a photo:

1.	 Click the photo icon.  Inside of the 
content placeholder, click the photo 
icon as shown in (Figure 2-51).

2.	 Navigate to your desktop.  In the Insert 
Picture dialog box that appears, click Desktop 
in the folder list. 

3.	 Choose a photo to insert.  From the list of 
files on your desktop, choose the file we put 
there earlier: johnny_photo.jpg.

4.	 Click the Insert button.  At the bottom of 
the Insert Picture dialog box, click the Insert 
button to insert the photo.

Steps 2 thru 4 are illustrated in (Figure 2-52).

Previewing Our Progress
Preview the slide in the Slide Show mode (Figure 2-53). The photo 
has inserted properly in the center of the content placeholder. (For 
more information on previewing a slide, see page 25).

However, it looks like the photo would benefit visually from a white 
border, and a drop shadow to match the text.

FORMATTING PHOTOS
Just like you can change font sizes and text colors, there are several 
attributes you can apply to photos as well. PowerPoint has several 
formatting presets for photos to help us.

Follow these steps to add a Picture Styles preset to a photo:

1.	 Select the photo.  Using your mouse, click once on the photo 
you want to add a picture style to.

Figure 2-51.

3

4

2

Figure 2-52.

Figure 2-53. 

Hint:  Begin typing the file 
name in the File name box. 
Use arrow keys to choose the 
file from the list that appears. 
Press Enter to insert the photo.
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2.	Open the Format tool bar.  When any photo is selected, a 
pink Picture Tools tab will appear at the top of the program 
window. Click the Format tab to open the Format tool bar.

3.	 Select a picture style.  in the Picture Styles section of the 
new tool bar, you will see several options. Click the first option 
as shown in (Figure 2-54).

The photo is now formatted with a white border and a drop shadow, 
which compliments the style of the text nicely (Figure 2-55).

More on Picture Style Presets
PowerPoint has a total of 28 Picture Style presets. Each one applies 
varying treatments to the selected photo including:

•	 photo shape and rotation

•	 photo border

•	 drop shadow

•	 reflections

To see all available presets, click 
the downward arrow in the 
bottom-right corner of the list 
in the Picture Styles section 
of the tool bar (Figure 2-56).

Not all presets are appropriate for eScreen slides. Use discretion when 
formatting photos, and always choose a preset that compliments 
the other elements on the slide. Here are some helpful guidelines:

•	 choose only style presets with square or rectangular shapes

•	 choose style presets that do not excessively distort the photo

•	 if you are ever unsure and want to be safe, choose only from 
the first five options in the Picture Styles presets list

Figure 2-54.

23

Picture Style 
previews:

When you hover your 
mouse pointer over a 
Picture Style preset in 
the menu, you can see 
a temporary preview of 
the style applied to your 
selected photo. The photo 
will revert to its previous 
style when you move your 
mouse cursor away from 
the Picture Style presets.

Figure 2-55.

Figure 2-56.

Export the finished 
slide with the name 

eom_nov.png using the steps 
listed in "Exporting a Slide" on 
page 27.
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2.4	Doing More with Templates
In the previous section you learned how to insert text and photos 
to create basic eScreen slides that will work for most of your 
needs. Let’s learn a few more basic techniques like cropping 
photos, resizing objects, selecting multiple objects, and adding 
your own objects to a slide layout.

Special Template Instructions
You will occasionally come across a template with a different set of 
instructions than you are used to. These instructions can be on a set 
of instructional slides, listed in a text box, or in a content placeholder. 

Hint:  Don’t let the word ‘special’ 
frighten you! The instructions are easy, 
clear, and you can get remarkable 
results just by following their steps! 

The file we will use in our next 
exercise, photo_collage.pptx, has 

a few special instructions.

Take a look at (Figure 2-57). Until now, 
we have only used the New Slide 
menu to see the slide layout options in 
a template. However, the photo collage 
template already has its slide layout 
options in the slide list at the left.

Example Exercise:
In this example, we will follow the steps to create a 
Photo Collage slide. We will insert a few photos, and 
learn the different ways they can be manipulated.

Let’s assume that there was a Digix event this past weekend that we 
want to highlight on the eScreens. There are three photos that we’d 
like to put together in a collage. For the example, we will assume 
they are on our desktop in a folder called: Collage Photos.

Hint:   To follow along with this exercise, choose three photos 
that you already have. Use copies of the original files just incase.

Figure 2-57. Slide layout options located in the slide list
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Follow these steps to open the example slide:

1.	 Open the file.  In your templates folder, double-click the file 
photo_collage.pptx to open it in PowerPoint

2.	Choose a slide from the slide list on the left.  Click on any of 
the slides to see them. For our example, we will use the slide 
with three photo placeholders (slide number 5 in the list).

When the slide appears, examine 
its layout objects to ensure it will 
fit our needs: In (Figure 2-58) 
we see that there are three 
frames with photo placeholders. 
Because we have three photos, 
this slide will suit our needs.

DUPLICATING A SLIDE
It is important to remember that in the case of this template file, the 
layout options in the slide list are just regular slides. If you edited the 
slide and save the file, , the changes you made would still be there 
the next time the template is opened. You will have lost the blank, 
pre-formatted slide layout options.

Hint:  You can always download new, blank template files from 
the employee website. (See page 13 for more information).

To avoid permanently changing the pre-formatted slides, it is 
necessary to duplicate the slide layout you would like to use.

Follow these steps to duplicate a slide:

1.	 Select the slide.  In the slide list, click once on the slide you 
would like to duplicate. For our example, click on slide 5.

2.	Use the keyboard shortcut Ctrl + D.  With the slide selected 
in the slide list, press Z + d on your keyboard.

Figure 2-58. 

What you need to 
know about the 
slide list:

There are seven 
layout options, 
each with one 
more placeholder 
than the last.

Because of the 
instructional 
slides, the 
layout options 
begin at No. 3.

The numbers do 
not follow the 
slides when you 
reorder them, 
and the slides in 
the list cannot 
be named. Be 
careful to avoid 
confusion.

The last slide in the list 
is an example slide.

Before adding photos, 
always duplicate the slide 
so that you will always 
start with a fresh one.
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3.	Move the slide to the bottom of the slide list.  Unfortunately, 
PowerPoint offers no way to organize or group slides in the slide 
list. The best approach is to keep all of the slides you create at 
the bottom of the list. For more information on moving slides 
in the list, see (Figure 2-18 on page 24).

CHANGING A PHOTO
Changing a photo means to replace one photo on a slide with 
another that you choose. This is a time-saving trick that can be great 
for re-using old slides that you have already created for other topics. 
Just switch out the old text, and use the Change Picture tool to 
replace the old photos with new ones.

In our photo collage example, we will use the Change 
Picture tool to swap out the placeholders with other photos.

Good to Know:  Unlike the content placeholders we’ve seen 
in previous exercises, the placeholders in this template are 
regular images, intended to be replaced with your photos. The 
placeholder images will appear both in Slide Show mode and 
on the exported slide, even if they are not replaced.

Follow these steps to change a photo:

1.	 Select the image you would 
like to change.  Click once on the 
leftmost photo placeholder.

2.	Open the Format tool bar.  When 
a photo is selected, a new Format 
tab will appear at the top of the 
window. Click it to show the Format 
tool bar.

3.	Click the Change Picture button.  
Click the Change Picture button in 
the Adjust section of the tool bar.Figure 2-59. Changing a photo using the Change Picture tool

1

2

3

Change is 
good:

You can also 
change a 
photo by 
right-clicking 
and choosing 
Change Picture in the menu.

A 
duplicate 
way to 
duplicate:

You can 
also 
duplicate 
a slide by 
right-clicking and choosing 
Duplicate Slide in the menu.
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4.	Navigate to your desktop.  In the Insert 
Picture dialog box that appears, click Desktop 
in the folder list. 

5.	Open the folder containing the image.  The 
file list is showing the files and folders on your 
desktop. Double-click the Photo Collage 
folder to open it.

6.	Choose a photo to insert.  From the list of 
files, choose: photo_collage_1.jpg.

7.	 Click the Insert button.  At the bottom of the 
Insert Picture dialog box, click the Insert 
button to replace the image with the selected 
photo.

In (Figure 2-61) you can see that the photo 
we chose has now taken the place of the 

leftmost photo placeholder image.

Unfortunately, it looks like one of the people in 
the photo is being covered by another photo 
placeholder. To fix issues like this, we will need to 
rotate and reposition the photos as we go.

MANIPULATING PHOTOS
In the Employee of the Month exercise on page 37, the photo that 
we inserted into the slide fit perfectly and looked great. However, in 
order to get the visual result you want, sometimes you may need to 
manipulate photos in one or more of the following ways:

•	 reposition the photo

•	 resize the photo

•	 rotate the photo

•	 crop the photo

Repositioning Photos
Repositioning, or moving, a photo is the most straight-forward way 
to manipulate it. To reveal the person whose face is covered in our 

Figure 2-60. Using the Insert 
Picture dialog box

Figure 2-61. Slide with the first 
photo inserted

7

4

5

6
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example, we will reposition the photo by moving it downward.

Follow any one of these steps to reposition the photo:

1.	 Drag the photo.  Click and hold your mouse 
button anywhere on the photo, and slowly 
drag it downward with your mouse until the 
face of the person in the photo is no longer 
covered. Release the mouse button when 
the photo is positioned where you want it as 
shown in (Figure 2-62).

2.	Use the arrow keys.  Pressing the arrow keys 
(GVCB) on your keyboard while the 
photo is selected will move it in the direction 
of the key you are pressing.

Hint:  If you hold the shift key while dragging, the photo will 
stay on a straight path in the direction you are dragging.

Now we have the result we want: the subject’s face is now visible.

Use what you learned in “Changing a Photo” on page 42, 
to insert the second photo (photo_collage_2.jpg) into the 

topmost photo placeholder.

Control Handles
Notice that several control 
handles appeared around the 
photo we just inserted: a round 
control handle at each corner, a 
square control handle at each 
side, and a round green control 
handle at the very top of the photo. Grabbing (i.e., clicking and 
dragging) any one of these control handles will manipulate the 

Cutting corners:

You may have noticed 
by now that the corners 
of some of the image 
placeholders extend 
past the sides of the 
slide. When the slide is 
exported, these corners 
will be completely cut-off.

This is acceptable, and 
gives the slide visual 
interest. Just make sure 
that faces and important 
parts of the photographs 
will not be cut-off.

Figure 2-62. Dragging to 
reposition a photo

Figure 2-63. Slide with the 
second photo inserted
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selected photo or object in one of the following ways:

•	 Dragging the corner control handles will resize the 
image proportionally in the direction you are dragging.

•	 Dragging a side control handle will stretch the image 
from the selected side, in the direction you are dragging.

•	 Dragging the top control handle will rotate the image 
in the direction you are dragging.

Hint:  When you hover your mouse over a control handle, the 
mouse cursor will change depending on the control handle.

•	 Hovering over a corner control handle will change 
your cursor to a diagonal arrow.

•	 Hovering over a side control handle will change 
your cursor to a horizontal or vertical arrow.

•	 Hovering over the rotation control handle will 
change your cursor to a rotating arrow.

Rotating a Photo
The photo we just inserted looks quite decent: no important parts of 
the photo were cut-off and no one’s face is being covered. However 
it may benefit from a bit more manipulation. If we rotate the photo, 
we will see more of it.

Follow these steps to rotate a photo:

1.	 Select the photo.  Click once on the photo 
to select it.

2.	Use the rotate control handle.  Move your 
mouse pointer to the green control handle 
at the top of the photo. Hold down your 
mouse button and drag the mouse counter-
clockwise slowly (Figure 2-64) until you get 
the result you want.

3.	 Release the mouse button. Figure 2-64. Dragging to rotate a photo
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Using what you learned 
in “Changing a Photo” on 

page 42, insert the third photo 
(photo_collage_3.jpg) into the 
rightmost photo placeholder. 
The result can be seen in 
(Figure 2-65). 

Resizing a Photo
The photo of the large group of people that we 
just inserted fits well. However, it is a little difficult 
to see all of the faces clearly because of its size. 
To fix this, we will make the new photo bigger.

Follow these steps to resize a photo:

1.	Select the photo.  Click once on the photo 
we just inserted (the rightmost photo) to 
select it.

2.	Use the resize control handle.  Move your 
mouse pointer over the round control handle 

in the top-left corner (your cursor will change to a diagonal 
arrow). Drag the control handle upward and to the left until 
the photo is approximately as big as shown in (Figure 2-66).

Unfortunately, making one photo 
bigger has covered faces of the 
people in the other two.

By cropping the new photo, we 
can cut out all the empty space 
above the group of people. To 
do this, we will use the Crop tool.

Figure 2-65. Slide with the third 
photo inserted

Figure 2-66. Dragging to resize a photo

Figure 2-67. Slide with the third 
photo resized

Resize vs. stretch:

Always use a round control 
handle at a corner to 
resize the photo. Using a 
square control handle at 
the side will stretch the 
photo it in the direction 
you are dragging.

Be careful not to reshape 
or distort photos by 
stretching them.
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Cropping a Photo
Cropping a photo is different from resizing a photo. Resizing changes 
the size of an entire photo, while cropping cuts edges off of a photo. 
You are essentially making the unnecessary parts of a photo invisible.

Hint:  Cropping a photo is never permanent. You can always 
re-crop a photo by using the Crop tool again. This way, you will 
never actually lose the unseen part of a cropped photo. 

Follow these steps to turn on the Crop tool:

1.	 Select the photo.  Click once on the photo you will crop. In 
this example, we will click on the photo that we just inserted in 
the previous steps.

2.	Open the Format tool bar.  When a 
photo is selected, a new Format tab 
will appear at the top of the window. 
Click it to show the Format tool bar.

3.	Click the Crop button.   Click the 
Crop button in the Size section of the 
tool bar (Figure 2-68).

When the Crop tool is activated, short black bars appear 
around the selected photo: one at each corner and one 
at each side. Slowly moving your mouse to one of these 
black bars will change your cursor to a cropping symbol 
(Figure 2-69). This symbol means that your mouse is in the 
proper place to begin cropping.

Follow these steps to crop a photo:

1.	 Drag a side of the photo.  With the photo selected 
and the Crop tool activated, drag one of the black 
bars toward the center of the photo. In this example, 
we will drag the top bar downward to just above the 
group of people as shown in (Figure 2-70).

Figure 2-68. 

Figure 2-69. The cursor changes to crop 
symbol, indicating you are ready to crop
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Hint:  You can continue making multiple 
crops while the Crop tool is activated.

2.	Deselect the photo.  When you have finished 
making your crops, click anywhere other than 
the photo to deactivate the Crop tool.

Previewing Our Progress
Preview the slide in the Slide Show mode 
(Figure 2-71). You can see that we have a bit more 
manipulating to do so that the important parts of 
all photos are visible. (For more information on 
previewing a slide, see page 25).

Move the leftmost photo upward to see the person who 
is still being covered, using the steps listed in the previous 

section, "Repositioning 
Photos" on page 43. 

However, the person’s 
face goes from being 
hidden behind one 
photo to being hidden 
behind another photo 
(Figure 2-72). 

To fix this, we must change the in-front-of/behind arrangement 
(known as the z-order), which we will do in the next exercise.

In too deep?

Reset the photo back to 
its original size and shape 
by clicking the Reset 
Picture & Size button in 
the Format tool bar.

Figure 2-70. Dragging to crop a photo with the Crop tool

Figure 2-71.

Figure 2-72.

MANIPULATING OBJECTS
Imagine that creating a slide in PowerPoint is like creating an art 
project in real life, like découpage. The slide and background image 
together are like the canvas. The slide objects would be like actual 
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photographs and text clippings that you arrange on top of the canvas. 
We’ve already looked at ways we can manipulate these objects just 
as we would in real life (move, rotate, etc.). Let's look at a few more.

Changing the Z-Order
Just like a real art project, the photos or text that you place on 
the canvas can go in front of or behind each other, 
and items have the potential to become hidden. 
In the computer world, this in-front-of/behind 
arrangement is known as the z-order.

In (Figure 2-73), our photo collage slide is 
dissected to show the z-order of its objects. The 
photo in question (Photo 1) is behind the other two. The photo 
covering it (Photo 2) is directly in front of it. Photo 3 is in front both 
of the other photos, however, it is not covering anything important 
like faces.

PowerPoint offers four tools for changing the z-order of objects on a 
slide. These tools have descriptive names:

•	 Bring to Front

•	 Send to Back

•	 Bring Forward

•	 Send Backward

These tools can be found in several places: The Arrange button on 
the Home tool bar; the Format tool bar that appears when a photo 
is selected; and in the menu that appears when you right-click on a 
photo.

Example Exercise:
In this example, we will continue to manipulate the 
Photo Collage slide that we began in the previous 
exercise. We will learn how to change the z-order of 

objects, create our own objects, and learn how to format them.

Figure 2-73.  
Demonstrating the z-order 

of objects on a slide

Why is it called 
the z-order?

In geometry, x refers to 
the horizontal axis (left 
to right), and y refers to 
the vertical axis (up and 
down). Perpendicular to 
these two is the z-axis 
(forward and backward).

Z-order, sometimes 
known as stacking order, 
refers to the order of 
objects along the z-axis. 
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To fix the problem of photo 2 covering the person’s face in photo 1, 
we must change the z-order so that photo 2 ends up behind photo 1.

Follow these steps to change the z-order:

1.	 Select the photo.  Click once on the photo whose z-order you 
want to change. In this example, we will click on photo 2.

2.	 Select Send Backward from the Arrange menu.  The Send 
Backward menu item can be found in the Order Objects 
menu, which is accessible by clicking the Arrange button in the 
Drawing section of the Home tool bar (Figure 2-74).

Our results.  In (Figure 2-75), 
you can see that the photos are 
now arranged properly, and the 
slide looks much better. No faces 

or important parts of any 
photo is being covered, 
and the spacing looks 

good. To understand what 
we’ve really done, take a look at 
(Figure 2-76). Now Photo 2 is behind Photo 1. If you are following 
along with the example, you may want to make minor adjustments 

to the position, rotation or size of the photos to get them 
looking just right before you export them.

More about the Object Order tools.  It is important to remember 
that the each time you click one of the Object Order tools, the 
selected object is moved up or down one level in the z-order. In our 
example, Photo 2 was directly in front of Photo 1, so the Send to 
Back tool gave us the result we wanted with just one click.

Hint:  Sometimes you may have to use an Object Order tool 
more than once to get the position you want in the z-order.

Figure 2-75. Slide preview with 

photos properly arranged 

Figure 2-76.  
The new z-order of the slide objects

Figure 2-74. 
The Order Objects section of the 
Arrange menu in the Drawing 
section of the Home tool bar
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Moving an Object to the Back or Front
If you know that you want an object moved all the 
way behind other objects on a slide, you can use 
the Send to Back tool. Conversely, you would use 
the Bring to Front tool to move an object all the 
way to the front of the other items.

Hint:  The background image on each slide is static, and is not 
counted in the z-order. If you use the Send to Back tool on an 
object, it will still be in front of the background image. 

Selecting Multiple Objects
Instead of moving or resizing several items individually, you can 
manipulate items simultaneously by selecting more than one at a 
time. Then, whichever manipulation or formatting you apply to one 
object will be applied to all selected objects.

Follow these steps to select multiple objects:

1.	 Click on the first object.  Click on the first object you would 
like to select. In this example, click on one of the photos in the 
Photo Collage slide.

2.	Hold down the Shift key.  Press and hold the | key on your 
keyboard.

3.	Click on the other objects.  With the | key held down, click 
once on each of the other objects you want to select. In our 
example, click on the other two photos.

4.	Release the Shift key.

Now that all three of the photos on the slide are selected, you could:

•	 reposition (move) all of the photos by dragging any one of the 
selected photos into the position you want (page 43)

•	 resize all of the photos by using the corner control handle of 
any one of the selected photos (page 46)

Figure 2-77. 
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CREATING YOUR OWN OBJECTS
In addition to the layout objects that are already on a slide when 
you open it, you can add your own objects for light customization.

On the Insert tab, PowerPoint offers several objects that can be 
inserted into slides. However, when creating slides for the eScreens, 
you should only insert photos and text boxes (Figure 2-79).

In rare cases, you may want to insert a table, chart or graph. However, 
use caution when doing this. It should be simple, clear, and readable 
from long distances when displayed on the eScreens.

Caution:  Never insert ClipArt, Screenshots, Shapes, SmartArt, 
Hyperlinks, WordArt, Video, Audio, Headers or Footers.

Example Exercise:
In this example, we will add a small text box to act as 
the slide caption, and format the text inside of it.

Figure 2-78.

Being objective 
about objects:

Creating your own 
objects on a slide is not 
recommended unless 
there are no suitable slide 
templates for your needs.

You should always use 
discretion when creating 
your own slide objects, 
and make sure they fit 
visually with the rest 
of the slide objects.

Figure 2-79.

•	 rotate all of the photos by using the rotate control handle of 
any one of the selected photos (page 45)

•	 format all of the selected photos by choosing a Picture Style 
preset from the Format tool bar (page 38)

Drag all of the photos upward a little as shown in 
(Figure 2-78). This will make room for the caption text box 

that we will create in the next exercise.
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Inserting a New Text Box
Follow these steps to insert a new text box:

1.	 Open the Insert tool bar.  At the top of the 
PowerPoint window, click on the Insert tab 
to display the Insert tool bar.

2.	Click the Text Box button.  In the Text 
section of the Insert tool bar, click the 
Text Box button. Your cursor will change to 
a text box cursor.

3.	Draw the text box.  Using the text box 
cursor, drag diagonally to create a square in 
the bottom-left area of the slide. It is okay if 
the square covers a bit of one of the photos 
(Figure 2-80).

A new text box has now been inserted with a blinking text cursor as 
shown in (Figure 2-81). It is ready to accept your text.

PowerPoint has given the new text box the width of the box that you 
drew. However, it has disregarded the height. In fact, if you tried to 
extend the text box using the square control handle at the bottom, it 
would not work. The height of a new text box is determined solely by 
the text that is typed into it. The text box will resize to accommodate 
the text as you type it in. 

Follow this step to fill the text box:

4.	 Type or paste the text.  For this example, type in the following:

The text is difficult to see because it is black. New text boxes 
are not pre-formatted like the other layout objects in the 

slide templates. However, we will manually format the text and the 
text box ourselves in the next exercise.

Employees Volunteer to Help the Food Bank

1

2

3

Figure 2-80.

Figure 2-81.
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FORMATTING TEXT AND TEXT BOXES
In the section “Formatting Text on a Slide” on page 32, we looked 
at the following basic ways to format text:

•	 centering text

•	 making text bold

•	 making text italic

Of course, you can use the other tools in the Font and Paragraph 
sections of the Home tool bar to format your text further.

In our Photo Collage example, we will make the caption text 
larger and change its color so that it is more readable.

Changing the Text Size
Follow these steps to change the text size:

1.	 Select the text.  Using your mouse, triple-click on the text 
to select all of it. For more information on selecting text, see 
pages 33 and 34.

2.	Use the Increase Size button.  With 
the text selected, click on the 
Increase Size button in the Font 
section of the Home tool bar 
(Figure 2-82) until the text size is 
about 24 points.

Inserting a New Photo
Clicking the Picture button on the Insert tool bar, shown in 
(Figure 2-79) on page 52, opens the Insert Picture dialog box 
where you will choose a photo to insert. For more on how to use 
the Insert Picture dialog box, see (Figure 2-52) on page 38.

Hint:  You can also drag-and-drop new photos into a PowerPoint 
slide from your desktop.

Figure 2-82.
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Changing the Text Color
It is good practice to only use dark text colors on light backgrounds, 
and white or light text colors on dark backgrounds.

Follow these steps to change the text color:

1.	 Select the text.  Using your 
mouse, triple-click on the text to 
select it. For more on selecting 
text, see pages 33 and 34.

2.	Open the Text Color 
menu.  With the text selected, 
click on the small arrow beside 
the Text Color button in the Font 
section of the Home tool bar.

3.	Choose a text color.  From the 
Text Color menu, click on the 
color you would like the text to 
be. In our example, choose white.

Center the text using they 
keyboard shortcut Z + e. 

For more information, see "Centering Text in a Text Box" on page 33. 
Our progress is shown in (Figure 2-84).

Hint:  Reposition the text box if necessary to ensure that the 
white text is fully on the dark background.

Adding a Drop Shadow to the Text
We will make the white text stand out even more with a drop shadow.

Follow this step to add a drop shadow:

1.	 Use the Shadow button.  With the text still selected, click the 
Shadow button in the Font section of the Home tool bar 
(Figure 2-85). The text now has a drop shadow (Figure 2-86).

Figure 2-83.

2

3

Figure 2-84.

Figure 2-86.

Figure 2-85.
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Example Exercise:
In this example, we will manipulate our caption text box 
even further. We will follow the steps to fill the text box 
with a translucent background color, apply an outline 

around the box, and even change its shape.

Adding a Background Color to a Text Box
Text boxes are simply rectangular shapes that contain text. As such, 
a text box can be filled with a color and/or have an outline like other 
shapes in PowerPoint.

Follow these steps to add background color to a text box:

1.	 Select the text box (not the text).  Using your mouse, click 
once on the outer edge of the text box, away from the text.

Hint:  Your cursor will change to a four-headed arrow, indicating 
your mouse is in the proper position to select the text box only.

2.	Open the Format tool 
bar.  An orange Drawing 
Tools tab will appear at the 
top of the program window. 
Click the Format tab to open 
the Format tool bar.

3.	Open the Shape Fill 
menu.  Click on the Shape 
Fill button in the Shape Styles 
area of the Format tool bar.

4.	Choose a fill color.  From the 
Fill Color menu, click on the 
color you would like the text to 
be. For our example, choose 
black. The text box is now 
filled black (Figure 2-87).

3

4

2

1

Figure 2-87.

Figure 2-88.
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Making a Background Color Translucent
Follow these steps to make a background color translucent:

1.	 Open the Colors dialog box.  Click on 
More Fill Colors... in the Shape Fill menu 
(Figure 2-89).

2.	Change the Transparency setting  In the 
Colors dialog box, move the Transparency 
slider to 50% (Figure 2-90).

3.	Click the OK button  to close the box.

Now the black background inside the 
text box is translucent (Figure 2-91). 

Next, we will add an outline around the box.

Adding an Outline to a Text Box
There are two ways to add an outline to a text box:

•	 choose an outline color •	 choose an outline weight

If you choose an outline color, the line defaults to a weight of 1pt. 
If you choose an outline weight, the line defaults to a color black.

Follow these steps to add an outline to a text box:

1.	 Select the text box (not the text).  Using your 
mouse, click once on the outer edge of the text 
box, away from the text.

2.	Open the Format tool bar.  Click the Format tab 
to open the Format tool bar.

3.	Open the Shape Outline menu.  Click on the 
Shape Outline button on the Format tool bar.

4.	Choose an outline color.  From the Outline 
Color menu, click on the color you would like 
the outline to be. For our example, choose white. 
Now the text box has a white outline around it.

Figure 2-89. Figure 2-90.

Figure 2-91.

Figure 2-92.
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Changing Line Weights
The default line weight for the outline applied to our text 
box is 1pt. We would like a thicker line for our example.

Follow these steps to change 
a line weight:

1.	 Open the Line Weight 
menu.  Click on Weight in 
the Shape outline menu.

2.	Choose a line weight  In 
the Line Weight menu, 
click on a line weight. In our 
example, we will choose 
6pt (Figure 2-93).

The outline around our text box is 
now much thicker (Figure 2-95).

Changing the Shape of a Text Box
Follow these steps to change the shape of a text box:

1.	 Open the Edit Shape menu.  Click on Edit Shape button in 
the Insert Shapes section of the Format tool bar.

2.	Choose Change Shape.

3.	 Choose a shape.  From the Shape Menu that appears, 
select a shape. For our example, we will choose the rounded 
rectangle (the second option) (Figure 2-94).

The text box has now changed to a rounded rectangle (Figure 2-96).

Figure 2-93.

Figure 2-94.

Figure 2-96.

Figure 2-95.
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Previewing Our Progress
Preview the slide in the Slide Show mode (Figure 2-97). You can 
see that the translucent text box with rounded corners looks great. 
(For more information on previewing a slide, see page 25).

Text and Text Box Formatting Presets
Just like we can format a photo using Picture Styles (see page 38), 
PowerPoint has several formatting presets for text and text boxes:

•	 we can format selected text using presets called Quick Styles

•	 we can format text boxes using presets called Shape Styles

Example Exercise:
In this example, we will assume that instead of the 
formatting we applied to the caption text box in the 
previous exercises, we want to apply a preset style.

To follow along, use the steps on page 53 to create a new text 
box, or undo all of the formatting changes so that the text box reverts 
back to the one shown in (Figure 2-98).

Follow these steps to add a 
Shape Style to a text box:

1.	 Select the text box (not 
the text).  Using your 
mouse, click once on the 
outer edge of the text box, 
away from the text.

2.	Open the Format tool 
bar.  An orange Drawing 
Tools tab will appear at 
the top of the program 
window. Click the Format 
tab to open the Format 
tool bar.

3 2

1
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Figure 2-97.

Figure 2-98.

Figure 2-99.
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3.	Open the Shape Style menu.  Click the small arrow at the 
bottom-right of the Shape Style list.

4.	Select a Shape Style.  in the Shape Styles list that appears, 
click the option shown in (Figure 2-99).

This formats the text box with a green fill, beveled edges, 
rounded corners, and a drop shadow — with minimal effort. 

Use what you learned in previous exercises to resize or reposition the 
text box to get the visual result you want, if necessary (Figure 2-100).

Export the slide with the name volunteer_collage.png using the 
steps listed in the section "Exporting a Slide" on page 27.

More on Shape Style Presets
PowerPoint has a total of 42 Shape Style presets. Each one applies 
varying treatments to the selected text box including:

•	 fill color

•	 outline color

•	 corner options

•	 reflections

•	 beveled edges

•	 drop shadows

To see all available presets, 
click the small downward-
facing arrow in the bottom-
right corner of the list in the 
Shape Styles section of the 
tool bar (Figure 2-101).

Not all presets are appropriate for eScreen slides. Use discretion when 
formatting text boxes, and always choose a preset that compliments 
the other elements on the slide. Here are some helpful guidelines:

•	 choose only style presets with square or rectangular shapes

•	 choose style presets that do not distort the text or text box

Figure 2-100.

Shape Style 
previews:

When you hover your 
mouse pointer over a 
Shape Style preset in 
the menu, you can see 
a temporary preview of 
the style applied to the 
selected text box. The 
text box will revert to its 
previous style when you 
move your mouse cursor 
away from the Shape Style.

Figure 2-101.
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So far we have created slides from the large templates. For 
shorter messages or quick announcements, using a small 
template is the quickest and easiest method.

Example Exercise:
In this example, we will go through the steps to create 
a short message to announce that a pair of earrings 
have been found. We will copy text directly from an 

e-mail we have received, and paste the text into a small slide layout.

If you receive an e-mail like the one shown in (Figure 2-102), you 
will know from the chart in (Figure 2-10.1 on page 16) that 
because the slide will only contain short text, we should post it in 
the upper right area. This means we will choose a small template.

For this example, we will start with a small general-
purpose template, and select a slide layout that 
will accommodate our message.

Follow these steps to open the example slide:

1.	 Open the file.  In your templates folder, 
double-click the file sm_gen_use_1.pptx to 
open it in PowerPoint

2.	 Show the New Slide menu.  Click the arrow 
below the New Slide button to bring up the 
New Slide menu.

3.	Choose the slide.  Click the slide named 1-Line Title in the 
Dark Green group (Figure 2-103).

When the new slide appears, examine its layout objects to ensure it 
will fit our needs: In (Figure 2-104) we see that there are only two 
layout objects on the slide. Both are user-editable:

•	 the title text box (1)

•	 the body text box (2)

The e-mail we received already contains a perfectly-composed 
message that we will simply copy and paste into the slide layout.

Figure 2-103.

1.	 Text box

2.	 Text box

1

2

Figure 2-104. Example of layout 
objects on a slide template

Figure 2-102. Example e-mail you may receive

Attention All Employees:

A pair of earrings were found in the Fitness Center yesterday. Please call extension 
4925 if they are yours.

Thank you,
Olivia 'Liv' D. Waits
Lifestyle Management Program Coordinator
(863) 555-4925
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Copying Text from Another Source
Sometimes an e-mail or document you receive will contain a short 
snippet of text that will work perfectly for your message, and fit well 
on a slide. In these instances, you will want to copy the text exactly.

Follow these steps to copy text from an e-mail or document:

1.	 Select the text.  Using your mouse, drag over the text in the 
e-mail or document to select it. (For more on selecting text, 
see pages 33 and 34). For our example, we will select 
just the following from the e-mail body:

2.	Copy the text.  Right-click on the text and choose Copy from 
the menu. Or, use the keyboard shortcut Z + c .

A copy of the text is now being held temporarily on the clipboard.

Type EARRINGS FOUND into the title text box of the 
slide. (See "Adding Information to a Slide" on page 23).

Pasting Text into a Slide
Follow any one of these steps to 
paste text into a text box:

1.	 Use the paste button.  Click 
on the Paste button in the 
Clipboard section of the 
Home tool bar  as shown in 
(Figure 2-105).

2.	Use the right-click menu.  Right-click inside the text box and 
choose Paste from the menu. 

3.	Use the keyboard shortcut Ctrl + V.  With your text cursor 
inserted in the text box, press Z + v on the keyboard.

A pair of earrings were found in the Uncle Sam 
Fitness Center yesterday. Please call extension 

4925 if they are yours.

Figure 2-105.

Figure 2-106. Our progress after 
pasting the text

To copy or not to 
copy?

You should always tailor 
your message to the needs 
at your facility. Composing 
your own message is a 
great way to keep the 
local feel, but copying 
text from an e-mail or 
memo is okay when you 
are pressed for time.
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Keeping Text Box Formatting After Pasting
Text boxes are pre-formatted for text color, font, size, shadows, etc. 
If the text you are pasting had no previous formatting, then it would 
assume the formatting attributes preset for the text box.

However, if you are pasting text from Outlook or Word, it will retain 
its previous formatting, thereby voiding those of the text box.

Hint:  Even if the text looks like plain black text, it is still 
considered to have formatting.

To force the text you just pasted 
to assume the formatting of the 
text box you are pasting into:

•	 Immediately after pasting 
the text, press and release 
the Z key on your 
keyboard to open the Paste Options menu.

•	 Type t on your keyboard, or click the Keep Text Only button 
as shown in (Figure 2-107).

Using what you learned in previous exercises, put a line break 
between the two sentences in the body text (page 33), 

and turn off the bold attribute for the second sentence (page 35). 

Give all of the body text a point size of 28 (page 54). The results 
should be similar to the slide preview shown in (figure 2-108).

Export the slide with the name announcement_earrings.png using 
the steps listed in the section "Exporting a Slide" on page 27.

Figure 2-107.

Figure 2-108.





CHAPTER 
THREE

The Design Studio™ Program

Design Studio — the software that you will use to interact 
with the eScreens at your facility — was developed by Symon, 
the company that provided Digix with its eScreens. It has 
powerful features for storing, managing and displaying the 
content that you create.
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What is Design Studio?
Design Studio is the program you will use to add, 
store and schedule content for your eScreens. It 
sends content and play times to the server, where 

they are stored and later recalled for playback on your eScreens.

DESIGN STUDIO TOOLS AND FEATURES
Design Studio offers several tools and features to create, manage, 
and display content, including:

•	 Storage Folders

•	 Play Categories/Schedules

•	 Messages

•	 Text Tickers

•	 Playlists/Advanced Schedules

•	 Player Previews (page 127)

Storage Folders
The storage folders in Design Studio work just like the folders that you 
are familiar with in Windows® (Figure 3-1). (For more information 
on navigating storage folders, see page 81).

There is a different set of storage folders 
for each content resource (graphics, 
videos, etc.). Your facility will have its 
own storage folder within each set, 
where you will store your content. (For 
more information on how to open your 
facility folders, see page 80).

Play Categories/Schedules
A Play Category (hereinafter category) 
is a container that groups play-items 

and slides based on the layout area in which they will display on 
the eScreens. Therefor, a category can be thought of as a direct 
portal to an eScreen layout area (page 5), and the sole means 
of scheduling content. For example, slides that display in the top 

Windows® Explorer Folder List: Design Studio Folder List:

Figure 3-1. Comparison of how storage folders work in Design Studio

3.1	 Introduction to Design Studio
Symon Design Studio™ (hereinafter Design Studio) is a powerful 
program used to store and schedule content. In this section we 
will look at its capability to manage and display content.
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right area of the eScreen layout are scheduled in a category named 
Top Right. (For more on categories and scheduling, see "Scheduling 
Content to Play" on page 90.)

Messages
A message can be thought of as a slide that is created inside of 
Design Studio, much like the ones we created using PowerPoint in 
Chapter 2 (page 9). It is not recommended to create general, 
every-day messages inside of Design Studio because they lack the 
efficiency, flexibility, functionality and branding that the eScreen 
templates offer. However, there will be a few good uses for messages 
as we will see in the upcoming sections, "Messages with Scrolling 
Text" on page 119 and "Messages with Audio" on page 124.

Text Tickers
A Text Ticker (hereinafter ticker) is simply a message that uses 
horizontally-scrolling text to achieve a "ticker tape" effect. Several 
tickers display in succession at the bottom of the eScreen layout in 
the Ticker Area. (For more information on eScreen Layout Areas, 
see page 5). The following tickers display on all Digix eScreens:

•	 National news ticker

•	 Stock ticker

•	 Digix news ticker

•	 Facility announcements

For more information on local facility tickers, see page 115.

Playlists/Advanced Schedules
Design Studio offers powerful tools for scheduling and displaying 
content, including the ability to customize the following:

•	 Which items play

•	 When items play

•	 The order that items play

•	 The duration items play

For more on advanced scheduling options, see page 94.
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Starting the Design Studio Program
There are a few different ways to start, or launch, Design Studio. 

From the Desktop:  When the program was installed on your 
computer, a shortcut icon was added to your desktop.

Follow one of these steps to launch Design Studio from the desktop:

1.	 Double-click the icon.  With your mouse, 
click twice quickly on the Design Studio 
program icon (Figure 3-2).

2.	 Select the icon and press Enter.  Click 
once on the Design Studio program icon 
to select it, and then press " on your 
computer keyboard.

From the Start Menu:  The Windows® Start menu contains all of the 
programs installed on your computer. The search box on the Start 
menu helps you launch programs quickly.

Follow these steps to launch Design Studio from the 
Start menu search box:

1.	 Open the Start menu.  Click once on the Start button, 
or press the  key on your keyboard.

2.	Type the program name.  Simply begin typing 
Design Studio and the Design Studio program will 
show up in the list (Figure 3-3).

3.	Launch the program.  With your mouse, click once 
on the Design Studio program in the list, or press the 
" key on your computer keyboard.

Hint:  If the Design Studio program is not the first 
item in the list, use your arrow keys to highlight it 
before pressing the " key.

3.2	The Design Studio User Interface
Let's start the Design Studio program and learn different the parts 
of its user interface, and how to customize them.

Figure 3-2. 

Figure 3-3. 
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LOGGING IN TO THE SERVER
The Design Studio program will only operate while 
connected to the eScreen Server (hereinafter server) in 
Wood Dale, IL. The very first time you launch Design Studio, 
you will be prompted to login to the Server.

User Name
Each facility has a unique user name to login to the server. 
The eScreen administrator will use this user name to 
manage the content for that site only. You should have 
been given this information when Design Studio was 
installed on your computer.

Password
Each facility has a unique password to accompany its user 
name. You should have been given this information when 
Design Studio was installed on your computer.

Server Name
The server name box tells Design Studio where to look for 
the server. You should have been given this information 
when Design Studio was installed on your computer.

Follow these steps to login to the server:

1.	 Enter your user name.  Click once on the Username 
box and enter your user name as it was given to you.

2.	 Enter your password.  Click once on the Password 
box and enter your password as it was given to you.

3.	 Enter the server name.  Click once on the Server 
Name box and enter the server name as it was given 
to you, if this box is not already filled-in.

4.	 Click Login .  Click once on the Login button 
(Figure 3-5), or press " on your keyboard.

Figure 3-4. The Design Studio login window the 
first time the program is launched

Figure 3-5. Logging in (Note: this figure may not 
reflect actual login information)
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'Remember Password' and 'Auto Login'
If you click the Remember Password check box, you will not have 
to type your password the next time you launch Design Studio.

If you click the Auto Login check box, Design Studio will automatically 
select the Remember Password check box as well. The next time 
you launch Design Studio, you will not be presented with the login 
window; you will be logged in immediately without further action.

Hint:  Press and hold the Z key while launching Design 
Studio in the future to see the login window again. 

THE PROGRAM WINDOW
When Design Studio loads for the first time, the program window 
resembles the one shown in (Figure 3-7).

Various elements of the user interface (hereinafter UI) can be found 
at the top, right, and bottom of the program window. Some of the 

Figure 3-6. The program window 
during the login process

Figure 3-7. The program window upon first launch

'Auto Login' tip:

Because it is Mosaic's 
policy that you are the only 
person allowed to use your 
Digix account on your 
computer, using Auto 
Login is permissible, 
because no one else will 
have access to your Design 
Studio.
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UI elements you will encounter include:

•	 The title bar

•	 The menu bar

•	 Tool bars

•	 Floating windows 

•	 Docked windows (panes)

•	 Tabs

The Title Bar
At the very top of the program window is the title bar. The title bar 
displays the Design Studio name, the user name you are logged in 
with, and the server name (Figure 3-8).

There are three buttons on the far right of the title bar: the Minimize, 
button, the Maximize/Restore button, and Close button.

The Menu Bar, Tool Bars and Windows
Each element of the UI, such as the menu bar, tool bars, and 
windows can be moved around independently.

The menu bar and tool bars will become a "window" and will 
"float" when not docked to the top edge of the program window. 
You can arrange them any way you like.

About Docking and Docking Pane Layouts
Design Studio's UI elements can be docked to any edge of the 
program window, where they will stay, even when the program 
window is resized or maximized. UI elements are known as a panes 
when they are docked.

The way docked panes are arranged in the Design Studio program 
window is known as a docking pane layout. These can be saved 
once you have the program window just the way you want it. See 
page 77 for more information on saving a docking pane layout.

Figure 3-8. The title bar

Figure 3-9. The menu bar

Figure 3-10. The tool bars
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Exercise:
In this exercise we will customize the 
Design Studio UI. We will load a pre-
defined docking pane layout, and learn 

how to reposition tool bars by dragging them.

Follow these steps to load a docking pane layout:

1.	Open the View menu.  Click once on the View menu 
in the menu bar, or press X + v on the keyboard.

2.	Open the Docking Panes menu.  Click once on the 
Docking Panes menu located in the View menu.

3.	Choose Reset Docking Panes to Advanced Layout. 

The above steps are outlined in (Figure 3-11).

The size, position, and layout of the UI 
elements within the Design Studio program 

window will all reposition themselves to the Advanced 
Docking Pane Layout, as shown in (Figure 3-12). You 
will see that a few more UI elements have appeared.

Hint:  When saving or recalling a docking pane 
layout, the menu bar and tool bars are unaffected. 
We will move those manually in the next exercise.

Case-in-point:
It is highly recommended that you use the Advanced 
Docking Pane Layout so that the example steps and 
screenshots found in this manual will match what 
you see. It is also beneficial for future training and 
troubleshooting if everyone's Design Studio program 
window looks and functions the same way.

1

2 3

Figure 3-11.

Figure 3-12. The Advanced 
Docking Pane Layout
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Moving the Tool Bars
All of the tool bars — and the menu bar — have small vertical lines, 
or "handles" on their left sides, as shown in (Figure 3-13). These 
handles are used to reposition the tool bars by dragging them around.

As you can see, there are still four tool bars across the top 
of the program window, each stacked on top of another. We 

will arrange these tool bars horizontally on fewer rows so that they 
take up less space inside the Design Studio program window.

Follow this step to move the tool bars:

1.	 Drag the second tool bar up.  Using your mouse, click and 
hold on the tool bar handle, and move the second tool bar up 
until it is on the first row, beside the first tool bar.

1.	 Drag the last tool bar up.  Using your mouse, click and hold 
on the tool bar handle, and move the last tool bar up until it is 
on the second row, beside the second tool bar. (Figure 3-15).

Hint:  While dragging, the tool bars will live-update, allowing 
you to see where you are positioning them. The extra tool bar 
rows will disappear automatically while you drag as well.

Figure 3-13. Tool bar handles

1
2

Figure 3-14. Dragging to reposition tool bars (steps 1 and 2 highlighted)

Figure 3-15. The tool bars now take up less space in two rows.

Did you notice 
the helpful arrow 
heads?

When you hover your 
mouse over a tool bar 
handle, the cursor will 
change to a four-way 
arrow. This will indicate 
that you are in the proper 
position to begin dragging 
to reposition the tool bar.
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Properties 
Window

See and edit all 
available attributes 

for an open item 
(See page 110)

Tool Description Bar
Displays helpful descriptions when you 
hover your mouse over tool bar button

Caps, Number, 
and Scroll Lock 

Indicators

Content 
Resource Tabs

See page 78

Docked and 
Tabbed Window

See page 75

Edit/Work Area
Opened items such as messages 
and categories will be displayed 

here for editing

Standard Tool Bar
new, save, undo/redo, cut/copy/paste, etc.

Menu Bar

Text Format 
Tool Bar

bold, italic, font 
color, indents, 

spell checker, etc.

Areas and 
Elements Tool Bar
insert object, align, 
center, etc.

Position Tool Bar
size, position, z-order, etc.

Title Bar
See page 71

Figure 3-16. Parts of the Design Studio program window UI

MANIPULATING TABS AND WINDOWS
Now that we have loaded the Advanced Docking Pane Layout and 
moved the tool bars, we can look at manipulating other UI elements.

Parts of the User Interface
Lets take a look at the Design Studio program window after following 
the steps in the previous exercises. (Figure 3-16).
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About Tabs
When two or more windows 
are docked on the same 
edge of the program window, 
Design Studio arranges them 
in a tabbed configuration. The 
content resource tabs shown 
in (Figure 3-17) are actually several windows 
docked at the bottom edge of Design Studio.

These windows can be accessed by clicking a tab, 
or by choosing the item from the View menu.

Using the View Menu
Another way to access tabbed windows is through 
the View menu (Figure 3-18). The View menu 
contains a list of available windows — whether 
they are floating, tabbed, docked or not currently 
visible. In the View menu, when you click on the 
name of a window that is currently visible, the 
window will close. If you click on the name of a 
window that is not currently visible, it will open.

Unpinning Windows (Auto Hide)
All tabbed windows have Pin and Close buttons 
in their top-right corner. Clicking the Pin button will 
either pin or unpin the window. When unpinned, 
the window will auto-hide when not in use.

Clicking the Close button will close the window.

Hint:  A closed window can be re-opened 
by clicking its name in the View menu.

Figure 3-17. Tabbed Windows

Figure 3-19. Pin 
and Close buttons

Figure 3-18. The 
View menu

On docking and 
pinning windows

Think of a tabbed window 
as an upside-down 
rolling window shade 
on a window in your 
house. Now imagine that 
the shade is attached 
or "docked" at the 
bottom of that window.

When you want to see 
the shade, you pull it up 
and attach, or "pin" it so 
that it remains open.

If a docked pane in 
Design Studio is "unpinned" 
at the top, it will "roll" 
itself closed when you 
move your mouse cursor 
away from it. This is also 
known as Auto Hide.
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Closing Unnecessary Items
Some UI elements represent items that Design Studio users 
cannot access, or simply will have no need for. We will close 

the unnecessary tabs now to simplify our UI.

Follow these steps to close the unnecessary items:

1.	 Show the tab you would like to close.  Click once on the 
Channels tab at the bottom of the program window to open it.

2.	Click the Close button.  Click once on the Close button in the 
upper-right of the Channels window.

Use either the steps above, or the View menu, to close the 
following unnecessary tabbed windows: Layouts, Toolbox, 

Border Styles, Plugins and Fonts.

Resizing a Tabbed Window
You may find it useful to see more of a tabbed window's contents. 
Tabbed windows can be resized vertically simply by dragging its top 
border up or down.

Hint:  Your mouse 
cursor will change 
to a double-headed 
arrow, indicating you 
are in the proper 
position to begin 
resizing the window.

1

2

Figure 3-20. Closing an unnecessary tabbed window

Figure 3-21. Resizing a tabbed window

More advanced 
docking help

For more information on 
docking windows inside 
Design Studio, as well 
as how to use Docking 
Helpers, use the help 
feature in the program.

•	 Choose Help Topics 
from the Help menu, 
or press the ! key.

•	 Search for docking on 
the search tab.
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Reordering Tabs
The tabbed windows can be rearranged to any order you like simply 
by dragging the tabs horizontally to another position with your mouse.

Saving the Current 
Docking Pane Layout

Now that we have closed 
all unnecessary UI elements 

and have gotten our program 
window just the way we want it 
(Figure 3-22), we will save our 
current docking pane layout.

Follow these steps to save the 
current docking pane layout:

1.	 Open the View menu.  Click 
once on the View menu in the 
menu bar, or press X + v 
on your keyboard.

2.	Open the Docking Panes menu.  Click once on the Docking 
Panes menu inside of the View menu.

3.	Choose Save Current Docking Pane Layout.  Your current 
arrangement of windows and tabs are now saved.

Hint:  If you have accidentally closed a tab or moved something 
out of place, and would like to return to the layout we've just 
saved, simply follow the steps above, but choose Load Last 
Saved Docking Pane Layout instead.

Figure 3-22. Ideal Design Studio program window layout
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Now that we have a basic understand of the UI, let's take a look 
at the ways in which content is stored and organized.

CONTENT RESOURCES AND FOLDERS
The items available for you to display on the eScreens are known as 
content. There are several types of content, including:

•	 Graphics

•	 Videos

•	 Sounds

•	 Messages

Each type of content is stored separately in its own area within 
Design Studio. Collectively, these are known as the content resources. 
In (Figure 3-23), you will see that each content resource has its own 
tabbed window containing a set of storage folders. Each facility has 
a designated folder located in each content resource tab.

Graphic Resources
The Graphics resource area holds graphic files such as photos 

and slides, until you are ready to schedule them. You will primarily 
use this area to store and organize your imported slides.

Graphic file types that can be imported include: *.jpg, *.jpeg, *.bmp, 
*.gif, *.png, or *.xaml (For more information on importing content, see 
"Importing and Organizing Content" on page 83).

Video Resources
The videos resource area holds video files like those from 

local events and corporate videos, until you are ready to schedule 
them. You will primarily use this area to store and organize your videos.

Video file types that can be imported include: *.mpg, *.mpeg, *.swf, 
*.mpg1, *.mp2, *.mp4, *.mov, *.asf , *.avi, *.vob, *.wmv or *.flv.

Figure 3-23. Content resource tabs
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Sound Resources
The Sounds resource area holds sound files such as MP3s 

and radio broadcasts, until you are ready to schedule them.

Sound file types that can be imported include: *.wav, *.mp3, *.rmi, 
and *.wma (For more information on importing files, see page 84).

Message Resources
The messages resource area holds messages such as tickers, 

birthday lists, and audio files, until you are ready to schedule them. 
You will primarily use this area to store and organize your messages. 
For more on creating messages with scrolling text, see page 119. 
For more on creating audio messages, see page 124.

The 'Categories' Tab
The Categories resource 

tab contains the four categories 
you will use to post your content 
to the eScreens (Figure 3-24):

•	 Main Area

•	 Top Right Area

•	 Ticker Area

•	 Background Audio Area

For more information on adding 
play-items to a category, see 
"Basic Scheduling" on Page 92.

The 'Players' Tab
In the Players tab, the SDAs, or Symon Digital Appliances, are 

represented as players. Design Studio allows you to see a real-time 
snapshot of what is being displayed on your facility's eScreens at any 
given time by opening the Players tab. (See page 127).

The videos resource area holds video files like those from 
local events and corporate videos, until you are ready to schedule 
them. You will primarily use this area to store and organize your videos.

Video file types that can be imported include: *.mpg, *.mpeg, *.swf, 
*.mpg1, *.mp2, *.mp4, *.mov, *.asf , *.avi, *.vob, *.wmv or *.flv.

Figure 3-24. There are four play categories for each facility.
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Opening Your Facility Folder
Each of the content resource tabs contains a set of folders, in which 
is a specific folder for your facility. Your facility's folder is where you 
will store all of your local content for later retrieval.

Exercise:
In this exercise, we will open our facility-specific folder 
in all of the resource tabs, create a new folder, and 
change the viewing mode to show thumbnail previews.

Follow these instructions to 
open your facility folder:

1.	 Open a resource window.  
With your mouse, click once 
on the Graphics tab to 
show the graphics resource 
window.

2.	 Expand the Graphics 
folder list.  Click once on 
the small plus symbol next 
to Graphics to show its 
folder structure.

3.	 Expand the _Sites folder 
list.  Click once on the small 
plus symbol next to _Sites to show its folder structure.

4.	 Select your facility folder.  Click once on the folder with the 
name of your facility to open it.

Follow the above steps to open your facility folder in 
the remaining tabs as well: Videos, Sounds, Messages, 

Categories and Players.

Hint:  The facility folders are not always grouped into a folder 
named _Sites. In those cases you will skip step 3.

1

2
3

4

Figure 3-25.

Why am I opening 
all of my facility 
folders at once?

Design Studio remembers 
which folders were open 
when you exit the program. 

This means that your 
facility folders will 
all remain open next 
time you return to 
Design Studio, ensuring 
you are always working 
in the correct folder.
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Navigating Content Folders
Navigating the folder list in each content resource tab is 
similar to navigating the folder structure in Windows™. 
Let's take a look at the folder structure of the Graphics 
tab in (Figure 3-26):

•	 (1) The top-level graphics resource folder

•	 (2) A graphics folder

•	 (3) Graphics sub folders within a graphics folder

•	 (4) "Plus" symbol indicates a folder contains sub 
folders, and expands the folder structure

•	 (5) The file list

•	 (6) Folder task buttons

Opening Folders: Clicking on a folder in the list shows the items 
it contains — including sub folders — in the file list (5). You can also 
open folders from the file list by double clicking them.

Folder Task Buttons:  The folder task buttons (6) help you navigate 
the folder structure, and contain a few commonly-used tasks:

•	 (A) Back

•	 (B) Forward

•	 (C) Up one level

•	 (D) Refresh

•	 (E) Search

•	 (F) New/add item

•	 (G) Folder List

•	 (H) Change View

Hint:  The folder structures, areas and buttons shown in 
(Figure 3-26) act the same in all content resource tabs.

Resizing the Folder List
You may find it useful to see more (or less) of the folder structure. 
Just like tabbed windows can be resized vertically (page 76), the 
folder list can be resized horizontally simply by dragging its right-side 
border to the left or right (Figure 3-27).

Figure 3-26. Parts of a tabbed 
content resource window

A B C D E F G H

1

2

3

4 6

5

Figure 3-27. Dragging to resize	
the folder list
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Changing Folder Views
Just like in Windows™, you may choose to change a folder's viewing 
mode to show the contents of each folder differently (Figure 3-29):

•	 Large icons

•	 List

•	 Details

•	 Thumbnails

To make organizing and scheduling our content easier in 
the future, we will change the folder view options to display 

thumbnail previews in the content resource folders.

Follow these steps 
to change the folder 
viewing mode:

1.	 Open a resource 
window.   With 
the mouse, click 
once  on the 
Graphics  tab 
to  show the 
Graphics window.

2.	 Open the Change View menu.  Click the small downward-
facing arrow next to the Change View button to open the 
Change View menu.

3.	 Open the Thumbnails menu.  Click once on Thumbnails to 
show the Thumbnails menu.

4.	 Select a viewing mode.  For our example, choose Medium.

Hint:  You could also choose larger thumbnail previews. You 
should always choose whichever viewing mode is best for you.

Follow the above steps to change the viewing mode to 
medium thumbnails for the rest of the content resource 

tabs: Videos, Sounds, Messages, Categories and Players.

1

2

3
4

Figure 3-28.

Figure 3-29. Folder viewing modes

(A) Large icons

(B) List

(C) Details

(E) Medium thumbnails

(F) Large thumbnails

(D) Small thumbnails
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Creating New Folders
Creating new folders to organize your content by 
topic, date, or in some meaningful way, will help 
you find content quickly in the future.

Use the steps listed in "Opening Your 
Facility Folder" on page 80 to navigate 

to your facility folder in the graphics resource tab 
if it is not already open.

Follow these steps to create a new folder:

1.	 Right-click on a blank area in the graphic resource 
window.  To avoid accidentally right-clicking on an existing item, 
locate a blank white space and then right-click there.

2.	 Choose New Folder.  From the menu that appears, choose 
New Folder as shown in (Figure 3-30), or press the f key.

3.	 Give the folder a name.  Begin typing a name for your new folder. 
For our example, we will name it General Announcements as 
shown in (Figure 3-31).

Figure 3-30. Right-clicking in a 
blank area to create a new folder

Figure 3-31. Typing a name for 
the new folder

IMPORTING AND ORGANIZING CONTENT
Adding graphics, videos, and sounds (also known as importing 
content) into Design Studio can be accomplished several ways:

•	 Clicking the New button

•	 Dragging-and-dropping

•	 Right-clicking
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Importing Using the New Button
There is a New button in the folder task buttons area (page 81) 
of a every content resource tab. Clicking this button will allow you to 
navigate your computer to select a file to import.

Hint:  Clicking the New button in the Messages, Categories or 
Players tabs will create a new one of those items, instead of 
allowing you to import resources. We will learn more about 
creating new messages in a later section, but there will never 
be a need to create new categories or players.

When you click the New button, the Open dialog box appears:

Importing By Right-Clicking
If you right-click in any blank area inside a content resource window, a 
menu appears as shown in (Figure 3-33). Choosing Add Graphics... 
from this menu will show the Open dialog box (Figure 3-32).

Hint:  This menu item will be called Add Videos... and 
Add Sounds... in their respective content resource tabs.Figure 3-33. Importing from the 

right-click menu

Are your items 
not displaying 
properly?

If your content folders do 
not update to show the 
changes after importing, 
copying, moving, renaming 
or deleting items, simply 
click the Refresh button.

Folder List
Lets you navigate to other 

folders if your slide is in 
another location.

File Type
Shows the types of files 
that can be imported. For a 
list of importable file types, 
see page 78.

File List
Shows a list of files in the 
current folder that matches 
the type in the File Type 
box.

Current Location
Shows the name and 

location of the folder where 
you are looking for your file.

File Name
Displays the name of the 

selected file.
Open Button
Click this button when you 
are ready to import the 
selected content.

Figure 3-32. Parts of the Open dialog box
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Importing Using the Drag-and-Drop Method
Dragging-and-dropping is the quickest way to add files to Design Studio.

Before dragging-and-dropping to import a file, you must:

•	 Make sure the correct tab and folder are opened and 
visible in Design Studio.

•	 Make sure the file you will import, and the Design Studio 
program window are both visible on your screen.

Making the Source and Destination Both Visible
If the file you will import is on your desktop, reposition 
either the Design Studio program window or the file icon 
so that they are both visible (Figure 3-34).

If the file you will import is in a folder, reposition the 
Design Studio program window and the folder containing 
the file, so that they are both visible (Figure 3-35).

Hint:  Technically, only part of the file icon you would 
like to import, and the part of the window you will be 
dragging to, needs to be visible. 

Two windows at 
once? It's a snap!

In Windows™ 7, dragging a 
window to the left or right 
edges of the your desktop 
will cause it to resize to 
half of your screen, and 
snap to that edge.

To easily see both windows, 
drag them to opposite 
edges of your desktop.

Figure 3-36. Splitting windows by 
dragging to the edges of the desktop

Figure 3-35. Dragging from a 
window to import

Figure 3-34. Dragging from the 
desktop to import
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Example Exercise:
In this exercise we will import the four slides we 
created in Chapter 2: eScreen Templates on page 
9. We will learn how to move and rename these 

graphics resources once they have been imported.

Follow these steps to import content into Design Studio:

1.	 Open a content resource window.  Click on the content 
resource tab that you would like to import the new file into. In 
our example, open the Graphics tab.

2.	 Navigate to your facility folder if necessary.  If you are not 
working in your facility folder, follow the steps on page 80.

3.	 Drag the f i le(s) into 
Design Studio.  With your 
mouse, drag the file from its 
destination onto a blank 
area of the Graphics 
window, and release the 
mouse button. (For more 
abou t  d ragg ing - and -
dropping, see page 85.) Design Studio will show a progress 
indicator while the graphics import as shown in (Figure 3-37).

Hint:  You can import more 
than one file at a time by 
selecting multiple files to drag.

Using the above steps, import 
these four files into Design Studio:

announcement_earrings.png
eom_november.png
heat_advisory_0813.png
volunteer_collage.png

Following along but 
don't have the slides?

If you do not have the four 
slides we will be using in these 
examples, but would like to 
follow along, simply use any 
existing slides or photos you 
may have; the import process 
is the same for all content.

How to drag with 
only one window 
visible at a time:
1.	 Minimize the 

Design Studio program 
window.

2.	 Navigate to the desktop 
or the folder with the 
file you will import.

3.	 Begin dragging the file 
downward over the 
Windows™ Task Bar.

4.	 Without releasing the 
mouse button, hover 
over the Design Studio 
icon in the Task Bar.

5.	 The Design Studio 
program window will 
pop up, allowing you to 
continue dragging.

6.	 Release the mouse 
button over the area 
you want the imported 
file to be stored.

Figure 3-38. The four slides 
imported into the Graphics window

Figure 3-37. 
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In the next few steps, we will be moving graphics into the  
folder that we created in a previous exercise (page 83), 

named General Announcements. Make sure your facility folder is 
open and visible in the Graphics window. If necessary, use the steps 
listed in "Opening Your Facility Folder" on page 80 to navigate to it.

Selecting More Than One Item in 
a Content Resource Window
Before you can move your content, you must 
select it. There are several ways to select 
more than one item:

•	 Dragging to select items

•	 Shift-clicking to select items

•	 Control-clicking to select items

Dragging to Select
Using your mouse, drag a selection rectangle 
around the items you wish to select  as shown 
in (Figure 3-39). This will select only the 
items touched by your selection rectangle.

Shift-Clicking
Using your mouse, click once on an item. 
While holding down the ? key, click on 
another item. These items, and all items in 
between them, will be selected (Figure 3-40).

Control-Clicking
Using your mouse, click once on an item. While holding down the 

Z key, click on additional items. Each click will add or remove an 
item from the selection (Figure 3-41).

Hint:  These selection techniques work in all viewing modes.

Figure 3-39. Dragging to select multiple items 

Figure 3-40. Shift-clicking to select multiple items

1 2

Figure 3-41. Control-clicking to select multiple items

1 2
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Moving Content
All of your graphics, videos, and sounds can be moved between 
folders that you create, depending on how you would like to organize 
them. (For more information on creating new folders, see page 83). 

Follow these steps to move content into a folder:

1.	 Open a content resource window.  For our example, click on 
the Graphics tab if it is not already open.

2.	 Select the items you wish to move.  Using one of the 
techniques on page 87, select these four items:

announcement_earrings
eom_november

heat_advisory_0813
volunteer_collage

3.	Drag the items to the new folder.  Using your mouse, 
drag one of the selected files to the folder named General 
Announcements. All of the selected files will be moved.

﻿
Hint:  If you cannot see the destination folder, drag the items 
upward, and the window will scroll to show more of its contents.

On cutting and 
pasting:

You can also move files 
using the Cut and Paste 
commands available in 
both the Edit menu and 
the right-click menu.

Or, you can use these 
keyboard shortcuts:

•	 Z + x = Cut

•	 Z + v = Paste

Simply cut the items you'd 
like to move, navigate to 
the new location, and 
paste them there.

1

2b 2c

2d

3

Figure 3-42. 

2a
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Figure 3-43. 

Renaming Content
To organize and categorize your 
content further, you may want to 
add specific information to the way 
they are named.

Follow these steps to rename a content 
resource item:

1.	 Right-click on the item.

2.	 Choose Rename.  From the right-click 
menu that appears, choose Rename as 
shown in (Figure 3-43).

3.	 Type a new name for the item.  Type a 
new name, or add to the existing name 
as shown in (Figure 3-44).

Deleting Stored Content
To delete a content resource item, right-
click the item and choose Delete from 
the menu as shown in (Figure 3-45).

Or, with the item selected, simply press 
the S key on your keyboard.

Hint:  You can delete multiple items if they 
are selected (See page 87 for more on 
selecting multiple items).

You can also delete folders using this method, 
provided they are empty, or their contents is not 
currently scheduled or otherwise being used on another eScreen. For 
more information on how to see which content resource items are 
being used where, see "Usage Reports" on page 129.

Copying Content
Duplicates of graphics, videos 
and sounds can be made in their 
original locations, other folders, 
or folders that you create (For 
more information on creating 
new folders, see page 83). 

Follow these steps to copy:

1.	 Select the item(s) you wish 
to copy.  Using one of the 
techniques on page 87, 
select the item(s).

2.	Drag the items.  Using your 
mouse, begin to drag one of 
the selected items (they will 
all be dragged together).

3.	Hold the Ctrl key.  Before 
releasing the mouse button, 
hold down the Z  key. 
A small plus symbol will 
appear next to the cursor.

4.	Release the mouse button 
to begin copying.  Release 
the mouse button over the 
folder or location where 
you'd like the items copied.

Figure 3-44. 

Figure 3-45. 
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Introduction to Scheduling
The content you have imported into Design Studio will only be 
displayed on the eScreens when they have been instructed to do so.

You will tell Design Studio which items to play, when to begin and 
stop playing the items, how long to play them, and set a few other 
options regarding item playback as well. Instructing Design Studio in 
this way is known collectively as scheduling.

WORKING WITH CATEGORIES
You will schedule content by adding it to one of the Play Categories  
(hereinafter categories) listed in the Categories tab (Figure 3-46).

The Anatomy of a Category
Double-clicking on a category in the Categories tab 
will open it in the Edit/Work Area (hereinafter, work 
area) as shown in (Figure 3-47).

Hint:  When more than one item is open in the 
work area, Design Studio groups and tabs them. 
Switch between them by clicking their tabs, or 
use the keyboard shortcut Z + Q. 

As you would expect, the items you see in this 
category, Colonsay Main Area, are being displayed in 
the main area of the eScreens at the Colonsay facility.

3.4	Scheduling Content to Play
The content stored in Design Studio exists for the sole purpose 
of being displayed on the eScreens. Let's look at how this is 
accomplished.

The four 
categories:

In the section "Template 
Sizes" on page 15, 
you learned that graphic 
content can be displayed 
in either the main or upper 
right areas of the eScreen.

Each facility has a category 
in the Categories tab 
that represents each 
of these two areas.

The third category 
represents the text ticker 
area (page 115).

The fourth category 
represents background 
audio, and is not displayed 
in any visible layout area.

Figure 3-47. An opened category

Figure 3-46. The four categories for the Colonsay facility



Chapter 3: The Design Studio™ Program 91

Working with Categories� Scheduling Content to Play

Play Items:  Categories can contain graphics, videos and messages. 
Items in a category are shown as a large thumbnail preview. Double-
clicking any item within a category will open it in the work area as well.

Play Order:  Between each item is a forward-pointing arrow, indicating 
the order the items will be displayed. A red arrow indicates two items 
will always play together. (See "Keep with Next" on page 111).

Changing the Play 
Order in a Category
To change the order in which 
the items in a category will play, 
simply reposition the items by 
dragging them. Dragging-and-
dropping one item on top of 
another will always place the 
first item before the item you've 
dropped it onto (Figure 3-48).

Deleting a Play Item from a Category
To delete a play item from a 
category, right-click the item and 
choose Delete from the menu as 
shown in (Figure 3-49).

Alternatively, you can use a 
keyboard shortcut. With the item selected, 
simply press the S key on your keyboard.

Hint:  You can manipulate multiple 
items by selecting them before 
moving or deleting. (See page 87 
for more on selecting multiple items).

Important 
reminder:

Be sure you are only 
working within your 
facility folder in each tab.

To make sure you are 
scheduling content to 
play only on your facility's 
eScreens, use the steps 
listed in "Opening Your 
Facility Folder" on page 
80 to navigate to 
your facility folder in 
the Categories tab if it 
is not already open.Figure 3-48. Dragging to change 

the play order

Figure 3-49. Deleting a 
play item

Opening Play Items 
from Within a Category
Most of the items in a category 
will be graphic slides or photos. 
Double-clicking these will open a 
larger preview of the item.

If the item is a video, double-
clicking will also open a larger 
preview.

If the item is a message, double-
clicking it will open the message 
for editing.
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BASIC SCHEDULING
The most straightforward form of 
scheduling consists of:

1.	  Adding an item to a category

2.	 Publishing the category

This will immediately add the item 
to the rotation to be played with 
the other items in that category.

Follow these steps to schedule 
an item to play:

1.	 Open a category.   In 
your facility folder in the 
Categories tab, double-click 
either your Main Area or 
Top-Right Area category to 
open it in the work area.

2.	 Navigate to the item you wish to play.  In the Graphics, 
Messages, or Videos tab, locate the resource item in your 
facility folder that you wish to play.

3.	 Drag the item into the open category window.  With your 
mouse, drag the item up into the open category window in 
the work area. Wherever you drop the item is where it will be 
located in the play order, but you can reposition it if necessary.

4.	 Right-click on the category's title tab.  At the top-left of the 
work area, right-click on the title tab of the open category.

5.	 Publish the category.  From the right-click menu, choose 
Publish. Design Studio will ask if you would like to save the 
changes to the category before publishing; choose yes.

Hint:  You can add multiple items by selecting them before 
dragging. (See page 87 for more on selecting multiple items).

2

3

4

5

Figure 3-50. Steps 2 thru 5: 
Adding an item to a category and 
publishing

Helpful things 
to remember 
before you begin 
scheduling:
•	 The category you 

wish to add an 
item to must be 
open and visible 
in the work area.

•	 The item you wish 
to schedule must be 
visible in a content 
resource tab.
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SAVING VS. PUBLISHING
Before the added content will be displayed on the eScreens, the 
category you have added it to must be both saved and published.

Saving a Category
Choosing Save from the tab or File menu 
(Figure 3-51) will save the changes you have 
made to the category, but will not send these 
changes to the eScreens.

You can also save the changes to an open category 
with the keyboard shortcut Z + s.

The category items that were being displayed on 
the eScreens before changing the items in a category, will continue 
to play until you publish the category. This is useful when you are 
making many changes and would like to save your work as you go, 
but you are not ready for the new items to display on the eScreens.

Publishing a Category
Choosing Publish from the tab menu 
(Figure 3-52) will send the changes 
to the affected eScreens immediately. 
However, it will also prompt you to save 
the changes you have made to the 
category. This means that the Publish 
command essentially performs both tasks: saving and publishing.

Unpublished categories are indicated by a small "cog" icon in the 
Categories resource window as shown in (figure 3-53).

Hint:  You can also publish a category at a later time from the 
Categories resource tab, by right-clicking and choosing Publish. 

Figure 3-51. 

Figure 3-52. 

How to discard 
all work done to 
a category since 
the last time it was 
published, even if 
it has been saved:

Right-click in the open 
category window 
and choose Category 
Publishing... 

Then click the Discard 
Changes button.

Figure 3-53. "Cog" indicator next 
to an unpublished category
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3.5	Advanced Scheduling Options
In this section, we will learn about Design Studio's scheduling 
tools and options. We will leverage these tools to gain more 
precise control over when and how long items play.

Introduction to Advanced Scheduling
Scheduling an item (page 90) can be compared to turning on a 
light switch: Once it is on, it remains on until you turn it off. However, 
Design Studio offers specific control over an item's play schedule 
(hereinafter schedule) through its powerful scheduling tools:

•	 Schedule time ranges

•	 Recurrence patterns

•	 Copy/paste play times

•	 Visual timeline schedules

THE MESSAGE SCHEDULING WINDOW
Adding a custom schedule or changing an item's schedule is done 
inside the Message Scheduling window for that item.

Follow these steps to open the Message Scheduling Window:

1.	 Select a category item.  With your mouse, click once on an 
item inside of an open category window.

2.	 Show the Properties window.  If it is not open, click 
on the Properties tab or choose Properties from the 
View menu to show the Properties window.

3.	Click the Scheduling button.  In the Schedule section 
of the Properties window, click the small ellipses 
button next to Always Scheduled. This will open the 
Message Scheduling window (Figure 3-54).

1

2
3

Figure 3-54. Message Scheduling window
Figure 3-55. Steps to open the Message 
Scheduling window for a category item
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Disabling 'Always Scheduled'
Items added to a category receive a default schedule of 
Always Scheduled (Figure 3-56). To create a custom schedule for 
an item, the Always Scheduled check box must be unchecked.

Follow these steps to disable an item's Always Scheduled option:

1.	 Open the Message Scheduling window.  Use the steps on 
the previous page to open the Message Scheduling window 
for a category item.

2.	Uncheck Always Scheduled.  At the bottom of the Message 
Scheduling window, click once on the check box next to Always 
Scheduled to uncheck it as shown in (Figure 3-57).

Hint:  Disabling the Always Scheduled option for an item is 
effectively the same as setting it to never be scheduled. The 
item will never display on the eScreens, however, you will still 
see the item in the category until it is deleted. 

When the Always Scheduled check box is unchecked, you can create 
custom schedules for the item. See "Creating a Play Time" on page 
96 for more information.

Resizing the Message Scheduling Window
When you open the Message Scheduling window for the first time, 
it is not very large. It will benefit us later to see more of this window.

Follow these steps to resize the Message Scheduling window:

1.	 Drag the bottom-left corner.  Using your mouse, drag the 
bottom left corner of the window to enlarge it (Figure 3-58).

2.	Move the window if necessary.  Move and center the window 
as necessary in order to see as much of it as possible

Figure 3-56. Item with default 
schedule of Always Scheduled

Figure 3-57. 

Figure 3-58.  Dragging to resize 
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CREATING A PLAY TIME
Any category item can be set to begin playing at any time of any 
day, and stop playing at any later time on the same day, or any later 
day. This is known as the play-time range (hereinafter time range).

An item's time range can recur (be invoked again) using one of these 
recurrence patterns:

•	 Play only once

•	 Daily recurrence

•	 Weekly recurrence

•	 Monthly recurrence

•	 Yearly recurrence

•	 Specific dates

The time range and recurrence options for an item are found in the 
Play Time dialog box (Figure 3-60).

Follow these steps to open the Play Time dialog box:

1.	 Right-click the empty timeline.  In the Message Scheduling 
window (page 94), right-click in a blank area. Make sure the 
Always Scheduled check box is unchecked before doing this.

2.	Choose Add Play Time  from the menu that appears 
(Figure 3-59). The Play Time dialog box will appear:

Figure 3-59. Figure 3-60. The Play Time dialog box
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Play Only Once
When the recurrence pattern is set to Specific Date, the time 
range will only be invoked once, on the selected date.

With the settings shown in (Figure 3-61), an item would begin 
playing at 8:00 A.M. on Wednesday, November 27, 2013, play 
for two hours, and never play again without further instruction.

Daily Recurrence
When the recurrence pattern is set to Daily, the time range 
will be invoked once per day.

With the settings shown in (Figure 3-62), an item would begin 
playing every day at 11:00 A.M. and play for three hours.

Weekly Recurrence
When the recurrence pattern is set to Weekly, the time range 
will be invoked on the selected days of the week.

With the settings shown in (Figure 3-63), an item would begin 
playing at 7:00 A.M. and play for nine hours every Monday, 
Wednesday and Friday.

Use-case scenario: You wish to display a welcome 
message to guests who will be arriving at your facility on 
a specific date and time.

Use-case scenario: You wish to display nutrition 
facts and information meant to encourage the work force 
to make healthy eating choices during lunch time.

Figure 3-61. Playing an item only once

Figure 3-62. Playing an item daily

Figure 3-63. Playing an item weekly
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Monthly Recurrence
When the recurrence pattern is set to Monthly, the time range 
will be invoked on the selected day of each month.

With the settings shown in (Figure 3-64), an item would begin 
playing at 11:00 A.M. and play for one hour on the second 
Tuesday of every month.

Yearly Recurrence
When the recurrence pattern is set to Yearly, the time range 
will be invoked once a year on the selected day or date.

With the settings shown in (Figure 3-65), an item would play 
all day (24 hours) on December 25 every year.

Recurring on Specific Dates and Times
You can create a custom play schedule that does not fall into one of 
the recurrence patterns offered. To play an item multiple times in the 
future on arbitrary dates and times (recurring, but not in a pattern), 
you must create multiple play times for the same item. See "Copying 
and Pasting Play Times" on page 102 for more information.

Use-case scenario: You wish to display separate 
information to each shift based on their weekly schedule.

Use-case scenario: You wish to display a reminder 
that the monthly radio address is in progress, and 
encourage the workforce to listen in.

Use-case scenario: Display a yearly holiday message.

Figure 3-64. Playing an item monthly

Figure 3-65. Playing an 
item yearly

Items can play for 
any length of time:

These use-case scenarios 
do not depict a time range 
any shorter than one day.

However, a time range 
can be any length of time, 
even days and weeks!
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THE MESSAGE SCHEDULING TIMELINE
The Message Scheduling Timeline (hereinafter timeline) stretches 
across the top of the Message Scheduling window. The timeline 
offers a visual representation of an item's scheduled play times.

After setting an item's schedule in the Play Time dialog box, the 
play time(s) will appear in the timeline. In the example shown in 
(Figure 3-66), a Play Time setting of 8:00 A.M. - 10:00 A.M. is 
shown in the timeline as a shaded indicator bar stretching across 
8:00 A.M. and 9:00 A.M., ending at the 10:00 A.M. mark.

Hint:  The default timeline interval is one hour. See "Time Type" 
on page 104 to change the time interval that is shown.

Click-and-Drag to Add a Play Time
You can create a play time by dragging your mouse across the timeline 
as shown in (Figure 3-67). The Play Time dialog box will appear, 
and the time range you dragged-out will be automatically filled-in.

You can edit the Time Range and Recurrence Pattern settings in 
the Play Time dialog box when it appears, or you can accept the 
schedule you dragged-out by clicking the OK button, or by pressing 
the " key on your computer's keyboard.

Figure 3-66. An item's Play Time dialog box settings are also represented 
visually on the timeline Always check the 

recurrence pattern!

When dragging to create a 
play time shorter than one 
day, the default recurrence 
pattern in the Play Time 
dialog box is set to Daily.

If you want to make sure 
an item plays only once, 
change the recurrence 
pattern to Specific 
Date (page 97).

On Scrolling
There may be more play times 
than you can see on the timeline.

You can scroll forward or 
backward to see if there are other 
play times for a selected item.

Figure 3-67. Creating a play time by dragging on the timeline
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If you do not get the begin and end times exactly right on the first 
drag, you can try one of the following:

•	 Adjust the Time Range settings in the Play Time dialog box 
when it appears (see "Creating a Play Time" on page 96)

•	 Adjust the play time by dragging its edges (next section)

•	 Delete the Play Time (page 101), adjust the Grid Settings or 
zoom-in (page 103), and drag again to reschedule your item

Hint:  If the play time you wish to create is longer than the 
length of the timeline, the timeline will automatically scroll as 
you drag to accommodate the new play time.

Adjusting a Play Time Using the Timeline
You can use your mouse to extend or shorten the beginning or end 
of the play time indicator bar to adjust the play time. In the example 
shown in (Figure 3-68), the play time is extended by one hour.

You can also use your mouse to drag the entire play time indicator 
bar to a new position on the timeline. You can even drag it to another 
date. This changes when the item begins and ends playing, but 
not the duration of the play time. Look at the example shown in 
(Figure 3-69). Instead of beginning at 8:00 A.M. and ending at 11:00 
A.M., the item will begin playing at 9:00 A.M. and end at 12:00 P.M.

A hint for dragging 
to extend a play 
time:

When you move your 
mouse near the beginning 
or ending edge of a play 
time indicator bar, the 
cursor will change to a 
double-headed arrow 
indicating you are in 
the proper position 
to begin dragging.

Figure 3-68. Dragging to adjust a play time

Figure 3-69. Dragging to adjust a play time
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Be aware that if you extend or move a play time indicator bar for 
a play time that is part of a recurrence pattern, then all of the play 
times in that pattern will be adjusted as well.

Adjusting a Play Time Using the Dialog Box
Instead of dragging a play time indicator bar to adjust a play time, 
you can reopen the Play Time dialog box to edit a selected play time.

Right-click on the play time 
indicator bar. Choose Edit Play 
Time from the menu as shown in 
(Figure 3-70), or press the e key on your 
computer's keyboard. The Play Time dialog 
box will appear. You can adjust the Time 
Range and Recurrence Pattern settings.

Be aware that if you adjust a play time that 
is part of a recurrence pattern, all of the play 
times in the pattern will be adjusted as well.

Deleting a Play Time
Delete a play time by right-clicking 
it and choosing Delete from the 
menu (Figure 3-71). Or you can 
select the play time and press the S key. 
Be aware that if you delete a play time that 
is part of a recurrence pattern, all other play 
times in the pattern will be deleted as well.

Hint:  If an item has no play time, it will 
never display on the eScreens, however, 
you will still see the item in the category 
until it is deleted.

Beware!

There is no way to undo 
or redo any changes 
made to the play 
times in the Message 
Scheduling window.

If you accidentally 
manipulate or delete a 
play time, click the Cancel 
button or re-adjust your 
play times manually.

Figure 3-70.

Figure 3-71.
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Copying and Pasting Play Times
You can create multiple play times for each item using the timeline. 
These play times can be set to any time and date in the past or future.

Follow these steps to create multiple play times for an item:

1.	 Right-click on a play time. On the timeline inside the Message 
Scheduling window (page 94), right-click on an existing play 
time indicator bar.

2.	Copy the play time.  Choose Copy from the menu (Figure 3-72), 
or press the c key on your computer's keyboard.

3.	Right-click on the timeline.  Right-click again, anywhere on 
the timeline.

4.	Paste the play time.  Choose Paste Play Time from the menu  
that appears (Figure 3-73).

Hint:  No matter where you initially right-clicked, the pasted 
time will always be placed directly over the copied play time.

5.	Reposition the new play time.  Drag the new play time to a 
new position. In the example shown in (Figure 3-74), the item 
will now play at 8:00 A.M. and at 11:00 A.M., for two hours each.

You can drag the newly-pasted play time to any time or date in the 
past or future. If you drag it rightward or leftward past the times that 
are visible, the timeline will scroll automatically for you.

You can edit the newly-pasted play time using the timeline (page 
100) or using the Play Time dialog box (page 101).

Figure 3-74.

Figure 3-72.

Figure 3-73.
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THE PLAYTIME GRID
Between the time intervals that you can see on the timeline, there are 
invisible intervals that your mouse will snap to when creating a play 
time indicator bar. You may not notice this snapping at first because 
the default snap interval is set to one minute.

With a default snap interval of one minute, it can be difficult to align 
your cursor directly on an interval mark when you want a play time 
that begins on the hour. Therefore, the beginning and ending edges of 
your play time indicator bar may not be created where you intended.

The timeline and the invisible interval grid have several settings to 
make dragging to create play times easier. You can:

•	 Enable/disable the Snap to Grid feature

•	 Change the grid snap interval (Grid Settings)

•	 Change the timeline interval (Time Type) (hours, days, etc.)

•	 Zoom in/out to see more of the timeline

Snap to Grid
By default, Design Studio is set so that the play times you drag-out 
on the timeline will snap to the invisible interval grid. You can turn 
this feature off by right-clicking on the timeline and choosing Snap 
to Grid  as shown in (Figure 3-75), to uncheck it.

Grid Settings
In the Grid Settings menu (Figure 3-76), you can choose 
the interval of the invisible grid. With a 30 Minute grid 
interval, your play time indicator bar can only be created 
and adjusted in increments of 30 minutes: When you drag, 
it is only possible to create a play time that begins or ends 
on an hour or half-hour mark. The selected Grid Settings 
also apply when dragging to adjust existing play times.

Figure 3-75.

Figure 3-76.

Figure 3-77. The invisible snap intervals

Grid Setting Invisible Snap Intervals

5 Minute

15 Minute

30 Minute

1 Hour

To access the 
timeline menu:

Right-click anywhere at 
the top of the timeline.
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Time Type
By default, the timeline is 
divided into one-hour intervals 
of time. You can change the 
display interval of the timeline 
using the Time Type menu: 
right-click at the top of the 
timeline and choose Time Type 
as shown in (Figure 3-78).

You can set the timeline to 
display the following intervals:

•	 Hours

•	 Days

•	 Weeks

•	 Months

•	 Years

Choosing one of these settings 
places helpful dividers on 
the timeline as shown in 
(Figure 3-79), to help visualize schedules and create new play times.

Zoom
Independent of the Grid Settings and Time Type, the timeline can 
be zoomed-in, spreading the interval marks (and the invisible grid 
intervals) farther apart as shown in (Figures 3-81 and 3-82). This 
offers more precision when dragging to create or adjust play times.

Figure 3-78. Changing Time Type

Hours

Days

Weeks

Years

Months

Figure 3-79. Time Types

What is the 
difference 
between 'Time 
Type' and 'Zoom'?

Changing the Time Type 
allows you to see more 
time in the same space. 
One of the benefits of the 
Time Type setting is the 
interval marks it displays.

Changing the Zoom setting 
simply spreads those 
interval marks farther 
apart for clarity, essentially 
allowing you to see less 
time in the same space.

If it helps, you can think 
of Zoom as zoom-in, and 
Time Type as zoom-out.

100% 100%

200% 200%

Figure 3-80. Zoom settings for the 
'Days' Time Type

Figure 3-81. Zoom settings for the 
'Weeks' Time Type
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To change the Zoom setting, right-
click at the top of the timeline and 
choose Zoom from the menu as 
shown in (Figure 3-82). You can 
choose from settings of 100%, 
200% and 300%.

Go to Date
Instead of scrolling long distances to find a specific date or time 
interval on the timeline, you can use the Goto Date feature. Right-
click at the top of the timeline and choose Goto Date from the 
menu. When the Date Chooser appears (Figure 3-84), navigate 

to the month, day, date and year 
you desire. This date will then be 
shown on the timeline.

Hint:  Click on the date at 
the top of the Date Chooser 
to switch quickly between 
months and years.

OPENING SCHEDULES FOR MULTIPLE ITEMS
Inside a category, there will be no visible difference between:

•	 Items that are Always 
Scheduled

•	 Items that have a custom 
schedule

•	 Items not currently playing 
because their schedules 
have not yet begun

•	 Items not currently playing 
because their schedules 
have expired

•	 Items not currently playing 
because they have no 
schedule

To see the schedules for more than one item, simply select several 

On Timeline Settings
Changes you make to the timeline 
and invisible grid settings will not 
be saved when you are done. 
You must set your Grid Settings, 
Time Type and Zoom each 
time you open the Message 
Scheduling window.

The time and date you were 
viewing are also not saved. The 
timeline will jump to the current 
date/time each time it is opened.

Figure 3-82. Changing the Zoom

Fun fact:

Design  
Studio 
uses the 
same 
Date 
Chooser 
that appears when you 
click on the time and date 
in your Windows™ TaskBar.

Wednesday, November 27, 2013

Figure 3-83. Goto Date feature

Figure 3-84. The Date Chooser
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(or all) items before opening the Message Scheduling window. 
There are several ways to select more than one item in a category. 
For more information, see (Figures 3-39 thru 3-41) on page 87.

Dragging to Select
Drag a selection rectangle around the items you wish to select. This 
will select only the items touched by your selection rectangle.

Shift-Clicking
Click once on an item. Hold down the ? key and click another 
item. These items, and all items in between them, will be selected.

Control-Clicking
Click once on an item. Hold down the Z key and click on additional 
items. Each click will add or remove an item from the selection.

Selecting All Items
Click once on any item inside the category window to select it. Choose 
Select All from the Edit menu as shown in (Figure 3-85), or simply 
press Z + a on your computer's keyboard.

Now when you open the Message 
Scheduling window (page 94), the 
selected items will be listed alongside their 
respective schedules. This is a great way to 
visualize what will play when, and to create 
better custom schedules.

In (Figure 3-86), all of the items in the list 
have a schedule of Always Scheduled by 
default. To create custom schedules for 
these items, you must first uncheck the 
Always Scheduled check box.

Figure 3-85.

Figure 3-86.
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Copying and Pasting Play Times to Other Items
Just like you can copy a play time for an item and paste it on the same 
item (page 102), you can also paste a copied play time to other 
items. These new play times can then be repositioned or adjusted 
as you would any other play time.

Follow these steps to copy a play time to a new item:

1.	 Right-click on a play time.  On the timeline, right-click on an 
existing play time indicator bar.

2.	Copy the play time.  Choose Copy from the menu, or press 
the c key on your computer's keyboard.

3.	Right-click on the timeline of another item.  Right-click 
anywhere on the timeline of the item you'd like to receive the 
copied play time.

4.	Paste the play time.  Choose Paste Play Time from the menu.

5.	Reposition the new play time.  The pasted play time will 
always be placed at the exact time of the original item's play 
time. Drag the new play time to a new position if you choose.

You can drag the newly pasted play time to any time or date in the 
past or future. (You cannot drag a play time between items). If you 
drag it rightward or leftward past the times that are visible, the timeline 
will scroll automatically for you. You can also edit the newly pasted 
play time using the Play Time dialog box (page 101).

Saving Schedules
Before the schedules you create will 
take effect, the category containing the  
scheduled item must be both saved and 
published. Choosing Publish from the 
tab menu (Figure 3-87) will send the 
changes to the eScreens immediately and will prompt you to save the 
changes you have made to the category. (For more, see page 93).

Figure 3-87. 
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Advanced Scheduling Options� Scheduling Examples

SCHEDULING EXAMPLES
Below are a few examples of what some common schedules could 
look like in the timeline.

Playing a Different Slide Every Week
Using the copy and paste technique (page 107), you are able to 
schedule energy tip slides to play for one week each, without having 
to drag-out a new play time for each slide.

Playing Slides at the Same Time Every Day
Using the Daily recurrence pattern settings (page 97), you are 
able to schedule nutrition fact slides to play every day at lunch time.

Playing Slides at Specific Times
The example in (Figure 3-90) shows two slides: one reminding 
of an upcoming radio address, and one announcing that the radio 

Figure 3-88. A typical schedule for a weekly energy tip

Figure 3-89. A typical schedule for daily lunchtime nutrition facts

Figure 3-90. A typical schedule for a radio address at a specific time
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Scheduling Examples� Advanced Scheduling Options

address is in progress. Using the dragging technique to create play 
times (page 99), and the Specific Date recurrence pattern setting 
(page 97), you are able to schedule the first slide to play until 
1:00 P.M., and the second slide to play during the radio address (from 
1:00 P.M. to 2:00 P.M.).

Repeating Slides on 
Specific Dates
The example in (Figure 3-91) 
shows three related blood drive 
slides: The first slide reminds the 
work force of an upcoming blood 
drive on Monday and Tuesday. The second slide announces that 
today is the day of the blood drive. The third one thanks everyone 
who donated blood, and plays for five days after the blood drive.

Using the Specific Date recurrence pattern setting (page 97), and 
the copy and paste technique (page 102), you are able to schedule 
each slide to repeat on different days. This allows you to use the 
same slides for two separate blood drives (the first on Wednesday 
of one week and the second of Thursday the next week).

Scheduling Date-Specific Slides with a Title Slide
The example in (Figure 3-92) 
shows a week's worth of birthday 
slides, each scheduled on its 
respective date. The first slide 
displays a Happy Birthday message 
before the date-specific slide plays.

Hint:  Be sure to select the Keep 
with Next check box for the first 
slide in its Properties window.

Figure 3-91. A typical schedule for slides recurring on different week days

Did you notice?

In the blood drive example 
(Figure 3-91), it is perfectly 
acceptable that the play 
time of the Thank You slide 
from the first blood drive 
overlaps the play time of 
the announcement slide 
for the second blood drive. 

Figure 3-92. A typical schedule for title slide followed by date-specific slides
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THE PROPERTIES WINDOW
If the Properties window is not open and docked on the left, choose 
Properties Window from the View menu to open it. Dock it to the 

left side of the Design Studio program window as shown 
in (Figure 3-93). Or, load the Advanced Docking Pane 
Layout. See "About Docking and Docking Pane Layouts" 
on page 71 for more information.

When you select an item within a category, the 
Properties window will list options available for that item. 
In (figure 3-93), there are several user-customizable 
options in the Properties window. For our purposes, 
we will only ever need to set the following options:

•	 Transition

•	 Keep With Next

•	 Timeout

•	 Schedule (page 94)

If you do not see all of these options when you select 
an item, then you may need to scroll down inside the 

Properties window using the scroll bar as in (Figure 3-94).

Transitions
A Transition is an animated visual change from one item to the next, 
and determines how the item will "arrive" on the eScreens. 

To  change  an  i tem's 
Transition set ting, click 
the small ellipses button 
as shown in (Figure 3-95). 
The Transitions window will 
appear (Figure 3-96).

Hint:  Resize the window 
to see more transitions.

3.6	 Item Properties
Once an item is added to a category and scheduled the way you 
want it, there are a few more options for the item that you may 
want to set. This is done using the Properties window.

Figure 3-93. Properties window

Figure 3-94. You  may have to 
scroll to see all available options

Figure 3-95. Opening the 
Transitions window

Figure 3-96. The Transitions resource 
window
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The Properties Window� Item Properties

Each animated Transition is represented by a thumbnail preview, 
giving you a basic idea of what the animation will look like.

The default Transition for all items added to a category is Cross Fade. 
This is suitable for all items, and you should avoid using busy or showy 
animations. Simple 2D Transitions work best for our purposes. (For 
more information, see "Avoid Distracting Transitions" on page 150).

Keep with Next
Between the items in a category, there are forward-facing arrows 
that indicate the play order. Although the items will always obey this 
order, they may be interrupted by other content also playing on the 
eScreens, such as that from Corporate or Public Affairs. For more 
information, see "Automatic Content" on page 8.

If you have two or more slides that must not be 
interrupted by other content, you can force them 
to always play together using the Keep with Next 
feature. Simply select the item in the category 
and click the Keep with Next check box in the 
Properties window (Figure 3-97).

Hint:  A red arrow after an item indicates that 
it and the next slide will always play together.

In the example shown in (Figure 3-98), the second hearing policy 
slide will always play immediately after the first hearing policy slide.

The second and third energy tip slides will always play immediately 
after the energy tip title slide.

Automatic content may still play between any two slides where there 
is a blue arrow.

Figure 3-97. Turning on the Keep 
with Next option for an item

In the example category 
above, three slides have 
the Keep with Next 
feature activated:

•	 HEARINGPOLICY_1

•	 ENGY-TIP-TITLE

•	 ENGY-TIP-02

Figure 3-98. Example of the  
Keep with Next feature in action
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Item Properties� The Properties Window

Timeout (Play Duration)
In Design Studio, the length of time an item displays before moving 
on to the next item is known as the play duration, or Timeout. The 
Timeout is measured in seconds, and is set in the Properties window.

The default Timeout for all new graphic resources (slides, photos, 
etc.) placed in a category is 10 seconds. This value can be changed 
by clicking the Timeout box and typing a new value (Figure 3-99).

Hint:  Only graphics have a Timeout setting. Messages and 
videos will move to the next item when they are done playing.

You may determine that some slides require longer Timeouts than 
others, based on the information they contain. In the example 
category shown in (Figure 3-98) on page 111, the energy tip title 
slide may only need a Timeout of five seconds because it does 
not contain much information; it is simply introducing the next slide. 
However, the slides containing the actual energy tips may require a 
Timeout of 15 or 20 seconds to be read comfortably.

Changing the Default Timeout
If you find yourself continually changing the Timeouts 
for the slides you add, you may consider changing the 
default Timeout, so that every new slide added will 
have a play duration suitable for your facility's needs. 
The default Timeout is set in the Options dialog box, 
which can be found in the Tools menu.

In the list on the left side of the Options dialog box, 
choose Schedule, then choose Item Insert Defaults, 
then choose Graphic.

Type a value into the Timeout box and choose OK.
Figure 3-100. Changing the default Timeout value in 
the Options dialog box

Figure 3-99. Typing a new value 
in the Timeout box

Did you know?

You can set the Transition, 
Timeout, and Keep with 
Next options for more 
than one item at a time 
by selecting multiple 
items (or all items) before 
changing the setting in 
the Properties window.

For more on selecting 
more than one item in a 
category, see (Figures 3-39 
thru 3-41) on page 87.
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•	 For a list of video file types that can be added to Design Studio, 
see "Video Resources" on page 78.

•	 For information on how to add videos to Design Studio, see 
"Importing and Organizing Content" on page 83.

•	 For information on how to play videos on the eScreens, see 
"Scheduling Content to Play" on page 90.

•	 For information on setting custom schedules for videos, see 
"Advance Scheduling Options" on page 94.

•	 For information on Transitions, and Keep with Next settings 
for videos, see "Item Properties" on page 110.

The techniques, procedures and settings referenced on the above 
pages apply to video content as well as graphic content resources. 

The only consideration when scheduling and setting options for video, 
is that  video content resources do not require a Timeout setting 
when added to a category. The eScreen will move on to the next 
item when the video has ended.

eScreen Audio Capabilities
All Digix eScreens are capable of playing videos and animations. If the 
video contains audio, you must make sure that your facility's 
eScreens are capable of audio output.

Most eScreens at your facility will be LCD televisions with 
built-in speakers. However, some eScreens were custom-built 
by the manufacturer (Symon), which included detachable 
speakers at the time of purchase. Whether these speakers 
were attached at the time of installation is a question for your 
facility's management or I.T. department.

Hint:  If more than half of the eScreens do not have this 
capability, you may want to avoid videos that contain audio.

3.7	 Working with Videos
Videos are imported, stored and scheduled just like graphic items, 
and can be played in either the main or upper right areas.

How can I tell if 
the eScreens at my 
facility have audio 
capabilities?

There is no indicator 
in Design Studio for 
whether an eScreen has 
speakers attached to it.

You should play a 
video (that contains 
audio), and walk to each 
eScreen is to see if you 
can hear the audio.

Be sure to bring a remote 
with you for the volume. 
Most eScreens also 
have volume controls 
on its bottom panel.

Why would some of the 
eScreens at my facility not 
have attached speakers?

Depending on your facility's management 
at the time of installation, the speakers 
that came with the eScreens may not 
have been attached.

This can be especially true in areas where 
distractions are discouraged, like control 
rooms, or in high-noise environments like 
warehouses and machine shops.
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There is a shared-content (Community Property) folder available in 
each of these content resource tabs:

•	 Messages

•	 Videos

•	 Sounds

•	 Graphics

The Community Property folders are a resource for general-topic pre-
made slides, slides made by users at other facilities, and a repository 

for finding corporate videos.

The Community Property folder 
in each content resource is called:

~Community Property
as shown in (Figure 3-101). The 
folder will always be somewhere 
near the top of the folder list.

Sharing Your Content Using 'Community Property'
In some cases, you will create content that users at other facilities 
may find useful. Feel free to place a copy of your general-purpose 
content in the Community Property folder in Design Studio. For 
more information, see "Copying Content" on page 89.

Corporate Video Repository
Corporate videos are made available in the Community Property 
folder inside the Videos tab. Be sure to check back regularly to see 
if new videos have been added.

Playing Community Property on Your eScreens
To play an item from a Community Property folder, add the item to 
one of your categories directly from the Community Property folder. 

Do not make a copy of, or move the item into, your facility folder. For 
more on scheduling items to play, see page 90.

3.8	Community Property
In each content resource tab, there is a folder for shared and pre-
made content called Community Property.

Why the tilde?

A tilde (the '~' symbol) 
appears at the beginning 
of the Community Property 
folder name so that it 
always appears near the 
top of the folder lists.

Figure 3-101. The Community Property folder in the graphic resource tab

On copying and 
pasting:

You can copy items using 
the Copy and Paste 
commands available in 
both the Edit menu and 
the right-click menu.

Or, you can use these 
keyboard shortcuts:

•	 Z + c = Copy

•	 Z + v = Paste

Simply copy the items, 
navigate to the Community 
Property folder and 
paste them there.
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3.9	Working with Text Tickers
Local facility tickers are a quick and powerful way to get text 
information out to the workforce. A ticker is simply a message that 
uses horizontally-scrolling text to achieve a "ticker tape" effect.

ANATOMY OF A TEXT TICKER
In its most basic form, a ticker is a box of text 
inside of a message. This text box is pre-set to 
horizontally scroll the text contained within it.

The message that contains this text box is always 
scheduled to play on your facility's eScreens, and 
as such, is found in the Text Ticker category for 
your facility. The Text Ticker category is found in 
your facility folder in the Categories tab.

When the text is edited and the message is 
published, the published text will be sent to 
your eScreens to play in the Ticker Layout Area 
alongside the other tickers (news, stocks, etc.). 
For more on Layout Areas, see page 5.

YOUR LOCAL FACILITY TICKER
Your local facility ticker will display in succession 
with several automatic tickers in the Ticker Area. 

Follow these steps to edit your local ticker:

1.	 Open the Ticker Area category.  In your 
facility folder in the Categories tab, double-
click your Ticker Area category to open it 
in the work area [Item 1 in (Figure 3-102)].

2.	 Open the ticker message.  In the window 
that appears, double-click the ticker 
message [Item 2 in (Figure 3-102)]. This 
also opens it in the work area (Figure 3-103).

Hint:  When more than one window is open in the work area, 
Design Studio tabs them. For more on tabs, see page 71.

Figure 3-102. How a text ticker works and where it is stored

Figure 3-103. A ticker message 
opened in the work area

Category
In the Categories tab, open the Ticker Area category 

located in your facility folder. For more information on categories, 
see "Working with Categories" on page 90.

Message
There is only one item in 

the Ticker Area category: Your 
local facility ticker. Double-click 
it to open it. Edit the ticker text, 
and then publish the message.

Layout Area
Once published, the 
text will scroll across 
the ticker area at the 
bottom of your facility's 
eScreens.

2 3

1
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Working with Text Tickers� Your Local Facility Ticker

3.	 Open the text box for editing.  Double click on the text 
to insert your type cursor. If there is no text in your ticker, 
double-click colored background where the text would be.

4.	Type or edit the text. Using your mouse and keyboard, type 
the announcement(s) you wish to display. Be sure to put 
a suitable separator between announcements or differing 
types of information.

Hint:  When editing, the text may not appear on one line.

Font, Color and Text Size
Ensure that the font, color, and size of the text is not changed. If you 
are pasting from another program, sometimes the source formatting 
can override the settings in the text box. Ticker text should be:

•	 Set in the Arial font

•	 Have a size of 18 - 20 pt.

•	 Be white in color

These settings can be verified in 
the Properties window as shown 
in (Figure 3-105).

Follow these steps to reset the 
text to the proper attributes:

1.	 Select all text.   Using your 
mouse, or the keyboard 
shortcut Z + a , select 
all of the text in the text box.

2.	 Adjust the text.  Using the 
options in the Properties 
window, re-set the text 
according to the attributes 
listed above.

Hint:  Be sure you are in text edit mode before using the shortcut 
Z + a. Otherwise, you will select the text box instead. 

Figure 3-104. Editing the text in a ticker

Figure 3-105. When text is 
selected, the Properties window 
displays the text formatting options

Separation bullets:

To insert a bullet (the 
'•' symbol) between 
text announcements, 
right-click in the text 

box and 
choose 
Insert 
Special and 
click Bullet.

Or, if you have a keyboard 
with a number pad, you 
can use the keyboard 
shortcut X + 0149. 
(This will only work if the 
numbers are typed on the 
keyboard's number pad.)
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Your Local Facility Ticker� Working with Text Tickers

The Zoom Drop-Down Box
To see more or less of the text at one time, you can 
change the zoom settings using the Zoom drop-down 
menu in the Standard tool bar as shown in (Figure 3-106).

Before using this setting, be sure to deselect the text. You 
can deselect the text either by clicking anywhere outside 
the text box, or by pressing the ~ key on your computer's keyboard.

Text Scrolling Speed (Crawl Rate)
How quickly the text will move across the Ticker Area is determined 
by its Crawl Rate setting in the Properties window (Figure 3-107). 

Follow these settings to change the text scrolling speed:

1.	 Deselect the text if necessary.  Click anywhere outside of the 
text box, or press the ~ key to deselect the text.

2.	 Select only the text box.  Click once on the text box to select it. 
(Do not double-click, as this will open the text box for editing).

3.	 Adjust the Crawl Rate setting.  In the Properties window 
(page 110), adjust the Crawl Rate slider to the left or right 
to decrease and increase the speed respectively.

Avoid setting the Crawl Rate too low or too high. A setting of between 
8 and 10 will be sufficient for comfortable reading.

Caution:  Never adjust other text ticker settings, including 
Shadow, Crawl Direction, Translucency, etc.

Figure 3-106. 

Figure 3-107. 

Don't see a 'Crawl 
Rate' setting? 

You may have to use the 
scroll bars to scroll down 
inside the Properties 
window to see this setting.
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Working with Text Tickers� Saving and Publishing Messages

SAVING AND PUBLISHING MESSAGES
Before the changed message will be displayed on the eScreens, it 
must be saved and published.

Saving a Message
Choose Save from the tab or File menu 
(Figure 3-108). This will save the changes you 
have made to the message, but will not send these 
changes to the eScreens.

You can also save the changes to an open message 
with the keyboard shortcut Z + s.

The text that was being displayed on the eScreens before editing 
the message will continue to play until you Publish the message. 
This is useful when you are making many changes and would like to 
save your work as you go, but you are not ready for the new text to 
display on the eScreens.

Publishing a Message
Choose Publish from the tab menu 
(Figure 3-109). This will send the 
changes to the eScreens immediately. 
However, it will also prompt you to save 
the changes you have made to the 
message. This means that the Publish 
command essentially performs both tasks: saving and publishing.

Unpublished messages are indicated by a small "cog" icon in the 
Messages resource window as shown in (figure 3-110).

Hint:  You can also publish a message at a later time from the 
Messages resource tab, by right-clicking and choosing Publish. Figure 3-110. "Cog" indicator next 

to an unpublished message.

Figure 3-109. 

How to discard 
all work done to 
a message since 
the last time it was 
published, even if 
it has been saved:

Right-click anywhere in 
the message and choose 
Message Publishing... 

Then click the Discard 
Changes button.

Figure 3-108. 
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When You Should Use Scrolling Text
As a general rule, you should not place large amounts of text on a slide 
(see "Post Only One Slide Per Topic" on page 143). However, there 
may be times when you need to display a list of names, dates, etc.

Lists can be an easily-digestible way to group and show similar pieces 
of information, while not being overwhelming to the viewer. Messages 
with scrolling text are a good option for this because it results in 
an uncluttered, easy-to-read slide. You should use messages with 
scrolling text for the following types of information:

•	 List of employees being 
recognized

•	 List of employee birthdays

•	 List of calendar events

•	 List of committee members

•	 Other similar items that can 
be grouped logically

You should avoid using messages with scrolling text for the following 
types of information:

•	 A list of chronological steps

•	 A large paragraph, body text 
or stories

•	 Any other information that 
would not make sense in 
list form

Creating a Message with Scrolling Text
There is no need to create a message from scratch. Templates for 
messages with scrolling text are provided in the Community Property 
folder in the Messages resource tab.

Unlike the assets in other Community 
Property folders, you would not 
add these messages directly to your 
eScreens to play. You must first open 
a message template to add your text, 
then save it into your facility folder 
before adding to your eScreen to play.

3.10	 Messages with Scrolling Text
Design Studio is capable of creating messages (slides) that 
include scrolling text... something that cannot be achieved using 
the slide templates. However, you should use the slide templates 
(Chapter 2, page 9) for creating all other types of slides.

When you should 
not use scrolling 
messages:

Due to the nature of 
scrolling text, there will 
be times when some 
information is visible and 
some information is not. 

Messages with scrolling 
text is not suitable for any 
information that would 
not make sense when 
considered individually, 
or suffer from the viewer 
being unable to consider 
all information at once.

If in doubt, stick with lists!

Figure 3-111. Templates for messages with scrolling text in the 
Community Property folder in the Messages tab in Design Studio
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 Messages with Scrolling Text� Using the Message Templates

USING THE MESSAGE TEMPLATES
The small 'T' icon next to a message item (Figure 3-111) indicates that 
it is a message template. A message template is itself not affected 
when you open it and edit the text inside: When you save the 
message, you will be prompted for a new name and location. You will 
have effectively created your own new message from the template.

Exercise:
In this exercise we will create a message with scrolling 
text, from a message template. We will follow the 
steps to fill out the text boxes. We will then preview 

the message, save it to our facility folder, and publish it.

Follow these steps to open a message template:

1.	 Open the Messages content resource 
tab.  Click once on the Messages tab to 
show it. If the tab is not visible, choose 
Messages from the View menu.

2.	 Navigate to the Community Property 
folder.  In the folder list of the Messages 
tab, double-click on the folder named 
Community Property.

3.	 Choose a message template.  In 
the file list, double-click on a message 
template. For this example, open the item 
Birthday Template 02 Right Justified.

4.	 Adjus t  the Zoom  se t t ing i f 
necessary.  A new tab will open in the 
work area showing the message. If it is 

too large, change the Zoom setting to 50%. You can also unpin 
the content resource window to see more of the work area.

Hint:  You can also use the scroll bars to scroll (pan) in the 
message as you are editing. Choose the best method for you.

Note:

A message template 
cannot be added to a Play 
Category until it is saved as 
an ordinary message item.

Figure 3-112. Opening a message 
template (Steps 1 thru 4 highlighted)

1
2

3

4
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Publishing from a Message Template�  Messages with Scrolling Text

Filling-in the Text Boxes
Unlike in the text boxes in the PowerPoint templates (page 30), 
the placeholder text in the Design Studio text boxes must be selected 
and over-written with new text.

Follow these steps to fill-in the text boxes:

5.	 Double-click the Month, Year text box.  Just like the text box 
in the ticker message (page 115), double-clicking anywhere 
in the text will open the text for editing.

6.	Select all of the text inside the text box.  Use your mouse 
cursor to drag across the text to select, or use the keyboard 
shortcut Z + a. (Figure 3-113).

7.	 Type the new text.  For our example, we will type November, 
2013 as shown in (Figure 3-114).

Using these same steps, type a list of names into the list text 
box. For our example, we will use these names:

Matt Innae
Kerry Oakey
Mario Speedwagon

Safe. T. Mann
Dewey DeScreens
Brock Lee

Buck Kinnear
Liv Dewaits
Paul Molive

Deselect the text box by clicking anywhere outside of it, or by pressing 
the ~ key. The results are shown in (Figure 3-115).

PUBLISHING FROM A MESSAGE TEMPLATE
Anytime you attempt to Publish or 
Save a message that was created 
using a template, you will be 
prompted to save a copy of it (See 
page 118 for more information on 
saving and publishing messages).

Right-click on the tab and choose Publish (Figure 3-116).

Figure 3-113. 

Figure 3-114. 

Hint:

Unpin the 
content resource 
window at 
the bottom of 
Design Studio to 
see more of the message. 
(See page 75 for more 
on un-pinning windows).

Figure 3-115. 

Figure 3-116. 
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 Messages with Scrolling Text� Publishing from a Message Template

Saving a Message from a Template
When you choose Publish 
from the tab menu as shown in 
(Figure 3-116) on page 121, 
you are prompted to save your 
new message. When you click 
the Yes button at the prompt as 

shown in (Figure 3-117), you will be presented with the 
Save As dialog box (Figure 3-118). You must give your new 
message a name and save it in your facility's message folder.

Follow these steps to save your new message:

1.	 Navigate to your facility folder.  When the Save As 
dialog box appears, your default save-location will be 
the Community Property folder. DO NOT SAVE YOUR 
MESSAGES IN THIS FOLDER.

•	 Open the drop-down menu and choose Messages 
(Figure 3-119).

•	 Find your facility folder in the folder list and double-
click to open it (Figure 3-120).

2.	 Choose a name for the new message.  Type in a 
name for the new message into the Name box. For our 
example, we will name it birthdays_november.

3.	 Click the Save button  as shown in (Figure 3-121), or 
press the " key, to save the message.

CAUTION:  Do not save your messages to the Community 
Property folder. Always save to your own facility folder.

The new message will be saved in your facility folder. 
To play the message on your eScreens, navigate to 

your facility folder in the messages resource tab and use 
the steps listed on page 92 to add it to a Play Category.

Figure 3-117. 

Figure 3-118. 

Figure 3-119. 

Figure 3-120. 

Figure 3-121. 
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Previewing a Message�  Messages with Scrolling Text

PREVIEWING A 
MESSAGE
While you are editing a message, 
Design Studio does a pretty 
good job of displaying what it 
will look like. However, to see 
the animated scrolling of the text, 
you must preview the message.

Follow these steps to preview a message:

1.	 Right-click on the title tab of 
the message you would like to 
preview.  This will display the tab menu 
for that message.

2.	 Choose Preview from the menu.  The 
Preview window will appear. Once 
the content has loaded, it will display 
an animated preview of exactly what 
the message will look like when it is 
played on the eScreens as shown in 
(Figure 3-123).

You c an  a l so 
p r e v i e w  t h e 
message f rom 
within the Messages content resource 
tab. Simply right-click on the message 
and choose Preview as shown in 
(Figure 3-124).

Figure 3-123.  The Message Preview window in Design Studio

Figure 3-124. 

Note:

Depending on your 
connection, the preview 
could take a while to 
load for the first time.

Figure 3-122. 
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WORKING WITH SOUND FILES
A sound resource (hereinafter audio) is imported, stored and 
organized just like graphic and video items. 

•	 For a list of sound file types that can be added to Design Studio, 
see "Sound Resources" on page 79.

•	 For information on how to add sound files to Design Studio, see 
"Importing and Organizing Content" on page 83.

eScreen Audio Capabilities
The eScreens at your facility are capable of playing audio if they have 
speakers built-in or attached.

Most eScreens at your facility will be LCD televisions with built-
in speakers. However, some eScreens were custom-built by the 
manufacturer (Symon), which included speakers when purchased. 
Whether these speakers were attached at the time of installation is 
a question for your facility's management or I.T. department.

Hint:  If more than half of the eScreens do not have this capability, 
you may want to avoid using audio messages.

ANATOMY OF AN AUDIO MESSAGE
Unlike graphic and video items, audio cannot be added directly to a 
Play Category. Audio can only be played by a message. When audio 
is added to a message, it is known as an audio message. The audio 
message is added to the Background Audio category to be played.

The types of messages we've encountered so far have been comprised 
of text and graphic elements. However, an audio message does not 
need any visual elements, as they would not be seen anyway. The 
audio message plays unseen in the background of the eScreens 
while the other visual content plays in their respective layout areas.

3.11	 Messages with Audio
Design Studio is capable of creating messages that contain audio. 
When placed in the Background Audio Play Category, the audio 
message will play through the speakers on your facility's eScreens.
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CREATING AND 
PLAYING AN AUDIO 
MESSAGE
You must create an audio 
message for each piece of audio 
you wish to play on the eScreens.

When more than one audio 
message is added to the 
Background Audio category, 
they play in succession, and will 
repeat when they are done.

Follow these steps to create 
and play an audio message:

1.	 Open the Messages tab and create a new message.  Inside 
your facility folder in the Messages tab, right-click in any 
blank area and choose New, then Message from the menu 
(Figure 3-126). Give the new message a descriptive name.

2.	 Open the empty message.  Double-click the new message to 
open it in the work area. You will notice the message is empty.

3.	 Drag an audio resource into the new message.  In the 
Sounds tab, navigate to your facility folder to find the audio item 
you wish to play. Drag the audio item into the open message 
[Item 2 in (Figure 3-125)].

4.	 Select the Wait for End of Audio check box.   In the Properties 
window, click the check box next to Wait for End of Audio as 
shown in (Figure 3-127). This ensures the eScreen will not 
move onto the next item in the Background Audio category 
before this one is done playing.

5.	 Save and publish the message.  Right-click on the title tab and 
choose Publish from the menu. You will then also be prompted 
to save the message.

6.	Add the message to the Background Audio category.  Open 

Figure 3-125.  How to play audio 
on the eScreens using messages

Figure 3-126. 

Figure 3-127. 

(Background Audio)
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 Messages with Audio� The Background Audio Category

the Background Audio category located in your facility folder 
in the Categories tab [Item 3 in (Figure 3-125)]. Drag the new 
audio message into the open category.

7.	 Save and publish the Background Audio category.  Right-
click on the title tab and choose Publish from the menu. You 
will also be prompted to save the category.

Hint:  Remember to publish the audio message and the 
Background Audio category for the audio to play. See pages 
93 and 118 for more on publishing categories and messages.

In following the above steps, you have effectively created 
and scheduled a message.

THE BACKGROUND AUDIO CATEGORY
The Background Audio category can be treated like any other Play 
Category, and can contain multiple items with differing schedules. 
The only difference is the workforce will not see the scheduled items 
on the eScreens, but hear them.

Hint:  It goes without saying that the Background Audio 
category is for playing audio messages only. You will get no 
results — visual or otherwise — if you add graphic slides or other 
types of messages to the Background Audio category.

If there is more than one audio message scheduled inside the 
Background Audio category, they will play in succession and repeat 
when they are done.

Audio messages can be scheduled like regular messages and graphics.

•	 For information on how to play audio messages on the eScreens, 
see "Scheduling Content to Play" on page 90.

•	 For information on setting custom schedules for audio messages, 
see "Advance Scheduling Options" on page 94.

On Large Sound Files
When you schedule an audio 
message to play, the sound file 
is sent to all of your eScreens at 
once. If it is a large file, this could 
take several minutes.

The audio may not play right 
away, or may produce 'false starts' 
while it loads. This behavior is 
normal. However, you should try 
to keep your audio files as small 
as possible by compressing them.

.MP3 is a much smaller file format 
than .WAV, and you should use 
these files whenever possible.

Organizational tip:

There is no visual indicator 
in the Messages resource 
window as to whether a 
message contains audio. 
It is a good idea add the 
word 'audio' to the name 
of your audio messages.

You can also create a new 
folder to store your audio 
messages separately from 
your regular messages (see 

"Creating New Folders" on 
page 83 for more info).
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3.12	 Player Previews
Design Studio can show you what is playing on your facility's 
eScreens, through thumbnail previews and animated previews.

About Players
Like the other content resource 
tabs, your facility has its own folder 
located inside the Players tab. 
Navigate to your facility's folder 
to see the eScreens, or players, 
at your facility. See "Opening Your 
Facility Folder" on page 80.

SDAs, or Symon Digital Appliances, are represented as players in 
Design Studio. The players for your facility are grouped in your facility 
folder located in the Players tab as shown in (Figure 3-128).

In some cases, one player can power multiple eScreens. If your 
facility has multiple eScreens powered by the same player, you will 
only see one player in the Players tab. This one player represents 
all eScreens at your facility.

THUMBNAIL PREVIEWS
Design Studio allows you to see what is being displayed on your 
facility's eScreens at any given time via thumbnails in the Players tab.

Each live thumbnail represents a real-time snapshot taken of the 
an eScreen at the moment you opened the Players window 
(Figure 3-128). The thumbnails will continue to update, which could 
slow down Design Studio significantly until you close the Players tab.

Hint:  If you do not see thumbnail previews, change the folder 
view mode to small, medium, or large thumbnails (page 82).

If a thumbnail preview refuses to show after refreshing (Figure 3-129), 
it may indicate a connection error between eScreen and Design Studio. 
See "The eScreen is Not Responsive" on page 152 for more.

Figure 3-128.  A facility folder open in the Players tab

Figure 3-129. 
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ANIMATED PLAYER PREVIEWS
In addition to the static thumbnail previews, Design Studio also offers 
a fully-functional preview of each player at your facility, complete with 
animation, video, transition animations and sound.

Follow these steps to preview what will play on your eScreens:

1.	 Show the Players window.  Click once on the Players tab to 
show the Players window. If the Players tab is not visible, choose  
Players from the View menu.

2.	Navigate to your facility folder.  If necessary, find and open 
your facility folder in the Players window.

3.	Right-click on a player.  Decide which of your players you'd 
like to preview. Right-click on it to open the right-click menu.

4.	Choose Preview.   Click Preview in 
the menu as shown in (figure 3-130), 
or press the v key on your computer's 
keyboard. The animated preview will 
appear as shown in (Figure 3-131).

The Preview window displays the content 
exactly as it is scheduled 
to play on your facility's 
eScreens. However, it is 
not a real-time preview. 
This means what you see 
in the Preview window is 
not simultaneously displaying on the eScreens.

The preview may not display properly until all of the 
content has loaded. You may see white spaces and 
blank boxes, especially if it is the first time you are 
previewing a player. Wait a few minutes for all of the 
content to load into the preview.Figure 3-131. 

What am I 
looking for when I 
preview?

Watch the player preview 
to ensure content fidelity:

•	 Look for misspellings, 
grammatical and 
informational errors.

•	 Check for outdated 
content that should 
be removed.

•	 Ensure your content 
remains on-screen 
long enough to read 
comfortably.

•	 Make sure your 
transitions are not so 
busy as to distract 
viewers.

Figure 3-130. 
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VIEWING A USAGE REPORT
You can view an item's usage report (sometimes known as running 
a usage report) from two places within Design Studio:

•	 From within a content resource tab

•	 From within another usage report

To view the usage report for an item, right-click on the item and 
choose Usage Report from the menu as shown in (Figure 3-132). 
the Usage Report window will open in the work area.

ANATOMY OF A USAGE REPORT
There are two main areas that provide usage information, which can 
help with understanding where and how the item is used:

•	 'Contained By' •	 'Items Contained'

In the example shown in (Figure 1-133), a usage report was run 
for an audio message named SafeNation Audio Message. You 
can see from the usage report that the message plays an audio file 
named SafeNation Radio Clip. The report also shows that this audio 
message is playing on the eScreens at the Colonsay facility.

3.13	 Usage Reports
It may sometimes be helpful to see which items are being used, 
and which other items contain them. The Usage Report feature 
in Design Studio can give you this information.

Title Tab
The usage report opens alongside 
other windows in the work area.

Item Info
Contains information about 

the item for which the 
usage report was run.

'Contained By'
Shows all items that contain 

the item for which the 
usage report was run.

Container Item
Container items can be 

opened as they would from 
a content resource tab. 

'Items Contained'
Shows all items that are 
used by the item for which 
the usage report was run.

Contained Item
A contained item can be 
opened and previewed as 
they would from a content 
resource tab.

Figure 3-132.  Right-clicking to 
run a usage report for an item from 
within the Messages resource tab

Figure 3-133. Example usage report with parts of its window highlighted
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Usage Reports Are Always Up-to-Date
An opened usage report will always live-update. This means that any 
changes you make to an item's container, or the items it contains, 
will immediately show up in the Usage Report window.

Additionally, when an item is placed in a category, the item's usage 
report will always show that it is contained by that category, even if 
the item is not currently being displayed on the eScreens for any of 
the following reasons:

•	 The item's schedule has run out or not yet begun

•	 The item has no schedule

•	 The category containing the item has not been published

Changing the View in a Usage Report
Just like in the content resource tabs, you can change 
the way items are listed in a usage report. Right-click 
in any blank space inside the Contained By or Items 
Contained area, and choose View from the menu 
(Figure 3-134). Select a view that suits your needs.

WORKING INSIDE A USAGE REPORT
A usage report is not solely for obtaining information. You can work 
with the items inside a usage report in many of the same ways you 
would if you were viewing these same items in a content resource 
tab. These actions include:

•	 Renaming items

•	 Locating an item's original 
location

•	 Copying items

•	 Running other usage reports

One of the only notable actions you cannot perform on an item from 
within a usage report is Publish.

Figure 3-134. 
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Working Inside a Usage Report�  Usage Reports

Locating an Item's Original Location (Go To)
In the Usage Report, as well as other places inside Design Studio, you 
can use the Go To feature to find the storage location of any item.

Right-click on the item and choose Go to from the menu that appears. 
Design Studio will open the content resource tab and folder containing 
that item, and the item will automatically be selected. You can then 
proceed to work with the item in its original storage location.

The Go To feature is available for items in usage reports, categories, 
and anywhere the original locations of the items are not apparent.

Running a Usage Report in a Usage Report
You can follow the chain of usage for items by running a Usage Report 
on an item from within an opened Usage Report (Figure 3-136).

Figure 3-136.  Running a usage report on an item from within a usage report

You can use 'Go To' 
from anywhere!

Any item inside a Play Category

The title tab of any open window

Any item inside a usage report

Use-case scenario:
When you try to delete 
an item but that item is 
currently in a category, 
you will receive an error 
message (Figure 3-135). 
If you are unsure which category or categories the item is contained 
by, a usage report is a quick way to find out.

Figure 3-135. 





CHAPTER 
FOUR

Best Practices

eScreens are an important communication channel at Digix, 
and their success is directly related to the relevance and 
value of the messages that are displayed.

This reference guide provides eScreen administrators with a 
detailed look at how to understand, create, post and manage 
eScreen content. The last chapter, Best Pracitces, is just that. 
It compiles the key takeaways to ensure all eScreens comply 
with our corporate-wide standards while also supporting the 
goal of internal communications: to engage all employees 
in Digix’s mission, strategy and success—across functions, 
levels and geographies.

An important rule of thumb for eScreens: use common 
sense! If you’re not sure about something, don’t post it until 
you can touch base with a member of Public Affairs. 
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WHERE DO I GET INFORMATION TO POST?
When a member of your facility management comes to you with 
a request to post information on your facility's eScreens, they will 
provide the relevant information to you, or tell you where to find it.

Aside from that, you may want to independently seek relevant and 
helpful information to post on your facility's eScreens. Knowing 
what information will be beneficial to your workforce — and what  
information will not — will help tremendously.

Event Calendars
As an administrator, you may keep (or have access to) a facility-wide 
event calendar that shows trainings, meetings, and other important 
events. These dates may be beneficial to your workforce, and is a 
good example of what could be displayed on your facility's eScreens.

It is a good idea to use a small template for a reminder such as an 
event date, and to post it in the upper right area. See "Using the 
Small Templates" on page 61 for more information.

Employee Recognition Committee
If your facility has an employee recognition program, stay in touch with 
a committee member who can give you the name(s) and photo(s) 
of employees for recognition on the eScreens each month.

Employee Birthdays
If your facility management wishes to display employee birthdays 
on your eScreens, please be sure that you always have a current, 
complete list from your Human Resources department. Be careful not 
to skip a monthly update so that employees do not feel left out. It is 
best practice to update the list consistently and in a timely manner.

Employee birthday lists are considered "nice to know" versus "need 

4.1	 What to Say and How to Say It
Whether you are copying body text from another source, or 
composing it from scratch, these best practices help ensure your 
slides and text tickers are concise, informative and easy to read.
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to know", so please avoid using the main area for this. It is a good 
idea to use a scrolling message template for long lists, and to post it 
in the upper right area. For instructions on making a scrolling birthday 
list, see "Creating a Message with Scrolling Text" on page 119.

You may also wish to list employee birthdays in your text ticker area. 
See "Your Local Facility Ticker" on page 115 for more information.

Local News and Advisories
One of the benefits of the eScreens is their ability to disseminate local 
information to the workforce. As an eScreen administrator, you are 
relied upon for this, as local news and advisories are not automatically 
fed to your facility's eScreens.

If your local government has a news site or emergency messaging 
system, subscribe to it. If there is a local emergency, road closure, or 
other event that could affect the workforce, you can get the relevant 
information to them via the eScreens.

Safety Reminders and Tips
Your Safety department can point you to some great free, reputable 
online sources for safety tips and imagery. Be sure the website states 
that its material can be reproduced freely before displaying it on the 
eScreens. It is also good practice to cite the source.

It is a good idea to use a small template for reminders such as safety 
tips, and to post them in the upper right area. See "Using the Small 
Templates" on page 61 for more information.

Reach Out to Department Managers
The Environmental Health & Safety (EH&S) department may want to 
post a weekly energy-saving tip, or the Maintenance department might 
like to post stability improvement charts. Your Safety department may 
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have a list of incidents and injuries common to your facility, and some 
great advice for preventing them.

Connect with the various departments at your local facility so that 
department managers become your content providers. Show them 
the benefits of communicating via eScreens.

Facility-Wide E-Mail
Generally, when a person or department sends out an announcement 
or memo via facility-wide e-mail, you should see it as an opportunity 
to inform members of the workforce who have limited or no access to 
e-mail. Facility-wide e-mail is your greatest source for eScreen material.

WHEN NOT TO POST
As discussed in "eScreen Channel Strategy" on page 3, knowing 
when not to post information is equally as important as knowing 
when and what to post. Asking yourself a few questions can help to 
determine if a given message should even be posted at all.

Who Is My Audience?
Sometimes the eScreens are not the best communication channel. Ask 
yourself if your audience would be better served by communicating 
the message using e-mail, bulletin boards and/or meetings.

Have We Already Communicated This Message?
In general, duplicate information can be considered a nuisance and 
may cause viewers to become discontented with the information 
being displayed on the eScreens.

Would Anyone Even Miss It?
By asking yourself what would happen if you didn’t post a message, 
you may just find it is not important enough to be posted.
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Should Someone Else Be Posting This 
Information Instead?
When you receive an e-mail that was sent to the entire Digix 
organization, you should generally not create slides for that information. 

If the message is important and relevant, then the Public Affairs team 
may already be creating the appropriate slides, which will display 
automatically on all eScreens.

COMPOSING AND EDITING TEXT
Whether you are composing text from scratch, or copying it from 
another source, always edit for brevity and be sure to proofread the 
results before posting.

Text on a slide should always be as short and concise as possible 
while giving the viewer valuable information. Text should read like 
a short snippet or headline, and not like an article. The text should:

•	 Be large enough to read from long distances

•	 Be easily digestible at a glance

•	 Convey only one topic or idea at a time

If the text is too lengthy to be condensed effectively, consider rewriting.

How to Extract Information from E-Mails
When you receive information or announcements via company 
e-mails, sometimes you can extract the entire text from the e-mail. 
Be careful, however, not to copy the greeting and closing lines, and 
delete any unnecessary spaces before and after the text.

If the e-mail text is too long to fit comfortably on a slide, determine the 
most relevant facts and rewrite it. Also, be sure to properly timestamp 
your text (page 139).
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Paring Down Long Text
When paring down the text, be sure to keep relevant facts and do not 
include repeat information. Make sure the final text reads correctly 
and properly conveys the meaning of the original text.

Bad Form Good Form
Digix mining returned 
to the Manatee County 
Planning Commission 
Thursday with a request 
for multiple changes 
in their previously-
approved Wingate Mine 
Extension Plan. The 
request represents a 
significant change from 
last June, when the 
county approved their 
"Operational Permit." 

Digix took its Wingate 
Mine Extension Plan back 
to the Manatee County 
Planning Commission 
with significant changes 
from last June when it 
was approved.

Avoid Using 'Filler Words' and Phrases
Always use concise statements when composing or editing a message 
for your eScreens, and avoid using redundant phrases. Consider 
changing these phrases:

Change This:
close proximity
each and every
free gift
in the event

To This:
proximity
each
gift
if

Change This:
refer back
"or" / "and/or"
the following
such as

To This:
refer
/
these
like

When composing or editing text for your messages, be on the lookout 
for fancy phrases that add nothing to the meaning of a sentence. All 
they do is take up space, and they should be removed. 

Can I use 
abbreviations to 
shorten my text?

It is acceptable to use 
abbreviations familiar 
to our industry that the 
majority of the workforce 
will understand, like PPE.

However, you should not 
abbreviate words for the 
sake of brevity. Consider 
rewriting instead.
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You can usually omit the following phrases from the text:

•	 all things considered

•	 as a matter of fact

•	 at the present time

•	 because of the fact that

•	 by means of

•	 by virtue of the fact that

•	 for all intents and purposes

•	 for the most part

•	 for the purpose of

•	 in a manner of speaking

•	 in the case of

•	 in the event that

•	 we would like to

•	 we are pleased to

Also, words like really, very, quite, extremely, should be used sparingly 
for best effect.

Bad Form Good Form
If you have any questions 
or concerns, feel free to 
call extension 4528. 

Call extension 4528 with 
questions/concerns.

Properly Time-Stamp Your Text
If the information you are using to create a message included specific 
dates, (yesterday, tomorrow, last thursday, Friday the thirteenth, etc.) 
you should consider the time frame during which the information will 
be displayed, and remove or revise these dates accordingly.

Bad Form Good Form
Thanks to Richard 
Kennedy for spending 
the past few days 
troubleshooting 
numerous faults in the 
ATEX explosion system.

Thanks to Richard 
Kennedy for 
troubleshooting numerous 
faults in the ATEX 
explosion system.

The revised text would now make sense even if shown a week after 
the event took place.

Tip: Edit the text 
on the slide

Instead of using a word 
processing program 
like Microsoft® Word 
to edit your text, paste 
the text into the slide 
and edit it there.

You will be able to see the 
final product, and decide 
which words or phrases 
can be removed to achieve 
the desired visual result.
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WORKING WITH CONTENT PROVIDERS
A content provider is a person, committee or department that has 
something to say, and will provide you with content to post to the 
eScreens. As an eScreen administrator, you help others to get their 
messages out using the communicating power of the eScreens.

Who Is Allowed to Make Requests 
to Post Information?
This question will be best answered by your local facility management. 
However, to keep things organized, avoid confusion, and discourage 
misapplication, perhaps it is a good idea to only allow department 
managers to send information to you for posting.

Non-management employees wishing to post information on the 
screens may make the request through their manager or have 
their manager's approval attached. Otherwise, you should obtain 
approval on their behalf from the facility manager, Human Resources 
department, or other relevant manager. If you already have a system 
in place for this type of approval, then you should take that route.

If You Receive Unsuitable Information
It is important to reach out to content providers ahead of time so 
that they understand the communicating power of the eScreens, as 
well as the guidelines and limitations of the eScreens. If a person or 
department has spent considerable time composing a long message 
intended for the eScreen, it may be difficult for them to understand 
why their hard work has to be edited and shortened.

If you receive a request to post information that is much too long, too 
confusing, or otherwise unsuitable for the eScreens, you must come 
to a healthy compromise in order to accommodate their needs. You 
can either take on the task of editing their content yourself using the 
tips listed on page 138, or you can request that the they shorten 
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the text or modify the content themselves and resubmit. Politely 
explain that we are aiming only for one topic per slide.

Posting PowerPoint Slides
Sometimes you will encounter a content provider who sends you a 
PowerPoint slide that they would like posted. In rare occasions, it is 
acceptable to post these if:

•	 The text on the slide is large and readable at a glance

•	 The slide is neat, professional and uncluttered

•	 The slide is from an official Digix presentation

If the slide and its text conforms to our standards of readability as put 
forth in "Composing and Editing Text" on page 137, it is generally 
okay to post on the eScreens.

Most times, however, a typical PowerPoint slide will not be suitable. 
Consider asking the content provider to edit the slide for brevity, or 
you can re-make the slide from scratch using an eScreen template.

Allowing Others to Use eScreen Templates
The eScreen templates are available on the employee website for 
everyone to use. Content providers may choose to use the templates 
to create eScreen slides, and then send them to you to post.

Although the templates are very easy to use and contain clear 
instructions, you must check the slides when you receive them. 
Make sure they conform to the standards set forth in this chapter. 

It is important to note that the templates which use the "Formata" 
font should not be used by others, as this font will not be available 
on their computers, producing unpredictable results and visually 
unappealing slides.
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Place Emphasis on Important Information
In the interest of readability, place important information — phone 
numbers, e-mail addresses, times, dates, etc. — each on its own line. 

This calls attention to them and makes the whole text easier to read. 
You may also consider making these items bold so users will get 
important information in a single glance.

Bad Form Good Form

Similarly, do not allow important information — phone numbers, e-mail 
addresses, times, dates, etc. — to become separated on two lines. If 
an e-mail address or phone number is too large to fit on one line, 
make it slightly smaller than the rest of the text.

Bad Form Good Form

For more information on placing text on its own line, see "Inserting 
Forced Line Breaks in a Text Box" on page 33.

4.2	Recommended Slide Conventions
eScreen templates are a great way to begin a slide. However, 
where possible, you should always tidy up the appearance of the 
information to ensure the slide is pleasing, uncluttered and easy 
to read. These best practices can help.
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Center the Text On a Slide for Best Results
Because the text on your slides should read like a short snippet or 
headline, centering the text makes it easier to read in most cases. For 
more information, see "Centering Text in a Text Box" on page 33.

Post Only One Slide Per Topic
It is important to our brand image that the information we post be 
easily digestible to the average viewer. One way we all work toward 
this goal is by posting only one slide per topic.

It may be tempting to think that you need more than one slide to 
convey your message. However, a short, well-written message can 
be infinitely more effective than a long message spanning five slides.

Using the tips found on page 138, try removing all filler words and 
phrases, keep only the most important facts, and rewrite the text if 
necessary to ensure your message will fit comfortably on one slide.

Light Customizations
You are free use traditional PowerPoint tools (including Style Presets) 
to apply the following light text customizations if you feel it will benefit 
the look and feel of your slide:

•	 Text color

•	 Font size

•	 Text box size/shape

•	 Photo borders

•	 Text box borders

You are not allowed to do the following to items on a slide:

•	 Change the font to anything other than Formata or Arial

•	 Excessively distort photos or text boxes

•	 Use distracting colors or effects, or any color that does not 
visually compliment the other elements on the slide

•	 Cover body text with photos or other text
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Recommended Slide Conventions� Do Not Use Clip Art

Bad Form Good Form

If you are in doubt about a particular customization, best practice 
dictates that you should keep it as simple as possible.

Do Not Use Clip Art
Microsoft® Office® includes a 
gallery of clip art for use in Word 
and PowerPoint. However, these 
have a tendency to be trite and 
unprofessional. Do not use the 
cartoon-like images found in 
these galleries, or from other clip 
art sites you may find online.

On the Use of Stock 
Photography
If necessary, use a tasteful and 
relevant stock image — preferably 
with a transparent background.

These are available for a small fee 
from stock photography websites 
like www.shutterstock.com and 
www.gettyimages.com. When 
searching, be sure to select 
Photos and not Illustrations.

Good Form

Bad Form
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Do Not Use Clip Art� Recommended Slide Conventions

On the Use of Digix Images
When you need an image representing Digix or our industry, the Public 
Affairs department may have a suitable option. Before purchaseing 
stock images of fields, crops, industrial machinery, community 
outreach, etc., send an email to public.affairs@digixco.com to see if 
they can help.

On the Use of Other Companies' Material
Most companies have trademarks and copyrights on their logos and 
marketing materials. As such, you should not use images, logos, or 
other content that has originated from companies outside of Digix 
without express written permission.

Not Allowed

Allowed

Some companies may have a procedure to request the use of their 
material. Generally, you should allow Public Affairs to handle this. If 
you are in doubt, e-mail public.affairs@digixco.com.
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Recommended Slide Conventions� Use varying Template Styles/Colors

Use Varying Template 
Styles and Colors
If all of your slides look the same 
regardless of topic, then viewers 
may not be able to distinguish 
between types of information, 
or new content from old. Using 
a variety of templates keeps 
your messages — and your 
eScreens — fresh and interesting.

Instead of beginning every slide with the same template, change it 
up a bit. Each template file contains several colors, styles and topics 
to choose from. Click the small arrow beneath the New Slide button 
to see the options for each template.

Group Similar Slides by Color and Style
In contrast to the above suggestion to vary your slide colors, in 
some cases it may be helpful to use the same template for recurring 
information or messages. For example, if you post weekly safety 
statistics, then you should use the same template each week. This 
way viewers will know at a glance which information is being shown.
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Add Your Own Content to Community Property
It is a good idea to add content that you've created into any Community 
Property folder when you feel it would benefit other users. Always 
place a copy of the content, and keep the original in your facility folder.

Use Descriptive File Names
When adding items to any Community Property folder, be sure to 
give it a helpful, descriptive name so that other users can identify it.

Bad Form Good Form
slide1.png
s_pol.png

parking_lot_safety.png
safety_policy.png

You can rename the content items inside Design Studio if necessary. 
For more information, see "Renaming Content" on page 89

Do Not Copy Content from a Community Property 
Folder into Your Facility Folder
Instead, add the content directly from the Community Property folder 
into your Play Category. This ensures that if the content is updated, the 
slides being displayed at your facility will also be updated automatically.

Never Delete Items from a  
Community Property Folder
Other users may be displaying content from the Community Property 
folders on their screens as well. Deleting a slide or a video can disrupt 
another user's play schedules.

4.3	Community Property Best Practices
Like any submission-driven resource, the idea of the Community 
Property folders inside of Design Studio can only thrive if we 
respect the shared content as well as contribute our own.
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When in Doubt, Right-Click!
The right-click menu is context-sensitive, so you will get a different list 
of commands depending on the item upon which you right-clicked. 
The most common commands and tasks normally found in menus 
and tool bars are also found in the right-click menu. You may just 
discover a new shortcut that can save time and boost your productivity! 

FOLDERS AND CONTENT
We all share the Design Studio program, and as such, we all must 
respect others' content and folders.

Work Only Inside Your Facility's Folder
Be careful when you are adding content resources to Design Studio. Be 
sure you are only working in your facility's folder. For more information 
on opening your facility's folders, see page 80.

Do not use slides from other facilities on your screens; you can use 
Community Property for this instead.

Only Create Folders Inside Your Facility Folder
You may find it helpful to create folders to organize your content. 
However, do not create folders in any facility folder but your own, 
and do not create folders in a main content resource folder.

Bad Form Good Form

4.4	Design Studio Best Practices
These tips and best practices will help ensure your work inside 
Design Studio is productive and efficient.
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Folders and Content� Design Studio Best Practices

Tip: Updating/
Overwriting Content
If you import an item into a folder 
that already has an item with the 
same name, you are given the 
option to update the existing slide. 
If you choose Yes, the existing 
slide will be overwritten by the 
new slide. If the existing slide is being displayed on the eScreens, the 
eScreens will automatically display the updated slide. 

This is useful if you post information that changes daily. Simply give 
your slide the same name each day, import it into Design Studio, and 
the eScreens will play the new slide in place of the old one, without 
having to schedule it again!

AUDIO AND VIDEO

Do Not Play Videos and Background Audio 
Simultaneously
If background audio is playing on your facility's eScreens, do not also 
schedule videos in other areas. The audio from a video will interfere 
with the background audio for a confusing and unpleasant result.

Audio Message Preview Tip
When you schedule an audio message to play, the sound file is sent 
to all of your eScreens at once. If it is a large file, this could take 
several minutes, during which time the audio may not play, or may 
produce 'false starts' until it loads completely.

Use the Preview command from either the audio message's title 
tab, or on the audio message itself.
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Design Studio Best Practices� Scheduling Best Practices

On Audio Message On Title Tab

When previewing, the sound file is sent from the server to your 
computer as though it were an eScreen, giving you an estimate of 
how long it will take for the audio to play properly on the eScreens.

SCHEDULING BEST PRACTICES

Timeouts: The Longer the Better
It is important that your slides' play duration (Timeout) settings are 
long enough for comfortable reading. Slides with less information 
require shorter Timeout. The default Timeout is ten seconds for all 
new slides, but you can increase the default Timeout by following the 
steps on page 112. Note that this will only change the setting for 
new slides added to a Play Category; existing slides are not affected.

Avoid Distracting Transitions
It is not in alignment with our brand to use showy animated transitions 
with too much movement. Do not use these. Simple 2D Transitions 
work best for our purposes. If you are in doubt, only use the following:

•	 Crossfade

•	 Fade Out then In

•	 Wipes from Left/Right

•	 Cube Horizontal/Vertical Flip

Do not use the Cinematic transitions.
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Miscellaneous Information� Design Studio Best Practices

MISCELLANEOUS INFORMATION

Your Communications Are Subject to Approval
Digix Public Affairs is responsible for the eScreens and all content 
displayed thereon. However, Digix Public Affairs knows the value of 
a "local look and feel." We feel that your workforce benefits from 
these local communications created and managed at the facility-level.

From time to time, Digix Public Affairs may monitor or search the 
content being displayed on your eScreens or stored in your local 
facility folder to ensure it is in-line with our branding and content 
guidelines.

If any communication is found to directly violate any of these 
guidelines, it may be edited or removed without notice. For more 
information, see "eScreen Content Guidelines" on page 6.

If you have any questions regarding guidelines, or if you would like 
approval for information that you are uncertain about, please contact 
Public Affairs before posting.

Use the 'Advanced' Docking Panes Layout
Use the steps listed in the exercise on page 72 to load the 
Advanced Docking Pane Layout in the Design Studio program 
window.

It is highly recommended that you use the Advanced Docking 
Pane Layout. If all of our Design Studio program windows look and 
function the same way, future training and troubleshooting will be 
made easier and more efficient.

Digix's Public 
Affairs department

E-Mail: 
public.affairs@digixco.com
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Always Physically View the eScreens
Although Design Studio offers a couple of helpful preview options, 
there is no substitute for physically previewing your eScreens.

This way, you can pinpoint issues such as slide timing, audio conflicts, 
and general readability, and adjust your content accordingly. If you 
encounter an unresponsive eScreen, begin an incident ticket using 
MyServiceDesk, located on the employee website.

I Can See a Preview In Design Studio, But There Is 
Nothing on the eScreen
Just like any LCD television set, most eScreen monitors have an input 
button that cycles through the various input connections. This button 
is typically found on the bottom or side of the screen.

Make sure the eScreen is plugged-in and powered on, and press 
the button to cycle through the inputs until you see content being 
displayed on the screen. This input is typically HDMI-1.

The eScreen Is Not Responsive
If you do not see a thumbnail preview in the Design Studio Players 
tab, try right-clicking on the player and choosing Update Thumbnail.

If the player remains unresponsive, begin an incident 
ticket using MyServiceDesk, located on the employee 
website.

My Facility Would Like an 
Additional eScreen
To request an additional eScreen for your facility, begin 
an incident ticket using MyServiceDesk located on the 
employee website. Indicate the facility and location of 
the requested eScreen.

4.5	Troubleshooting and Support
These tips can help resolve minor issues with the eScreens, 
templates, and Design Studio. However, technical issues should 
be reported to the Global Help Desk.

Digix's Public 
Affairs department

E-Mail: 
public.affairs@digixco.com

Digix's Global Service Desk

E-Mail: 
global.servicedesk@digixco.com

Website: 
http://myservicedesk.digixco.com

Phone: 
1 (866) 256-9750
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Template Font Issues� Troubleshooting and Support

I Have an Issue with Managing or 
Displaying Content
Digix Public Affairs is responsible for all content displayed on the 
eScreens. Contact the Public Affairs department with content-related 
questions and issues, at public.affairs@digixco.com.

Why Can't I Delete an Item in Design Studio?
There are a couple of criteria for deleting items and folders:

•	 You may only delete folders and items that you have created 
and imported into Design Studio.

•	 Folders can only be deleted if they are empty or their contents 
are not being used by a Play Category or a message.

If you are unable to delete a folder or item, run a Usage Report to 
determine if the item is being used and where. Delete the item from 
the Play Category or message containing it and try to delete it again. 
See "Usage Reports" on page 129.

The Template I Have Chosen Does Not Look Right
If the Formata font is not installed properly, some templates will 
appear to be corrupt or display an unattractive font in its place.

Formata Not Installed Formata Installed

Never post a slide in this condition. Change the affected text to Arial, 
or use a different template until the official Formata font is installed on 
your computer. See "Getting the Formata Font Files" on page 13.
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A
add, 93, 124

see also import
additional, request eScreen, 152
adjust, 101
Advanced Docking Pane layout, 

67, 151
appear, 49, 84, 99
approval, 140, 151
arcs, 11

see also branding
area, 5, 15 to 16, 84, 90, 135

eScreen layout areas, 5, 151, 
66 to 67
choosing, 66 to 67

storage, 78 to 79
text ticker, 115
tool bar, 35

Arial
see fonts

arrange, 49
see also z-order

arrow, 21, 91
attached speakers, 113, 124
attachment, e-mail, 36
audience, 136
audio

background audio, 124 to 126, 
149

capability, 113

message, 125
preview with, 129, 149
working with sound files, 124

automatic content, 111
avoid, 111, 138

see also best practices

B
back

see send to back
background

add color to text box, 56
making translucent, 57

background audio, 124 to 126, 
149

badge, 8
see also automatic content

bar, 47, 71, 73
see also tool bar

before, 93, 118, 137
see also keep with next

begin, 97, 100, 152
behind, 48 to 50

see also z-order
beneficial, 134
best practices, 133 to 153
birthday, 6, 109, 121, 134

see also scrolling text
black, 47, 57
blank, 18

see also templates

body, 33, 63
see also text

bold, 35
see also formatting

border, 76
see also outline

box
see text box

brand guidelines, 10 to 11
branding, 10 to 12
breaks, 33

see also forced line breaks
bring to front, 49, 51
built-in speakers, 113, 124
button, 21, 27, 71, 75, 81, 84, 152

C
canvas, 49
capability, audio, 113, 125 to 126
caption, 35, 52
category, 66, 124, 130 to 131

anatomy of, 90 to 91
Background Audio, 125 to 126
deleting an item from, 91
main area, 5, 23, 90
play item properties, 110 to 112
play order, 91

keep with next, 111
run usage report on, 129 to 131
scheduling within, 92, 94

APPENDIX A
Index
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folders, 83
objects on a slide, 52 to 54
play time, 96, 102 to 104

crop tool, 47
current, 27, 77

see also fresh content
custom, 95, 106

D
daily, 97

see also recurrence pattern
date, 97 to 98, 102, 105, 109, 

139, 142
see also play time

day, 109
see also recurrence pattern

default, 57, 103, 112, 150
delete, 89, 91, 101, 153
department, 135 to 136, 140
deselect, 117
Design Studio, 4, 8, 66 to 72, 75, 

85 to 86, 90
best practice, 131, 148, 

151 to 152
folder list, 81
importing content, 83 to 86
launching, 68 to 70
message, 67, 91, 99, 129
tool bars, 71
user interface, 71 to 72

saving current layout, 77
see also windows

usage report, 127
see also folders

desktop, 68
dialog box, 

Insert Picture, 43, 54
Open, 84

sharing, 114, 147
playing content from, 114,147

company, 1, 145
composing text, 31, 137 to 138
computer, 4, 68 to 69
contain, 22, 112, 130
content, 4, 15, 37 to 38, 66 to 67, 

80 to 84, 111, 113 to 114, 128, 
130, 140 to 141, 147 to 149, 
151 to 153
automatic, 8
deleting, 89

replacing, 89, 149
guidelines, 6 to 9
importing, 83 to 86
keeping fresh, 146
organizing, 78
pasting, 88
playing, 90

scheduling, 92, 94
renaming, 89
resource, 78 to 80, 82, 89, 

113 to 114, 130
selecting multiple, 87, 106

content providers, 140 to 141
content resource tabs, 78 to 83

importing content, 83 to 86
copying content within, 89
moving content within, 51, 88

control handles, 44
copy and paste, 61 to 62, 107, 

114, 147
corporate video repository, 114
Crawl Rate, 117

see also ticker
create, 12, 48, 79, 83, 95, 106, 

148
audio message, 125

selecting multiple items within, 
106

text ticker area, 115
upper tight area, 16 to 17

centering text, 143
see also formatting

change
folder views, 82
line weights, 58
photo, 42
properties

see Properties window
text color, 55
text size, 54
z-order, 50 to 52
see also publish
see also save

Change Picture tool, 42
channel strategy, 3, 136
check  box

Auto Login, 70
Remember Password, 70
Always Scheduled, 95

choose, 11, 15, 30, 57, 105, 112, 
118

click, 21, 50, 70, 75, 87, 106
see also right-click

clip, 144
see also video

close, 75 to 76
collage, photo, 40, 49
color, 10, 21, 55 to 57, 116

variety, 146
see also palette

commands, common, 148
committee, 134

see also content providers
community property, 8, 114, 119
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importing from, 85
folder list

Insert Picture dialog box, 
42 to 43

Open dialog box, 84
Save As dialog box, 27
Design Studio folder list, 81

resizing, 81
see also folder views

storage, 66
facility folder, 80
navigating, 81

folder views, 82
fonts, 11, 116, 141
Arial, 11, 13, 153
Formata, 11, 13, 153
forced line break, 33, 35
Formata

see fonts
format

file format, 27
photos, 38
text boxes, 54
text on a slide, 30 to 32

keeping formatting after 
pasting, 63

presets
photo, 39
text, 59
text box, 59

fresh content, 146
front, bring to, 49, 51
future, 102

see also play time

G
goal

communication, 2

exercises
employee of the month, 

30 to 39
photo collage, 40 to 60
small template, 61 to 63
weather advisory, 23 to 26

play time adjustment, 100
scheduling examples, 

108 to 109
template styles, 17 to 20

export, 21, 27
extracting information from 

e-mails, 137

F
facility, 66, 69, 80, 83, 87, 113, 

115, 122, 124, 127 to 128, 
134 to 136, 140, 147 to 148, 
152

features, 66, 131
file

basic management, 14
File menu, 27, 93, 118
file types

JPEG vs. PNG, 29
importable file types, 78 to 79
Save As dialog box, 27 to 28
see also import

large sound files, 129
overwriting, 149
template files, 14, 21

folder, 
content resource, 78 to 83

copying content within, 89
moving content within, 88

community property, 114
best practice, 147 to 148

creating new, 83

Options, 112
Play Time, 96 to 97, 101
Save As, 27 to 28, 29

different, 40
digital communication, 1
display, 5, 23, 25, 66 to 67, 104
docking panes, 71 to 72

saving, 77, 151
recalling, 77, 110, 151

document, 28, 62
dotted line, 25
down, 87, 106, 138
drag-and-drop, 100, 102, 107
drive, 14, 109
drop-down menu, 117
duplicate a slide, 41
duration

see timeout

E
edge, 71, 75
edit

edit text, 137 to 139
edit play time, 101

elements, 10, 71 to 72, 124
see also object, slide layout

e-mail, 61 to 62, 136, 142
how to extract information from, 

30 to 31, 137
saving photo from, 36 to 37

employees, 1, 6, 13, 34 to 35, 
134, 134, 152

eScreen, 3 to 8, 7 to 9, 12 to 13, 
15 52, 65 to 67, 69, 79, 90, 93, 
113, 115, 118, 124, 126 to 128, 
134 to 136

event, 134
example
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folder list, 81
new slide list, 21
slide list, 24

lists, 135
local facility ticker, 5, 115
local news, 135
location

current save location, 27
original location, 131

login, 69 to 70
logos

Digix, 10
other companies, 145

long text
best practice, 140, 150

lower right area, 5

M
main area, 5, 23, 90
management, facility, 134, 140
manipulate

photos, 43
z-order, 49

material, 145
menu, 

Start menu, 71
View menu, 75
right-click menu, 84, 93, 101, 

105, 148
File menu, 118

message
text on a slide, 15, 22 to 23, 36, 

61
working with text, 30 to 31

best practice, 135 to 136, 
143, 149

formatting text, 32 to 35
in Design Studio, 67, 91, 99, 129

play item, 90
deleting, 91
scheduling, 92, 94
selecting multiple, 106
copying and pasting playtimes 

to and from, 107
properties, 110 to 112

J
JPEG, 29

K
keep with next, 111

L
large templates, 15, 126
launching Design Studio, 

68 to 70
layout, 40 to 41

eScreen layout areas, 5, 
66 to 67, 115, 151

Design Studio user interface, 
71 to 72
saving current layout, 77

layout object, 22 to 23, 31, 61
manipulating, 48 to 49
selecting multiple, 51 to 52

slide layout examples, 17 to 20
light customization, 55, 143
line, 

outline, 57 to 58
line breaks, forced, 33 to 34
line weight, 57

changing, 58
list

best practice, 134 to 135
birthday list, 121
file type list, 27

good practice, 134 to 135
see also best practice

Goto, 105
graphic

resource window, 78
importing, 83 to 87
scheduling, 112

grid, playtime, 103 to 105
guidelines, 10 to 11, 151

H
handle

control handles, 44
tool bar, 73

hour, 97
grid settings, 103

I
important information, 2, 50, 

134, 136, 142 to 143
import, 78, 149

importing content, 83 to 86
input button, 152
insert, 37, 52, 54
inside, 67, 130, 148
installed, 68 to 69, 153
interval, 103 to 104

see also recurrence pattern
invoke, 97 to 98
issues, 153
italic, 35
item, 23, 51, 76, 96 to 100, 124, 

126, 147, 149, 153
closing unnecessary, 76
selecting more than one, 87
renaming, 89
deleting, 89
run usage report on, 129 to 131
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order, 91
slides together, 111
time, 96 to 97

playtime grid, 103
Play Time dialog box, 101

play time, 96 to 97
adjusting a play time, 101
copying and pasting, 107
time type, 104

player, 79, 127 to 128, 152
animated preview, 128
thumbnail preview, 127, 152

PNG, 29
policy, 111

brand guidelines, 10 to 11
eScreen content, 6 to 7

post, 9, 15, 30, 134 to 137, 
104 to 141, 143
where to, 16
see also schedule

PowerPoint, 13, 27 to 28, 141
see also templates

presets
picture style presets, 38 to 39
text formatting presets, 59 to 60

preview, 38, 48, 59, 91, 128, 149
message, 123
player

animated, 128
thumbnail, 127, 152

thumbnail preview
see also folder views

slide, 25 to 26
previous, 63

see also keep with next
program, 68, 70 to 71, 73, 85, 

151
program window

play order, 91
keep with next, 111

z-order, 49 to 52
organizing content, 78
outline, 56 to 58

see also line weight

P
palette, 10
pane

see docking pane
paring down text, 138
password, 69 to 70
paste, 

content, 88
play times, 107
text, 32, 62

retain formatting, 63
pattern

see recurrence pattern
photo, 40, 42, 48 to 50, 52

adding to slide, 37
importing to Design Studio, 

83 to 86
manipulating, 43 to 48

cropping, 47
formatting, 38
picture style presets, 38 to 39
repositioning, 43
resizing, 46
rotating, 45

saving from e-mail, 36 to 37
play category

see category
play, 4, 8, 90, 99 to 104, 

114 to 115, 119, 122, 128
audio messages, 125 to 126
copy and paste playtimes, 107

publishing from template
saving and publishing, 118
scheduling, 94 to 65
scrolling text, 119
templates, 120
text ticker, 115

messages, 67, 79, 118 to 119, 
122, 124, 126, 146

minute, 103
mode

preview, 26
folder views, 82

month, 30, 98
see also recurrence pattern

 mouse, 47, 87, 100
move

moving content, 88 
see also reposition

N
name, 27, 34 to 35, 69, 71, 75, 

121, 149
navigating folders, 81
need, 41, 43, 110, 119
network, 14
news, 5, 135

O
object, slide layout, 22 to 23, 31, 

61
manipulating, 48 to 49
selecting multiple, 51 to 52

open, 110, 120
opening your facility folder, 80
Open dialog box, 84
play item, 91

order, 
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server, 4
server name, 69

settings, 29, 97 to 99, 
103 to 105, 109, 116 to 117

shadow, 55
shape, 56, 58, 60

see also inserting objects
short, 61, 137, 143

see also text
show, 26, 130

see also display
size, 15, 54, 63, 116

see text
see template

slide, 12 to 13, 15, 32, 78, 
108 to 109, 111 to 112, 114, 119, 
137, 141 to 150
topics and examples, 17 to 18
blank slides, 18 to 20
duplicating in PowerPoint, 

41 to 42
layout, 21
objects, 22 to 23
previewing, 25 to 26
exporting, 27 to 29
see also graphics
see also templates

small templates
see templates

snap to grid, 103
sound, 79, 124, 126

see also audio
speakers, 113, 124

see also  audio
speed, 117

see also timeout
stock photography, 144
storage folders, 14, 66, 78, 131

resizing, 47, 81
photo, 46
window, 81, 85, 95

tabbed, 76
folder list, 81

resource, 78 to 80, 82, 89, 
113 to 114, 130
importing, 84 to 86
see also content resource tabs

rotate, 45

S
sans serif

see fonts
save, 105, 120 to 122

Save As dialog box, 27 to 28
messages, 118

from a message template, 122
docking pane layout, 77
vs publish, 93

schedule, 67, 78 to 79, 90, 99, 
149
advanced, 94 to 95
basic, 92
examples, 108 to 109
multiple items, 105
see also timeline

scrolling text, 117, 119, 135
see also ticker
see also message

search, 68
seconds, 112

see also timeout
select, 35, 51, 89, 97 to 98, 106

text, 33 to 34
items in window, 87, 106

serif
see fonts

see window, 68
Properties window, 110
property

see community property
providers

see content providers
Public Affairs, 145, 151, 153
publish, 93, 115, 118, 121

saving vs., 93

R
range, 96 to 99

see also timeline
receive, 61, 137, 140
rectangle, 87, 106

see also select
recurrence pattern, 96 to 98, 

101, 109
daily, 97
monthly, 98
play only once

specific date, 97
Play Time dialog box, 101
weekly, 97
yearly, 98

recurring
on specific dates and times, 98

relevant information, 134, 137
reminders, 135
replace

content, 89, 149
photo, 42

report
see usage report

reposition, 44, 51, 72, 85
repository

see corporate video repository
requests, 140
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Home, 62, 35, 49 to 50, 
54 to 55, 62

if you do not see, 33
tool

PowerPoint tools
Change Picture, 42 to 43
Crop, 47 to 48
see also z-order

Design Studio
scheduling tools, 94
tools and features, 66 to 67

topic, 12 to 13, 15, 17, 20, 143
see also templates

transitions, 110 to 111
best practice, 150

troubleshooting, 152
type

time type, 104
typing text

see text
see also file types

U
unsuitable content, 140

see also content guidelines
upper right area, 16 to 17

content, 135
see also small templates

use-case scenarios
cannot delete item, 131
choosing a template, 22
scheduling examples, 98
where to place content, 16

see also usage report
usage report, 129 to 131

viewing, 129
user name, 69

see also login window

retain format after pasting, 63
selecting, 33 to 34
scrolling, 119
text box, 23, 25
creating, 53

adding a background, 56
adding an outline, 57

formatting, 32 to 33, 35
changing color, 55 to 56
presets, 59

text ticker
see ticker

thumbnail preview
content

see folder views, 
player, 127, 152

ticker
anatomy of, 115
area, 5
automatic feed, 5, 67
local facility, editing, 115 to 117
scrolling speed, 117

ticket, 152
see also Global Help Desk

timeline, 99 to 100, 102 to 105
timeout, 112

best practice, 150
time

play duration
see timeout

see play time
see also play time

tool bar
Design Studio, 71

moving, 73
PowerPoint

Format, 42, 47 to 49, 52, 
56 to 59

see also content resource tabs
strategy

see eScreen channel strategy
studio

see Design Studio
styles

picture style presets, 38 to 39
text formatting presets, 59 to 60

symbol, insert bullet, 47
system, parts of the, 10
tabbed windows

see windows
tabs

content resource tabs, 78 to 79
close, 75
reordering, 77
resizing, 76
unpinning (auto hide), 75
see also window

T
templates 

adding information to a slide, 
23 to 25

duplicating a slide, 41
files, 13 to 14

obtaining, 13
choosing, 15 to 20
exporting from, 27 to 29
layout objects, 22 to 23
small, 15, 61, 134 to 135, 141, 

146, 153
special-use, 23
special instructions, 40 to 41

text
compose and edit, 137 to 139

what to say, 134
copy from another source, 62
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program window, 70
preview window, 128
properties window, 110 to 113
resizing, 76

user interface, 68
parts of, 74

selecting items in, 87, 106
unpinning (auto hide), 75

workforce
communicating to, 10
what to communicate to, 

134 to 135
see also employees

Y
yearly, 98

see also recurrence patterns

Z
zoom

in message editing, 117
on the playtime grid, 104

z-order, 49 to 50

user-editable areas
eScreen layout, 5
templates, 23

users, 8, 114, 147

V
variety, 12,146

see also templates
video

best practice, 149
content resource, 78
working with, 113

view menu, 75
viewers

see workforce
visual identity

see brand compliance

W
website

employee 13
Global Service Desk, 152

weekly, 108 to 109
see also recurrence patterns

weight
font weights, 11
see also line weight

window
content resource windows, 78
closing, 76
dragging from, 85
floating, 71
login window, 69
manipulating, 74
message scheduling window, 

94 to 95
navigating, 81

see also content folders
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